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はじめに

拡張電源測定および解析ソフトウェアを使用すると、設計者はカスタム定義の設
定を使用して複数の測定を構成し、1 回のアクイジションでスイッチング・デバイ

スの電源損失や磁気パラメータを測定、解析できます。突入電流、キャパシタン
ス、無効電力など、新たな測定項目の追加により、より詳細な入出力特性を把
握できます。従来、サイクル当たりの電力消費を手動で解析するだけでも長い
時間を要しましたが、現在では、全スイッチング・サイクルについて、スイッチン
グ損失プロット、時間トレンド・プロットを使用して、電力消費をグラフィカルに測
定することができます。追加機能のある .mht フォーマットで、測定結果、テスト

結果、プロット図を含むレポートを簡単に作成できます。このソリューションにより
生産性のレベルが向上するため、プリコンプライアンス要件を満たす必要がある
SMPS 設計者にも最適です。

バージョン 2.0.0 以上の拡張電源測定および解析ソフトウェアは、Windows
7 64 ビット OS を使用した、DPO/DSA7000C、MSO/DPO5000/B、MSO/DSA/
DPO70000C、DPO/DSA700000D、および MSO/DPO/DSA70000DX シリーズ

のオシロスコープ上で動作します。Windows XP シリーズ・オシロスコープ用の

DPOPWR ソリューションのバージョンは 1.0.13 です。

機能および利点
ソフトウェアの主要な機能は次のとおりです。

■ 突入、キャパシタンス、無効電力、およびスイッチング・ロス曲線プロットなど
の新機能により、より詳細な入出力特性が把握可能

■ カスタム・ソースの垂直および水平のオートセットにより、オシロスコープのパ
ラメータが自動的に設定されるので生産性および測定の再現性が向上

■ 電源周波数の自動計算により、電圧／電流高調波のより正確な測定が可
能

■ PFC 回路の波形を自動検出でき、ノイズ／リンギングを伴うスイッチング波
形に対してもゲート電圧を使用した測定が可能

■ 1 回のアクイジションで複数の測定を同時に行えるため、相関性のあるパワ
ー測定が可能

■ タイム・トレンド・プロットと実際の波形の同期により、経時的な測定値の変動
も観測可能

■ プローブの自動検出機能とオートゼロ／消磁、およびデスキュー機能をサ
ポート

■ リファレンス波形のサポートにより、すべての測定でポスト解析を利用可能

■ アプリケーションがオシロスコープにシームレスに統合されているので、両者
を簡単に切り替えて、デバッグ効率を向上できる

■ アクイジション・モード（ハイレゾ）、カーソル・ゲート、カップリング、帯域制限
などのグローバル・コンフィグレーション機能を測定グループ内で統一的に
適用可能

■ プログラム可能なインタフェース・コマンドをサポート

拡張電源解析 ix



主要な測定

DPOPWR の主要な測定は次のとおりです。

■ スイッチング・ロス測定は、すべてのスイッチング・サイクルにおける TON、
TOFF、および ON 値および OFF 値の合計損失値と曲線プロットを計算しま
す。

■ ハイパワー・ファインダは、電力波形（MATH）のすべてのピークを特定し、
対話型の詳細結果を示します。これにより、ピーク値間を全探索できるよう
になり、結果には ON-ON スイッチング・サイクルごとにエネルギー値および
ロス値が示されます。

■ RDS(on) および SOA は、動的内部抵抗およびカスタマイズ可能な安全動
作領域マスク・テストをリニア・スケールおよび対数スケールで測定します。
SOA X-Y RDS（on）はリファレンス波形をサポートしません。

■ 磁気の測定では、磁気損失の合計、コアのインダクタンスが計算され、B と
H の関係がグラフ表示されます。

■ 電源品質の測定 - THD、有効電力、皮相電力、力率、および波高率を計算
します。これらすべての解析出力は、要約結果表としてクイック・ビューに表
示されます。

■ 電流高調波は、すべてのプリコンプライアンス・テストを有効にし、
EN61000-3-2、EN61000-3-2 AM14、および MIL 1399（400 Hz）の各規格に
対応します。ユーザ定義モードでは、表形式とグラフ形式のどちらの場合も
最大 100 の高調波が表示されます。

■ 電圧高調波は、インバータの出力回路など、AC 電圧を周波数領域で測定
します。

■ 突入電流は、構成されたスレッショルド・レベルに基づいてピーク電流を計
算します。

■ キャパシタンス測定は、構成されたスレッショルド値より上のピーク・キャパシ
タンス値を計算します。

■ タイミング／変調解析は、正負のパルス幅、正負のデューティ・ サイクル、周
波数、周期、スキューの測定結果に基づいて、変調スイッチング信号内の
サイクル間変動を時間トレンド・プロットとして表示します。

■ 振幅測定は、ハイ、ロー、（ハイ）-（ロー）、サイクル最小値、サイクル最大
値、およびサイクル・ピークを計算します。すべての解析の出力が結果表、
タイム・トレンド、およびヒストグラム・プロットに表示されます。

関連情報
オンライン・ヘルプおよび関連マニュアル

製品の概要

インストール手順
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、測定機器（およびその機器に接続されている製品）の損
傷を防止するために、安全性に関する次の注意事項をよくお読みください。安
全のために、指示に従って本ソフトウェアおよび測定機器を使用してください。

本ソフトウェアをご使用いただくとき、システムのほかの部分にアクセスしなけれ
ばならない場合があります。本ソフトウェアを使用するシステムの操作に関する
警告、注意事項、および定格については、他の機器のマニュアルの安全および
仕様に関するセクションをお読みください。

火災および人体への損
傷を避けるには

接続と切断の手順を守ってください。測定対象の回路にプローブを接続する前
に、プローブ出力を測定機器に接続してください。測定機器からプローブを外
す前に、測定対象の回路からプローブの入力とグランドを外してください。

すべての端子の定格に従ってください。火災や感電の危険を避けるために、本
ソフトウェアとともに使用する測定機器およびその他の機器のすべての定格とマ
ーキングに従ってください。測定対象の回路に接続する前に、定格の詳細につ
いて、個々の製品マニュアルを参照してください。

故障の疑いがあるときは使用しないでください。本ソフトウェアとともに使用する
測定機器またはその他の機器に故障の疑いがある場合は、資格を有するサー
ビス担当者に検査を依頼してください。

本マニュアル内の用語 このマニュアルでは次の用語を使用します。

警告：人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意：測定機器やその他の接続機器に損害を与えるおそれのある状態や行為
を示します。
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アプリケーション使用時
の確認事項

オシロスコープのメニューからアプリケーションを起動すると、注意を促すダイア
ログ・ボックスが開き、適切な定格電圧プローブと定格電流プローブ、アクセサ
リ、およびその他の機器のみを使用するように警告が表示されます。OK をクリッ
クします。
 

 

安全にご使用いただくために  
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オンライン・ヘルプおよび関連マニュアル

オシロスコープによるアプリケーションの操作方法の詳細については、次の関連
マニュアルおよびオンライン・ヘルプを参照してください。

関連情報 表記規則

関連マニュアル

Tektronix 連絡先

本製品についてのフィードバック

オンライン・ヘルプの印刷

一部のオンライン・ヘルプ・トピックでは、アプリケーションの例がカラー表示され
ている場合があります。このようなトピックをモノクロ・プリンタで印刷すると、特定
の色で示された一部の情報が印刷されない場合があります。情報をすべて印刷
するには、オンライン・ヘルプと同じ内容の PDF（Portable Document Format）フ
ァイルからトピックを印刷する必要があります。
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関連マニュアル

オシロスコープの操作方法の詳細については、オンライン・ヘルプ以外に、次の
関連マニュアルを参照してください。

■ オシロスコープの情報：オシロスコープのユーザ・マニュアルおよびユーザ・
オンライン・ヘルプには、オシロスコープの操作方法に関する一般的な情報
が記載されています。

ヒント： 多くのユーザ・マニュアルの PDF 版は、当社 Web サイトからダウンロー
ドできます。

■ プログラマ向けの情報：オシロスコープのオンライン・プログラマ・ガイドに
は、GPIB コマンドを使用してオシロスコープを制御する方法の詳細が記載

されています。

表記規則

オンライン・ヘルプでは、次の表記規則を使用しています。

■ DPOPWR 電力測定ソリューションは拡張電源解析アプリケーションと表記さ

れます。

■ アプリケーション・インタフェースを使用して一連の手順を選択する必要があ
る場合、メニューとオプションの間の移動は ">" 記号で区切って示します。

たとえば、セットアップ・ファイルを保存する手順を File > Save と示します。

■ Source Configuration パネルは、ほとんどの測定に共通です。

■ GP ノブとは、汎用（General-Purpose）ノブのことです。

まえがき  
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フィードバック

当社は、製品に関するお客様のフィードバックを重視しています。ご使用のオシ
ロスコープに関するご意見、ご提案、またはコメントをお寄せください。お客様
に、より良いサービスを提供するための参考にさせていただきます。

フィードバックの送信先

電子メールは techsupport@tektronix.com、FAX は (503)627-5695

フィードバックには次の情報を記載してください。また、内容はできるだけ具体
的に記述してください。

一般的な情報： ■ オシロスコープの型名とハードウェア・オプション（ある場合）

■ 使用しているプローブ

■ 氏名、会社名、郵送先住所、電話番号、ファックス番号

■ ご意見またはコメントについて当社より連絡をご希望の場合は、その旨をご
記入ください。

アプリケーション固有の
情報：

■ ソフトウェアのバージョン番号

■ 問題の説明（これに基づき、テクニカル・サポートで問題を再現します）

■ .set ファイルとして保存した、オシロスコープとアプリケーションのセットアッ
プ・ファイル（可能な場合）

■ .wfm ファイルとして保存した、測定実行中の波形（可能な場合）

これらの情報を収集した後、電話または電子メールでテクニカル・サポートにご
連絡ください。電子メールの場合は、必ず件名を "DPOPWR Problem"）と
し、.set ファイルと .wfm ファイルを添付してください。

 まえがき
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はじめに

製品の概要

バージョン 2.0.0 以上の拡張電源測定および解析ソフトウェアは、Windows
7 64 ビット OS を使用した、DPO/DSA7000C、MSO/DPO5000/B、MSO/DSA/
DPO70000C、DPO/DSA700000D、および MSO/DPO/DSA70000DX シリーズ

のオシロスコープ上で動作します。Windows XP シリーズ・オシロスコープ用の

DPOPWR ソリューションのバージョンは 1.0.13 です。DPOPWR を使用すると、

さまざまなテスト・ポイントで、各種スイッチング電源の信号の取り込み、測定、お
よび解析を実行できます。このアプリケーションでは、スイッチ・モード電源のス
イッチング・デバイスのテスト、磁気コンポーネントのテスト、および EN
61000-3-2 規格に対するコンプライアンス・テストの結果を、簡単かつ直接的に

得ることができます。 DPOPWR の機能は次のとおりです。

■ スイッチング解析：電源に搭載されている、FET（電界効果トランジスタ）、

BJT（バイポーラ・ジャンクション・トランジスタ）、IGBT（絶縁ゲート型バイポ

ーラ・トランジスタ）などのスイッチング・デバイスを解析します。スイッチング・
ロス、すべてのスイッチング・サイクルの ON および OFF 値の曲線プロット、

ハイパワー・ファインダ、SOA（安全動作領域）、SOA X-Y（DPX）、動的抵

抗、RDS(on)、di /dt、および dv /dt を測定できます。

■ タイミング解析：電源に搭載されている、FET（電界効果トランジスタ）、BJT
（バイポーラ・ジャンクション・トランジスタ）、IGBT（絶縁ゲート型バイポーラ・

トランジスタ）などのスイッチング・デバイスを解析します。パルス幅変調、周
期変調、デューティ・サイクル変調、周波数変調、およびスキューを測定で
きます。

■

磁気：インダクタンス、磁気特性、磁気損失、 を測定します。

■ 入力解析：電源品質、電流高調波（最大 100 の高調波が表／グラフ形式で

表示される）、電圧高調波、全体の電源品質、突入電流、およびキャパシタ
ンスを測定します。

■ 出力解析：ライン・リップル、スイッチング・リップル、ターン・オン時間、およ
びスペクトラム解析を測定します。スペクトラム解析では、電磁干渉の一因と
なる周波数成分を解析し、DC 出力電圧の周波数範囲でノイズおよびリップ

ルを測定します。

■ 振幅：ハイ、ロー、（ハイ）-（ロー）、サイクル最小値、サイクル最大値、および

サイクル・ピークを測定します。

■ 追加機能を持つレポート・ツールを使用して、.mht 形式でのカスタム・レポ

ートの作成と印刷を実行できます。

■ SOA オーバーレイ、デスキュー、プローブ自動検出、消磁 自動設定、およ

び SOA Mask Editor ユーティリティ。

拡張電源解析 7



関連情報 電流プローブ

互換性

必要条件と制限事項

アプリケーションのインストール

互換性

チャンネル数に対する測定の依存性を表示するには、Help > About TekScope
を選択します。オシロスコープのオプション・パネルに、チャンネル依存性が表
示されます。

測定項目名 チャンネル数

Switching Analysis
di/dt 1 
dv/dt 1 
Hi-Power Finder 2 - 3 
RDS(On) 2 
SOA 2 
SOA X-Y（DPX） 2 

スイッチング・ロス 2 - 3 
タイミング解析

デューティ・サイクル 1 
周波数 1 
周期 1 
パルス幅 1 
スキュー 2 

Magnetics
電流と積分電圧 2 
磁気損失 2 
磁気特性 2 - 4 
インダクタンス 2 

Input Analysis
突入電流 1 
入力キャパシタンス 2 
電流高調波 2 
電源品質 2 
全体の電源品質 2 
電圧高調波 1 

Output Analysis
ライン・リップル 1 

はじめに  
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測定項目名 チャンネル数

スイッチング・リップル 1 
スペクトラム解析 1 
ターン・オン時間 2 ～ 4 
振幅

High 1 
Low 1 
（ハイ）-（ロー） 1 

サイクル最小値 1 
サイクル最大値 1 
サイクル・ピーク 1 

必要条件と制限事項

DPOPWR アプリケーションが動作するには、オシロスコープに Microsoft .NET
Framework バージョン 4.0 がインストールされている必要があります。レポートに

は、Microsoft Windows Internet ブラウザが必要です。

電流プローブ

このアプリケーションでは、次のプローブがサポートされています。

■ AM503B シリーズ（A6302 型とともに使用）

■ AM503B シリーズ（A6302XL 型とともに使用）

■ AM503B シリーズ（A6303 型とともに使用）

■ AM503B シリーズ（A6303XL 型とともに使用）

■ AM503B シリーズ（A6304XL 型とともに使用）

■ AM503 シリーズ（A6312 型とともに使用）

■ TCP0020 型
■ TCP0030 型
■ TCP0030A 型
■ TCP0150 型
■ TCP202 型
■ TCP2020 型
■ TCP202A 型
■ TCP202A 型および TPA-BNC 型
■ TCPA300 型（TCP303 型とともに使用）

 はじめに
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■ TCPA300 型（TCP303 型および TPA-BNC 型とともに使用）

■ TCPA300 型（TCP305 型とともに使用）

■ TCPA300 型（TCP305 型および TPA-BNC 型とともに使用）

■ TCPA300 型（TCP305A 型とともに使用）

■ TCPA300 型（TCP305A 型および TPA-BNC 型とともに使用）

■ TCPA300 型（TCP312 型とともに使用）

■ TCPA300 型（TCP312 型および TPA-BNC 型とともに使用）

■ TCPA300 型（TCP312A 型とともに使用）

■ TCPA300 型（TCP312A 型および TPA-BNC 型とともに使用）

■ TCPA400 型（TCP404XL 型とともに使用）

■ TCPA400 型（TCP404XL 型および TPA-BNC 型とともに使用）

■ TekVPI TCP0030 型

電圧プローブ ■ P5050 型
■ P5050B 型
■ P5100 型
■ P5100A 型
■ P5200A 型
■ P5200A 型
■ P5202A 型
■ P5205 型
■ P5205A 型
■ P5210 型
■ P5210A 型
■ P6015A 型（10 フィート）

■ P6015A 型（25 フィート）

■ P6021A 型
■ P6131 型（1.3 m）

■ P6131 型（2 m）

■ P6138A 型
■ P6139A 型
■ P6139B 型
■ P6158 型
■ P6243 型

はじめに  
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■ P6245 型
■ P6246 型
■ P6247 型
■ P6248 型
■ P6250 型
■ P6251 型
■ TAP1500 型
■ TAP2500 型
■ TDP0500 型
■ TDP1000 型
■ TDP1500 型
■ TDP3500 型
■ TekVPI TAP1500 型
■ TekVPI TAP2500 型
■ TekVPI TPA-BNC 型
■ THDP0100 型
■ THDP0200 型
■ TMDP0200 型
■ TPP0500 型
■ TPP0500B 型
■ TPP0502 型
■ TPP0850 型
■ TPP1000 型

このアプリケーションでは、デスキュー・フィクスチャ（当社部品番号 067-1686-
XX）がサポートされています。

NOTE. プローブに関する詳細な情報については、www.tek.com/probes を参照し
てください。

NOTE. 外部フィクスチャを使用する場合、ターン・オン時間およびリップルを測定
するには、オシロスコープの Vertical > External Attenuation メニューで外部減
衰係数値を入力し、正しい結果が得られるようにしてください。

 はじめに
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Web サイト経由の更新

このアプリケーションおよびその他のアプリケーションの詳細については、
Tektronix Inc. の Web サイト www.tektronix.com を参照してください。アプリケー

ションの更新およびその他の無償アプリケーションを入手するには、このサイトを
確認してください。

アプリケーションの更新をインストールする場合は、当社 Web サイトからオシロ

スコープのハード・ディスクに更新をダウンロードする必要があります。

注： アプリケーションまたはインストールに対する変更の詳細については、Web
サイトの Readme.txt ファイルを参照してください。作業を進める前に、このファイ
ルに目を通しておく必要があります。

アプリケーションのインストール

ご使用の機器には、ハード・ドライブにアプリケーションがプリインストールされて
います。

注： 新しい拡張電源解析アプリケーションをインストールすると、古いアプリケー
ションはアンインストールされます。

はじめに  
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基本操作

基本操作について

基本操作について このセクションでは、次の情報について説明します。

アプリケーション・インタフェース

オシロスコープの基本機能の使用

ソフトウェアのセットアップ

設定の保存と呼び出し

アプリケーション・インタ

フェース

このアプリケーションでは Microsoft Windows のインタフェースを使用します。

アプリケーションのディレクトリとファイル名

アプリケーション・インタフェースのメニュー・コントロール

注： このアプリケーションが実行されていると、オシロスコープ・アプリケーション
は半分のサイズに縮小されて、画面の上半分に表示されます。

アプリケーション・インタ

フェースのメニュー・コン
トロール

項目 説明

メニュー・バー オシロスコープの上部領域。ここからアプリケーションを
起動します。

タブ 関連するオプションをグループとしてまとめ、ラベルを付
けたもの。

フィールド 一連の関連オプションを区切った領域。

オプション・ボタン 特定のコマンドまたはタスクを定義するボタン。

ドロップダウン・リスト・ボッ
クス

項目のリストを含むボックス。この項目リストから 1 つの

項目を選択できます。

フィールド テキストの入力に使用するボックス。Keypad または

Multipurpose ノブを使用して値を入力することもできます。

チェック・ボックス 設定を選択またはクリアするときに使用する四角形のボ
ックス。

スクロール・バー 表示領域の横または下にある垂直または水平のバー。
領域内の移動に使用します。

参照 ディレクトリおよびファイルのリストを閲覧できるウィンドウ
が表示されます。

コマンド・ボタン アクションをただちに開始するボタン。
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項目 説明

キーパッド ボックスを選択して値を入力するときに表示されます。

MP/GP ノブ 汎用（MP または GP）ノブを選択すると、ノブとボックスの

間に線が表示されます。オシロスコープ上のノブを回して
値を選択します。

アプリケーションの基本機能

アプリケーションのディレ

クトリとファイル名

このアプリケーションでは、セットアップ・ファイルをディレクトリに保存し、そこから
呼び出すことができます。また、ファイル名拡張子でファイル・タイプを識別しま
す。

次の表に、デフォルトのディレクトリ名を示します。

ディレクトリ 使用目的

C:\Users\Public\Tektronix\TekApplications
\Advanced Power Analysis\Waveforms

チュートリアルに使用する波形の保存場
所

C:\User\<Current User>\Tektronix
\TekApplicaitons\Advanced Power Analysis
\Reports\

デフォルト・レポートの保存場所

C:\User\Public\Tektronix\TekApplicaitons
\Advanced Power Analysis\SOA Mask\

SOA マスク・データ（カンマ区切り値ファイ

ル）の保存場所

C:\User\<current user>\Tektronix
\TekApplicaitons\Advanced Power Analysis
\SwitchingLoss\

スイッチング・ロスのサイクルごとの損失
情報（csv 形式）の保存場所

次の項目も参照してください。.
ファイル名の拡張子

ファイル名の拡張子 拡張子 説明

.csv "カンマ区切り値" フォーマットを使用するファイル。

.ini アプリケーション・セットアップ・ファイル。

.set .ini ファイルに基づいて保存および呼び出される、オシロスコープ

のセットアップ・ファイル。.ini ファイルと同じファイル名が付けられ

ます。

.wfm リファレンス・メモリに呼び出すことのできる波形ファイル。

.mht レポートのファイル形式。

.jpg プロットのイメージ・ファイル・フォーマット。

.msk SOA マスク・ファイルのフォーマット。

基本操作  
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アプリケーションの再表

示

オシロスコープの機能にアクセスすると、オシロスコープの画面がスクリーン全体
に広がります。オシロスコープの機能には、次の方法でアクセスできます。

■ オシロスコープのメニューを選択して、アプリケーションにアクセスする

■ フロント・パネルのボタンを押す

設定の保存と呼び出し

設定の保存 アプリケーションの状態とオシロスコープの設定をセットアップ・ファイルに保存
するには、次の手順を実行します。

1. File > Save As > Setup を選択します。

 

 

2. Save メニューを選択します。

3. セットアップ・ファイルを保存するディレクトリを選択します。

4. ファイル名を選択または入力します。セットアップ・ファイルの名前には、
".xml" という拡張子が追加されます。

5. Save を選択します。

注： レポートを保存するとき、ドライブの空き容量の確認は行われません。

 基本操作
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保存された設定の呼び

出し

保存されたセットアップ・ファイルからアプリケーション設定とオシロスコープ設定
を呼び出すには、次の手順を実行します。

1. File > Recall を選択します。

2. アプリケーション設定の呼び出し元ディレクトリを選択します。

3. ファイル名を選択または入力します。

注： アプリケーション設定を呼び出すと、".xml" ファイルからオシロスコープ設定
も呼び出されます。

デフォルト設定の呼び出

し

デフォルトのセットアップ・ファイルからアプリケーション設定を呼び出すには、
File > Recall Default Setup を選択します。
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ユーティリティ

消磁 電流プローブの操作において消磁は必須です。すべての電流プローブは、使
用前に消磁されている必要があります。

電流プローブの消磁には、以下のことが必要です。

■ 消磁を行う前に、電流プローブの顎部は閉じられている必要があります

■ プローブはどのアクティブ・ポイントまたはプローブ内の信号とも接続されて
いてはなりません

アプリケーションは、オートセットを開始する度に各プローブの Degauss ステータ

スをチェックし、必要に応じてプローブの消磁を行うよう求めるメッセージを表示
します。測定を選択してソース・コントロール・ウィンドウを起動し、De-Gauss ボタ

ンを選択します。これにより、消磁プロセスの間中、ガイドが行われます。

 

 

または、電流プローブの消磁ボタンを押して、手動で行うこともできます。

 基本操作
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オートゼロ オートゼロは、アクイジション中に垂直軸のゼロ点誤差（DC オフセット）を計算

し、補正を行う機能です。AutoZero ボタンが押されると、スコープはアクイジショ

ンを実行し、オフセットを調整します。オートゼロ機能は、電圧プローブを電流の
測定に使用するときに役立ちます。

オートゼロを実行するには、電圧プローブを接続し、入力端子を短絡させます。

 

 

注： プローブ・チップに入力信号が接続されていないことを確認してください。

注： オートゼロは電圧プローブに適用されます。
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設定セットアップ ■ TCP、Shunt、Custom、および AM503S の設定を表示するには、I-Probe
Settings をクリックします。TCP シリーズのプローブを使用している場合は、

TCP ボタンをクリックします。

 

 

注： TCA-1MEG 型バッファ増幅器を使用する場合、終端が自動的に変更さ
れない電流プローブでは、入力側を 50 Ω で終端処理します。TCA-BNC 型
アダプタを使用する場合、入力側を終端処理する必要はありません。

デスキュー MSO/DPO5000/B シリーズのオシロスコープ：プローブとチャンネルのデスキュ

ー

正確な結果を得るために、被測定装置のテストを実行する前にプローブをデス
キューします。

このアプリケーションには、次の 2 つのデスキュー・オプション

■ 静的なデスキュー

■ Tek-DPG 型（デスキュー・パルス・ジェネレータ）および外部ソースを使用し

たリアルタイム・デスキュー

デスキューには、Preferences ダイアログ・ボックスを使用してアクセスできます。

注： THDP プローブでは、ノイズが発生するため、静的なデスキューを使用する
ことをお勧めします。

 

 基本操作
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注： 外部信号モードを使用する場合は、最速の遷移にプローブを接続してくだ
さい。

電流プローブをデスキューするには、次の手順を実行します。

1. IProbe タブを選択します。

2. Current Sources ドロップダウン・リストおよび Current Probes ドロップダウン・リ

ストからソースおよびプローブを選択して、電流ソースおよび電流プローブ
を選択します。

3. 電流プローブを設定したら、Deskew Static または Deskew Real Time タブを

選択して、Perform Deskew をクリックし、デスキューの手順を開始します。
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静的なデスキューを実行するには、次の手順を実行します。

1. Deskew Static タブを選択します。

2. Source ドロップダウン・リストからソースを選択して、To および From ソースを

選択します。

3. Probe ドロップダウン・リストからプローブを選択して、To および From プロー

ブを選択します。

4. Perform Deskew をクリックしてデスキュー手順を開始します。
 

 

 基本操作
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リアルタイム・デスキューを実行するには、次の手順を実行します。

1. Deskew Real Time タブを選択します。

2. Source ドロップダウン・リストからソースを選択して、To および From ソースを

選択します。

3. 基準レベルまたはヒステリシス値を変更するには、テキスト・ボックスをダブル
クリックし、ポップアップ・キーボードを使用して希望値を入力します。

4. Slope には Rise または Fall のいずれかを選択します。

5. Source では、Tektronix デスキュー・フィクスチャおよびデスキュー・パルス・

ジェネレータ（TEK-DPG）を選択します。

6. Ch1 を電圧、Ch2 を電流に設定します。

7. プローブの先端をデスキュー・フィクスチャに接続し、TEK-DPG を Ch3 に
接続します。

8. TEK-DPG プローブでの出力有効を選択します。

9. Perform Deskew をクリックしてデスキュー手順を開始します。

オートセットを実行するかどうかを尋ねるポップアップが表示されます。Yes
をクリックすると、アプリケーションでデスキュー用にオシロスコープをセットア
ップできるようになります。オシロスコープをすでに設定済みであり、単にデ
スキューを実行する場合は No をクリックしてください。
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プローブとチャンネルの

デスキュー

静的なデスキュー： 静的なデスキューでは、サポートされているプローブ・タイプ

に基づいて、デスキューが自動的に設定されます。プローブの伝播値は固定で
す。チャンネルをデスキューする場合に、外部デスキュー・フィクスチャは必要あ
りません。

このアプリケーションでは、DPO/DSA7000C シリーズ、MSO/DPO5000/B シリー

ズ、MSO/DSA/DPO70000C シリーズ、DPO/DSA700000D シリーズ、MSO/
DPO/DSA70000DX シリーズのオシロスコープの次の 2 チャンネル・プローブに

ついては、どのような組み合わせでもサポートされています。

プローブのモデル スキュー（ナノ秒単位）

AM503B 型（A6302 型とともに使用） 30.1

AM503B 型（A6303 型とともに使用） 55.0

AM503B 型（A6312 型） 30.1

AM503B 型（A6302XL 型とともに使用） 60.3

AM503B 型（A6303XL 型とともに使用） 105.0

AM503B 型（A6304XL 型とともに使用） 105.0

P5050 型 5.5

P5050B 型 6.0

P5100 型 14.9

P5100A 型 6.0

P5200 型 20.0

P5200A 型 21.0

P5202A 型 18.0

P5205 型 17.3

P5205A 型 18.0

P5210 型 20.3

P5210A 型 18.0

P6015A 型（10 フィート） 14.7

P6015A 型（25 フィート） 33.3

P6021A 型 9.0

P6131 型（1.3 m） 6.3

P6131 型（2 m） 9.1

P6138A 型 6.3

P6139A 型 6.3

P6139B 型 6.0

P6158 型 5.0

P6243 型 5.3

P6245 型 5.3

P6246 型 7.7

P6247 型 7.3

 基本操作
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プローブのモデル スキュー（ナノ秒単位）

P6248 型 6.8

P6250 型 6.5

P6251 型 6.5

TAP1500 型 5.3

TAP2500 型 5.3

TCP0020 型 15.0

TCP0030 型 14.6

TPP1000 型 5.3

TCP0030A 型 14.5

TCP0150 型 21.0

TCP202 型 17.3

TCP202A 型 17.2

TCP2020 型 17.0

TCP202A 型および TPA-BNC 型 17.2

TCPA300 型（TCP303 型とともに使用） 40.0

TCPA300 型（TCP303 型および TPA-BNC
型）

40.3

TCPA300 型（TCP305 型とともに使用） 19.0

TCPA300 型（TCP305 型および TPA-BNC 型
とともに使用）

19.3

TCPA300 型（TCP305A 型とともに使用） 19.0

TCPA300 型（TCP305A 型および TPA-BNC
型）

19.3

TCPA300 型（TCP312 型） 17.0

TCPA300 型（TCP312 型および TPA-BNC 型
とともに使用）

17.3

TCPA300 型（TCP312A 型とともに使用） 17.0

TCPA300 型（TCP312A 型および TPA-BNC
型とともに使用）

17.3

TCPA400 型（TCP404XL 型とともに使用） 80.0

TCPA400 型（TCP404XL 型および TPA-BNC
型とともに使用）

80.3

TDP0500 型 6.5

TDP1000 型 6.5

TDP1500 型 5.4

TDP3500 型 5.3

TekVPI TCP0030 型 14.6

TekVPI TAP1500 型 5.3
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プローブのモデル スキュー（ナノ秒単位）

TekVPI TAP2500 型 5.3

TekVPI TPA-BNC 型 0.25

THDP0100 型 16.0

THDP0200 型 14.0

TMDP0200 型 14.0

TPP0500 型 5.3

TPP0500B 型 5.3

TPP0502 型 5.3

TPP0850 型 6.1

静的なデスキューを実行するには、次の手順を実行します。

1. Analyze > Advanced Power Analysis を選択してから、Preferences を選択し

ます。

2. Deskew Static タブをクリックします。

3. From フィールドで Source を選択し、該当する Probe のタイプを選択しま

す。

4. To フィールドで Source を選択し、該当する Probe のタイプを選択します。

 

 

5. Perform Deskew をクリックして、選択したプローブをデスキューします。

注： 静的なデスキューは、選択した任意の 2 チャンネル間で実行されます。
3 チャンネル以上のチャンネルのデスキューを実行する場合は、From パネルの
パラメータは変更しないで、To パネルのパラメータを変更してください。カスタ
ム・プローブを使用する場合は、アプリケーションでデスキューの調整と値の設
定が行われ、静的なデスキューが実行されます。

 基本操作
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DPO70000 シリーズのオシロスコープ： DPO/DSA7000C シリーズ、MSO/DSA/
DPO70000C シリーズ、DPO/DSA700000D シリーズ、MSO/DPO/DSA70000DX
シリーズのオシロスコープ

プローブとチャンネルをデスキューするには、Aux Output 信号（DPO7000C シリ

ーズ）およびデスキュー・フィクスチャ（当社部品番号：067-1686-XX）を使用しま

す。

外部ソースを使用してデスキューするには、次の手順を実行します。

1. オシロスコープの AUX OUT をデスキュー・フィクスチャの B 側入力に接続

し、電圧プローブと電流プローブをデスキューします。

2. プローブ校正とデスキュー・フィクスチャの指示に従って、接続を行います。

3. オシロスコープを次のようにセットアップします。

■ オシロスコープの Horizontal Scale ノブを使用してアクイジション・レート

を調節し、デスキュー・エッジに 2 つ以上のサンプルが表示されるように

します。

■ Vertical Scale ノブおよび Position ノブを使用して信号を調整し、画面

上に信号を表示します。

■ Record Length を設定して、アクイジションに含まれるエッジのサンプル

を増やします。レコード長は 25,000 ポイントに設定することをお勧めしま

す。

4. アプリケーションを開始するには、Analyze > Advanced Power Analysis を選

択してから、Preferences を選択します。

5. Deskew Real Time タブを選択します。Source フィールドの Internal Source
ボタンをクリックします。

6. From パネルで Source を Ch1 に設定します。このチャンネルのソース波形

を基準として、他のチャンネルがデスキューされることになります。

7. To パネルで、Source を Ch2 に設定します。このチャンネルがデスキューさ

れます。

8. デスキュー・ユーティリティを開始するには、Perform Deskew ボタンをクリッ

クして動作を確認します。
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9. Ch1 を基準として使用し、他のチャンネルをデスキューします。

次の図は、デスキュー設定の例を示しています。

 

 

次の図に、デスキュー後の結果を示します。

 

 
10. 1 エッジのみが表示されており、スキューが取り除かれたことがわかります。

 基本操作
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注： デスキュー前のオシロスコープの設定は保存され、デスキュー後にその設
定に戻ります。たとえば、設定を保存する前のアクイジション設定が停止条件で
あった場合は、停止条件の設定に戻ります。デスキュー後にこの設定に戻って
も、アプリケーションに波形が表示されるわけではありません。波形を表示する
には、オシロスコープ・アプリケーションの Run ボタン ボタンまたは Stop ボタン
を押してください。

次の項目も参照してください。.
静的なデスキュー

電力デスキュー・フィクスチャを使用したデスキュー

電力デスキュー・フィクスチャを使用したデスキュー： 電力測定デスキュー・フィ

クスチャ（当社部品番号：067-1686-XX）では、150 A AC/DC までの電流プロー

ブがサポートされています。

デスキューを行うには、次の手順を実行します。

■ オシロスコープの AUX OUT をデスキュー・フィクスチャの J1、J2（Cal 信号

入力）入力に接続し、電圧プローブと電流プローブをデスキューします。

■ 「DPO/DSA7000C シリーズ、MSO/DSA/DPO70000C シリーズ、DPO/
DSA700000D シリーズ、MSO/DPO/DSA70000DX シリーズのオシロスコー

プでのデスキュー」のトピックに記述されている手順 2 ～ 10 を実行します。
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拡張電源測定および解析ソフトウェア

測定を開始するための DPOPWR のセットアップ

ソフトウェアのセットアッ

プ

アプリケーションをセットアップすると、測定を実行できます。さらに、測定結果は
必要に応じてプロットとして表示できます。また、レポート・ゼネレータを使用する
と、詳細レポートを生成できます。

測定は 6 つのタブに分かれています。これらの測定の詳細を参照するには、次

のリンクをクリックしてください。

次の項目も参照してください。.
オプション一覧：ソース設定

測定および設定の一覧：スイッチング解析

測定および設定の一覧：タイミング解析

測定および設定の一覧：磁気

測定および設定の一覧：入力解析

測定および設定の一覧：出力解析

測定および設定の一覧：振幅
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オプション一覧：ソース設

定

フィールド オプション 説明

Source Selection パネル Voltage（V）、Current（I）、Gate
（G）

選択した測定に電圧、電
流、およびゲート・チャンネ
ルを割り当てることができま
す。Live を選択した場合は

Current Source の Ch1 ～
Ch4、Ref を選択した場合は

Ref1 ～ Ref4 を選択します。

Ch3 と Ch4 および Ref3 と
Ref4 の選択は、オシロスコ

ープのチャンネル数によっ
て異なります。
Live を選択した場合は

Voltage Source の Ch1 ～ Ch4
および Math1 ～ Math4、Ref
を選択した場合は Ref1 ～
Ref4 を選択します。

ゲートの選択は、選択した
測定に適用されます。この
選択は、選択した測定に設
定されているゲートまたは
エッジ・ソースの選択と同期
が保たれます。

測定および設定の一覧：

スイッチング解析

測定 サブ・タイプ／設定 説明

Switching Analysis
Switching Analysis スイッチング・デバイスのス

イッチング・サイクルで損失
される電力を解析します。
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測定 サブ・タイプ／設定 説明

スイッチング・ロス スイッチング・デバイスで消費される平均エネルギーの瞬
間的な最小値と最大値を測定します。取り込まれた波形
のサイクルごとに損失が測定されます。測定結果には、
単一のレコードに含まれるサイクル全体の最小、最大、
および平均の損失とエネルギーが含まれます。

Type PWM Type
Device
PFC Type  1

OnOffLevel Units
Device
V-level
I-Level
Math Destination

オプション Units
Ref Level
ヒステリシス
Filter Current
Signal Condition
Log Switching Cycles

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

Hi-Power Finder ハイパワー・ファインダは、スイッチング・コンポーネント
の電力損失を解析し、瞬間的な電力が指定された限界
内にとどまるようにします。

PWMType Fixed
Variable

OnOffLevel Units
Device
V-level
I-Level
Math Destination

Edges Units
Ref Level
ヒステリシス
Filter Current

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

1 少なくとも 1 サイクルの入力電源周波数を取り込み、カーソル・ゲートを On にします。
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測定 サブ・タイプ／設定 説明

安全動作領域（SOA） 単一のレコードに含まれる電圧と電流の波形を XY モー

ドでプロットします。Mask の Enable チェック・ボックスを有

効にできるのは SOA Normal の場合のみです。Mask Editor
を使用して、SOA Normal オプションの場合のみ SOA プロ

ットにマスクを適用します。

Mask Editor 有効
X Co-ord.
Y Co-ord.
Add
Update
Clear
Clear All
Save
Recall
Graph
Preview

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

SOA X-Y（DPX） 電圧および電流の波形の永続パーシスタンスを使用し
て、オシロスコープを XY モードでセットアップします。

RDS(on) Method V/I
dV/dI

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

dv/dt 電圧の微分 dv/dt を測定します。

オプション Units
Ref Level
ヒステリシス
Ref High
Ref Low

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

di/dt 電流の微分 di/dt を測定します。

オプション Units
Ref Level
ヒステリシス
Ref High
Ref Low

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

測定および設定の一覧：

タイミング解析

測定 サブ・タイプ／設定 説明

変調解析

パルス幅 取り込まれた波形のパルス幅の変動トレンド・プロットで
す。パルス幅とは、パルスの立上りエッジと立下りエッジ
間の時間差です。

Edges Polarity

■ Positive
■ Negative

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

周期 立上りエッジ間、または立下りエッジ間で測定される周期
の変動トレンド・プロットです。

Edges Edge Type

■ Rise
■ Fall

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

デューティ・サイクル 波形のデューティ・サイクルを測定したトレンド・プロットで
す。デューティ・サイクルには、正または負のデューティ・
サイクルを指定できます。

Edges Edge Type

■ Rise
■ Fall

Polarity

■ Positive
■ Negative

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

周波数 信号の周波数の変動トレンド・プロットです。

Edges Edge Type

■ Rise
■ Fall

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

タイム解析
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測定 サブ・タイプ／設定 説明

スキュー スキュー測定は、基準とする波形の指定されたエッジと、
比較対象とする波形の指定されたエッジの時間差を計算
します。

Edges From Edge

■ Rise
■ Fall
■ Both

To Edge

■ Same as From
■ Inverse of From

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

測定および設定の一覧：

磁気

測定 サブ・タイプ／設定 説明

インダクタンス Edges Edge Source
オプション Units

Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

磁気特性 Source Voltage Source
Freq and Duty

■ Fixed
■ Variable

Physical Chars1 Units
Cross Section Area
Magnetic Length

Physical Chars2 Number of Winding

■ Single
■ Multiple

Number of Turns
Multiple Windings

■ Number of Winding
■ Magnetising Current
■ Winding2 Source
■ Winding3 Source
■ Number of Turns
■ Number of Turns

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

磁気損失 Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

電流と積分電圧 XY プロットに電圧波形の積分と電流波形をプロットしま

す。V の積分は B に比例し、電流波形 I は H に比例しま

す。

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定および設定の一覧：

入力解析

測定 サブ・タイプ／設定 説明

入力解析の選択

電源品質 電源そのものを含む、非線形負荷による歪みの影響を
計測します。　

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

電流高調波 あらかじめ定義された高調波の限界値を取り込みます。
これは、測定された高調波の値を比較する場合に使用し
ます。

Standard Type

■ 61000-3-2
■ AM - 14
■ MIL 1399

Line Frequency

■ Auto：入力信号の周波

数を自動的に計算しま
す。

■ 50 Hz
■ 60 Hz
■ Custom：数字キーパッド

を使用して 1 Hz ～
4,000 Hz の範囲で電源

周波数を設定できま
す。

Harmonics Order

■ タイプが 61000-3-2 およ

び AM 14 の場合は、高

調波次数は 40 ～
100 の範囲です。

■ MIL 1399 の場合は、

50 ～ 100 の範囲です。

I-Probe Impedance Impedance table
Edit

高調波 Class
Harmonic
Edit
Input Power
力率

Filter check box
Fundamental Current

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

電圧高調波 あらかじめ定義された高調波の限界値を取り込みます。
これは、測定された高調波の値を比較する場合に使用し
ます。

Line Frequency ■ Auto：入力信号の周波

数を自動的に計算しま
す。

■ 50 Hz
■ 60 Hz
■ Custom：数字キーパッド

を使用して 1 Hz ～
4,000 Hz の範囲で電源

周波数を設定できま
す。

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

全体の電源品質 次の項目を測定して表示します。

■ 電流および電圧の RMS 値

■ 有効電力

■ 皮相電力

■ 電流と電圧の波高率、電流高調波

■ 無効電力

■ 力率

■ 総合高調波歪み

これは、電源品質と電流高調波の測定を組み合わせた
ものです。

Standard Type

■ 61000-3-2
■ AM - 14
■ MIL 1399

Line Frequency

■ Auto：入力信号の周波

数を自動的に計算しま
す。

■ 50 Hz
■ 60 Hz
■ Custom：数字キーパッド

を使用して 1 Hz ～
4,000 Hz の範囲で電源

周波数を設定できま
す。

I Probe 電流プローブのインピーダ
ンスと周波数をこのテーブ
ルで編集し、電流高調波の
値の計算に使用できます。
デフォルトの状態では、I プ
ローブは有効ではありませ
ん。
Impedance table
Edit

Harmonics Table Class
Harmonic
Edit
Input Power
Power Factor
Filter check box
Fundamental Current

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

突入電流 インサーキット動作時のスイッチング電源のピーク突入
電流を測定します。

オプション Units
Ref Level
ヒステリシス
Peak (Amps)

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

入力キャパシタンス インサーキット動作時のスイッチング電源の入力電流と
入力電圧を使用して、基準レベルを超えるキャパシタン
スを測定します。

オプション Units
Ref Level
ヒステリシス
Peak (Amps)

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

測定および設定の一覧：

出力解析

測定 サブ・タイプ／設定 説明

出力解析を選択します

ライン・リップル ライン入力周波数に関連した AC 出力信号の量を測定し

ます

Line Ripple Freq 次の項目を測定します。

■ DC に存在する電圧の

AC 成分

■ ピーク・ツー・ピーク電
圧に含まれる低周波数
の AC 電圧。

50 Hz
60 Hz
400 Hz

Global Coupling
Bandwidth Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

Switching Ripple DC に存在する最大 AC 電圧を測定します。

Ripple Freq スイッチング・リップル周波
数

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

測定 サブ・タイプ／設定 説明

スペクトラム解析を選択

スペクトラム解析 選択された Start、Stop、および RBW の値に基づいて、信

号に含まれる周波数成分の解析、測定、および表示を行
います。

Spectral Config Frequency Start
Frequency Stop
Window Type
Res BW
Update
Auto Setup
DC Block

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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測定 サブ・タイプ／設定 説明

ターン・オン時間 システムに入力電圧が印加された時間と、出力電圧が定
常状態になるまでの時間の遅延時間差異を測定します。

入力 Convertor
DC-DC
AC-DC
周波数
Source
Maximum Voltage
Trigger Level
Max Turn on Time

出力 Source1
On
Off
Max Voltage
Source2
On
Off
Max Voltage
Source3
On
Off
Max Voltage

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

測定および設定の一覧：

振幅

測定 サブ・タイプ／設定 説明

High
Low
High-Low

Edge Measure the Center X% of the
signal
Methods

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode

サイクル最小値
サイクル最大値
サイクル・ピーク

Signal Type AC
DC

オプション Units
Ref Level
ヒステリシス

Global Coupling
BW Limit
Cursor Gating
Acquisition Mode
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新しい測定の実行

測定の実行について 測定を行うには、次の手順を実行します。

1. 必要な電圧プローブと電流プローブを被測定ユニットに接続します。

2. Source Configuration パネルで Current と Voltage についてそれぞれソース

を設定します。

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、「安全にご使用いただくために」を参
照してください。

注： 測定を実行するときは、リアルタイム・サンプリング・モードを選択する必要
があります。

結果の解析 取り込まれた波形を解析した後、測定を選択および実行して、結果を表示しま
す。また、さまざまな測定の「結果の表示」を参照することや、レポート・ツールを
使用してカスタム・レポートを作成することもできます。

結果の表示 測定が正常に完了すると、アプリケーションは要約結果および詳細結果を表示
します。

結果の詳細を表示するには、Detailed Results タブを選択します。表示する測定

によって、詳細は変化します。

 

 

要約結果は、Current および Accumulated になります。Current は、現在のアク

イジションの結果を示します。Accumulated は、すべてのアクイジション (以前お

よび現在) の統計を示します。測定結果の要約を表示するには、Accumulated
タブを選択します。
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アプリケーションは、選択したすべての測定の統計を計算します。Results メニュ

ーに以下の統計が表示されます。

■ Max （最大値）。アプリケーションでは、最大値の計算に次の式を使用しま

す。Max(X) = X の最大値。

■ Min （最小値）。アプリケーションでは、最小値の計算に次の式を使用しま

す。Min(X) = X の最小値。

■ 平均。アプリケーションでは、平均値の計算に次の式を使用します。

 

 

■ Std Dev （標準偏差）。アプリケーションでは、標準偏差の計算に次の式を

使用します。

 

 

■ ピーク・ツー・ピーク。アプリケーションでは、ピーク・ツー・ピーク値の計算に

次の式を使用します。 

■ 母集団。母集団は、他の統計が計算されるイベントまたは観察の合計数で
す。母集団（X）は波形のサイクル数を表し、サイクルが意味を持たない測定

の場合、母集団はアクイジションの数として表示されます。

■ 結果。このフィールドは、測定が成功したか、あるいは失敗したかを示しま
す。このフィールドが失敗になっている場合、解析中にエラーが発生してい
ます。測定が実行されると、フィールドには‘Not Available’と表示され、測定

の結果に基づいて Success または Failure に変わります。

注： 設定を変更すると、以前に計算された結果がクリアされるため、結果表も空
になり、何も表示されなくなります。
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測定結果をさらに表示するには、More タブを選択します。追加の結果は、選択

した測定に応じて異なります。

 

 

コンポーネントのプロット

と機能

プロットの詳細と機能を制御するにはプロット・メニュー・バーを使用します。

 

 

メニュー項目 説明

X-Axis、Y-Axis、または Both を選択して、選択した軸

のズームインとズームアウトを有効にします。

プロット・ウィンドウを初期状態にリセットします。

手の形を使用して、プロット・ウィンドウをパンした
り、波形表示内を移動したりします。

表示領域の中心にプロット・カーソルを移動します。

プロット・カーソル、水平軸、垂直軸、または両方を
設定します。Show Legend は XY 位置の詳細を表示

します。

直線補間によりプロット・データ・ポイント間を接続し
ます。

プロット・イメージを .png フォーマットのファイルに保

存します。
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メニュー項目 説明

Details を選択すると、ピーク間の移動や垂直軸の

各種スケール・オプションなどの詳細が表示されま
す。

複数のプロットがある場合は、Layout ボタンが有効

になります。プロットを縦または横に配列するには
Summary ボタンを使用します。最大で同時に 4 つの

プロットを表示できます。

プロットの表示. 複数のプロットがある場合は、Layout (multiple plots) 表示セレ
クタで Grid か Flow のいずれかを選択します。

Figure 1: 複数プロットのオプション
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グリッド表示. 同時に複数のプロットを表示し、比較できます。複数のプロットを
選択する場合は、グリッド表示が推奨されます。各種プロット・データを横に並べ
て表示し、比較することができます。デフォルトではグリッド表示が選択されま
す。グリッドの横の数字を使用して、各行に並べて表示するプロットの数を指定
します。指定可能な最大数は 4 です。

■ Grid 1 (1*1)：1 行にプロットを 1 つ表示します。
 

 
■ Grid 2 (1*2)：1 行にプロットを 2 つ横に並べて表示します。

 

 
■ Grid 3 (1*3)：1 行にプロットを 3 つ横に並べて表示します。
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■ Grid 4 (1*4)：1 行にプロットを 4 つ横に並べて表示します。
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フロー表示. 複数プロットのコンポーネントはプロット・ウィンドウのサイズに従って
配置されます。デフォルトでは、プロットが横に並びます。プロット・ウィンドウのサ
イズを調整すると、選択したプロットの構成を変えることができます。たとえば、次
のフロー表示は、プロットが 1 つの列に整列されています（4*1）。

フロー表示は 1 つのプロットを表示するときに役立ちます。
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Figure 2: フロー表示
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プロットの表示 一部の測定では、正常に完了したときにプロットが生成されます。Analysis >
Advanced Power Analysis を選択してから、Plots ナビゲーション・タブを選択し、

対応する有効測定のプロットを設定および表示します。

 

 

注： 最大 4 個のプロットを追加できます。4 個のプロットはすべて 1 つのウィンド
ウに表示され、各プロットはダブルクリックすることによって全画面に拡大すること
ができます。プロットをダブルクリックすると、最大サイズとコンパクト・サイズの間
で切り替わります。プロット・メニュー・バーのコントロールの詳細についてはコン
ポーネントのプロットと機能を参照してください。

 

 

プロットをプロット・テーブルに追加するには、Plots ボタンをクリックします。プロ

ット・テーブルから選択したプロットを削除するには、Clear を選択します。プロッ

ト・テーブルからすべてのプロットを削除するには、Clear All を選択します。プロ

ットを表示するには、Show Plots ボタンをクリックします。

次の例では、Magnetic BH Curve （磁気 BH 曲線） プロットが表示されていま

す。
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追加された詳細結果を表示するには、プロットをダブルクリックします。プロット上
の点をクリックすると、そのポイントの詳細が表示されます。

注： レコード長が大きいと、プロット操作は非常に遅くなります。一般に、これは
レコード長の更新が高すぎる場合に観察されます。このプロセス中は、アプリケ
ーションのユーザ・インタフェースでどんな操作も実行しないでください。フリー
実行中、アプリケーションはかなり長いレコード長の大きなプロット・データを描
画します。フリー実行を停止するには、オシロスコープの RUN/STOP ボタンの
STOP を押して、アプリケーション・シーケンサを一時停止します。これで、アプリ
ケーションが停止します。フロント・パネルの Run ボタン ボタンを押すと、シーケ
ンシングが継続されます。
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プロットのオートスケール. デフォルトでは、プロットは選択されたマスク範囲に
基づいてオートスケールされます。たとえばマスク違反があった場合、プロットを
表示する際には、違反領域のみが表示されます。プロット・ウィンドウでデータ全
体を表示するには、プロット・ツール・ボックスの Reset ボタンをクリックします。

Figure 3: 違反のあるプロット

Figure 4: リセットして全体を表示

NOTE. マスク違反がなかった場合には、プロットをリセットするとデータ全体が表
示されます。
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カーソルを中心に移動： カーソルを中心に移動したいときに使用できます。波
形をクローズアップ表示したり、ズームを使用すると、表示領域に合わせてプロ
ットがリセットされるため、カーソル線が画面から外れてしまいます。Position
Cursors to Center を使用すると、カーソルを表示領域の中心に移動できるため、
必要に応じて位置を変えることができます。

図 5 : カーソルが表示されたプロット

図 6 : カーソルが中心に移動

レポート 測定が正常に完了すると、プロットが生成されます。レポートをセットアップして
表示するには、Reprots を選択します。
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レポートを設計するには、次の手順を実行します。

1. Report Name フィールドで、Browse をクリックして使用するレポートの名前を

参照するか、フィールドをダブルクリックして完全なファイル名およびパスを
ポップアップ・キーボードで入力します。Report Name フィールドには、レポ

ートが保存されているディレクトリ・パスが含まれます。

2. レポート名が既に存在する場合に自動増分するには、Auto increment
report name if duplicate ボックスにチェックを入れます。自動生成されるレポ

ート名の形式は YYMMDD_HHMMSS_savedfile.mht です。

3. 生成後にレポートを表示するには、View report after generating ボックスに

チェックを入れます。

4. Content To Save フィールドで、レポートに含める項目をチェックします。

■ Include results summary を選択すると、生成されるレポートに結果要約

ステータスが含められます。

■ Included detailed results を選択すると、生成されるレポートに測定結果

の詳細が含められます。

■ Include plot images を選択すると、生成されるレポートに測定プロットお

よびオシロスコープ波形のようなプロット・イメージが含められます。

■ Include user comments を選択すると、生成されるレポートに任意のコメ

ントが含められます。コメントを追加するには、Add Comment ボタンをク

リックします。

■ Include setup configuration を選択すると、生成されるレポートに

DPOPWR のバージョン、オシロスコープのバージョン、ステータスが含

められます。

■ Include complete application configuration を選択すると、生成されるレ

ポートに完全な構成の詳細が含められます。

5. 現在の設定を既存のレポートに追加するには、Append ボタンをクリックしま

す。

6. 変更内容をデフォルトのレポート・ディレクトリに保存するには、Save または

Save As ボタンをクリックします。レポート名は、Auto increment report name
if duplicate オプションに基づいて変更されます。

7. レポートを表示するには、View ボタンをクリックします。次のイメージで、レ

ポートの例を示します。
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測定の選択 測定を行うには、Analyze > Power Analysis を選択してから、Select ナビゲーシ

ョン・タブをクリックして、アプリケーションのデフォルトの開始画面を表示します。

測定項目には、次の 6 つのカテゴリがあります。

■ スイッチング解析、

■ タイミング解析、

■ 磁気、

■ 入力解析、

■ 出力解析、

■ 振幅

次の表に、これらのカテゴリ別の測定を示します。

スイッチング
解析

タイミング解
析

磁気 入力解析 出力解析 振幅

スイッチング・
ロス

パルス幅 インダクタン
ス

電源品質 ライン・リップ
ル

High

Hi-Power
Finder

周期 磁気損失 電流高調波 スイッチング・
リップル

Low

SOA デューティ・
サイクル

磁気特性 全体の電源
品質

スペクトラム
解析

（ハイ）-（ロ
ー）

SOA X-Y
（DPX）

周波数 Ivs ∫V 突入電流 ターン・オン
時間

サイクル最小
値

dv/dt スキュー  入力キャパシ
タンス

 サイクル最大
値

di/dt   電圧高調波  サイクル・ピ
ーク

RDS(on)     

測定を選択して、波形ソース、電圧、電流、およびプローブの設定に基づいて
アプリケーションを設定します。
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ソース設定 Source Configuration パネル： 画面左の Source Configuration パネルには、ソー

ス、電圧、電流、電流プローブ、ゲートの共通の設定オプションがあります。

Source Configuration パネルでオプションを設定するには、次の手順を実行しま

す。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、プローブおよびその他のコンポーネントが定格内で使用されることを確
認してください。「安全にご使用いただくために」を参照してください。

1. オシロスコープのリファレンス波形を使用するには、Ref オプションを選択し

ます。被測定ユニットの波形を取り込むには、Ch オプションを選択します。

デフォルトの選択は Ch1 です。

■ ライブ・ソースを選択すると、デフォルトの電圧のソースは Ch1 となり、電

流のソースは Ch2 となります。使用可能な選択は次のとおりです。Ch1、
Ch2、Ch3、Ch4、Math1、Math2、Math3、Math4。Math は、Live を選択

し、Ref 以外のチャネルを選択した場合にのみ選択できます。特定のチ

ャンネルを選択するには、Voltage フィールドおよび Current フィールド

にあるボタンを使用します。リップルは REF チャンネルをサポートしてい

ます。SOA X-Y( DPX) を除き、すべての測定で REF チャンネルと Live
チャンネルの両方がサポートされます。ここでは演算の選択肢はありま
せん。

 拡張電源測定および解析ソフトウェア

拡張電源解析 59



■ Ref オプションを選択すると、デフォルトの電圧のソースは Ref1 となり、

電流のソースは Ref2 となります。特定のチャンネルを選択するには、

Voltage フィールドおよび Current フィールドにあるボタンを使用します。

注： 電圧のソースとして Math が選択されている場合、演算は選択され
た演算の保存先から独立している必要があります。演算の保存先は、
選択された演算の保存先が、選択された測定または演算定義のすべて
から独立している場合にのみ、定義済みの関数で定義されます。
Voltage フィールドと Current フィールドとで、同じチャンネル・ソースを
選択することはできません。たとえば、Voltage フィールドで Ch1 を選択
し、Current フィールドでも Ch1 を選択して Run を選択すると、"Conflict
in selection of voltage source and current source." というエラー・メッセー
ジが表示されます。電圧と電流のソース選択は、選択された測定に依
存します。

Vg Level ボックスをダブルクリックし、表示されたキーパッドを使用して、値

を入力します。Source Configuration ウィンドウで Vg オプションを選択して

いる場合、Vg 値の許容範囲は 0 ～ 50 V であり、デフォルト値は 1.5 V で
す。ゲート電圧を選択すると、電源オンの開始のデフォルト値を変更できま
す。デフォルト値は、最大 Vg の 5% と Vg の 1.5 V のうちの小さい方です。

2. Source Autoset パネルの Vert Scale、Horiz Res、または Vert & Horiz ボタン

を押して、測定に最適なスケールおよび解像度を自動的に設定します。

3. 最後のオートセット操作に戻すには、Source Autoset パネルの Undo を押し

ます。
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ソース・オートセット： Source Autoset パネルには、次のコマンド・ボタンが含まれ

ます。

■ Vert Scale

■ Horiz Res

■ Vert & Horiz

■ Undo

Source Autoset を使用して、オシロスコープの垂直設定または水平設定（または

その両方）をライブ・ソース （Ch1-Ch4） 用に自動調整したり、測定グループに従

ってオシロスコープをセットアップしたりできます。

Vertical Scale オプションは、ライブ・ソースのピーク・ツー・ピーク・レベルを自動

的にチェックします。ピーク・ツー・ピーク値が 6 目盛より少ないすべての信号の

垂直軸スケールおよびオフセットは、ピーク・ツー・ピーク値が 8 目盛になるよう

に調整されます。信号の最大値または最小値がクリップされている場合、垂直
軸スケールおよびオフセットは、ピーク・ツー・ピーク値が 8 目盛以上になるよう

に調整されます。クリッピングが検出された場合、エラー・メッセージが表示され
ます。

Horizontal Resolution オプションは、すべてのライブ・チャネルの時間軸を調整

し、非常に低い周波数（200 Hz）の場合は少なくとも 5 つの完全なサイクル、高

い信号周波数の場合はさらに多くのサイクルが表示されるようにします。スイッチ
ング・ロス、変調解析、磁気特性の測定では、ほぼ同じ方法でオシロスコープが
セットアップされます。ただし、入力解析および出力解析のスペクトラム、ライン・
リップル、スイッチング・リップルなどの測定では、水平時間軸は解像度帯域幅
（RBW） およびリップル周波数に基づいて設定されるため、別の方法でセットア

ップが行われます。Input and Output Analysis 測定が Switching Loss および

Modulation Analysis グループとともに選択された場合、水平パラメータの設定

では後者が優先されます。

垂直設定および水平設定を両方ともすべてのチャネル・ソースに自動的に定義
するには、Vert and Horiz ボタンを選択します。Vert and Horiz （垂直および水

平） オプションは、垂直軸スケールおよび水平解像度のオートセットを実行する

前に、各チャネルでオシロスコープのオートセットも適用します。

垂直および水平設定. 有効なソースに垂直または水平設定を自動的に定義す
るには、次の手順を実行します。

1. オートセットする任意のチャネルの波形がオシロスコープ上に表示されてい
ることを確認します。

 拡張電源測定および解析ソフトウェア

拡張電源解析 61



2. 次のオプションのいずれか 1 つを選択します。

■ Vert & Horiz （垂直および水平設定の両方をオートセットする場合）

■ Vert Scale （オシロスコープの垂直設定のみをオートセットする場合）

■ Horiz Res （オシロスコープの水平設定のみをオートセットする場合）

■ オシロスコープをオートセットする前の状態に戻す場合には、Undo を選
択します

 

 

NOTE. オートセットはデスキュー値にも関係します。デスキュー値がオートセ
ットによって設定されたサンプル間隔よりも小さい場合、デスキュー値はオシ
ロスコープによって 0.0 秒に丸められます。これは、Vertical > Deskew メニ
ューの場合に起こる可能性があります。この場合は、より高いサンプル・レー
トを使用することをお勧めします。

測定の選択および設定 1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択して、Select ナビゲーション・タブを押して、デフォルトの画面を表示

します。

2. Switching Analysis タブをクリックします。Measurements パネルで SOA をク

リックします。

SOA Mask Editor を使用するには、次の手順を実行します。
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1. SOA プロットにマスクを適用するには、Mask フィールドの Enable チェック・

ボックスをオンにします。

 

 

2. Mask X および Mask Y の各フィールドをダブルクリックし、表示されたキー

パッドを使用してマスク値の XY 座標を設定します。Add ボタンをクリックし、

新規のマスク・ポイントとしてマスク値を追加します。Update ボタンをクリック

し、選択したマスク・ポイントを新規のマスク値で更新します。Recall ボタンを

クリックし、デフォルト・ディレクトリまたは任意のディレクトリに保存されている
マスクを取得します。

3. Graph ボタンをクリックし、マスクをプレビューします。

 

 

4. SOA を設定し、Run をクリックして、マスクが背景に設定された SOA プロット

を表示します。
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5. 同様にして、上記ステップに次いで対数マスクを作成することができます。
Log タイプを選択します。

 

 
 

 
6. Save フィールドの Mask ボタンをクリックすると、デフォルト・ディレクトリ

（\User\Public\Tektronix\TekApplications\Advanced Power Analysis\SOA
Mask\）または任意のフォルダにマスクを .msk ファイルとして保存できます。

マスクでは、SOA プロット上で合格または不合格の領域が識別され、それら

の領域が異なる色で表示されます。Save ボタンを選択すると、マスク全体を

イメージとして保存できます。

7. マスクは、Graph ボタンをクリックしてグラフィカルに、またはマスク・エディタ

で座標を入力して、作成することができます。

Graph モードでは、マウスをクリックして、フリー・ハンドでグラフを描くことが

できます。描画が完了したら Apply をクリックしてマスクを完成します。
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8. Apply をクリックした後、閉じるボタンをクリックすると、マスク・エディタでグラ

フから得たマスク・ポイントを確認できます。

9. Log と Linear のボタンを切り替えて、対数と線形のマスクを作成することが

できます。

マスク値を設定してマスクを定義できます。選択したマスク・ポイントを削除する
には Clear ボタンを選択し、すべてのマスク・ポイントを削除するには Clear All
ボタンを選択します。

グローバル設定の構成 すべての測定に適用される設定を作成するには、Global タブを選択します。

 

 

Global タブで、次の設定を実行します。

■ カップリングを設定します:AC または DC

■ BW Limit フィールドで帯域制限のオプションを選択します:20 MHz、
250 MHz、または Full。Full オプションは、オシロスコープで使用可能な最

大帯域幅を表します。これらのオプションは、サポートされているオシロスコ
ープのうち、一部のものでは使用できない場合があります。使用しているオ
シロスコープの帯域幅オプションを参照してください。

■ カーソル・ゲートを On または OFF にします。波形の特定部分を解析するに

は、オンを選択してゲート測定を有効にします。Cursor Gating を有効にして

から Run ボタン または Single をクリックすると、"Place the cursors at the
appropriate region of the waveform." というメッセージが表示されます。指示

に従ってカーソルを置きます。Yes を選択すると、複数のカーソルの間とし

て示された、波形の選択された部分に対する解析が実行され、タイム・トレン
ドがプロットされます。

■ アクイジション・モードを設定します：Hi Res、Average、Sample モード。平均

モードが選択されている場合、平均値を変更できます （オシロスコープの

Horizontal アクイジション・メニュー内で）。デフォルトで、平均値は 16 に設

定されています。
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オプションの設定 単位、基準レベル、ヒステリシス、ログ・スイッチング・サイクル、信号調整、フィル
タ電流を設定するには、Options タブを選択します。

 

 

1. Signal Condition オプションを有効にします。Signal Condition オプションを

有効にすると、電源オフから次の電源オンまでの間、スイッチ電流がゼロに
リセットされます。Filter Current オプションを選択すると、電源オンの間、スイ

ッチ電流に低レベルでリンギングが発生します。

2. Filter Current オプションを有効にします。Filter Current オプションを選択す

ると、電源オンの間、スイッチ電流に低レベルでリンギングが発生します。デ
フォルト値は、最大 Vg の 5% と Vg の 1.5 V のうちの小さい方です。

3. スイッチング・サイクルを .csv ファイルに記録するには、Log Switching
cycles を有効にします。

4. Units ドロップダウン・メニューの Percentage オプションを選択して、Ref
Level の値、Hysteresis の値、V-Level の値、I-Level の値をパーセンテージ

として設定するか、または、Absolute オプションを選択して、ピーク・ツー・ピ

ーク信号の絶対値を設定します。

5. Ref Level フィールドをダブルクリックし、表示されたキーパッドを使用して、

基準レベル値を絶対値またはパーセンテージとして設定します。

6. Hysteresis フィールドをダブルクリックし、表示されたキーパッドを使用して、

ヒステリシス値を絶対値またはパーセンテージとして設定します。

エッジの設定 エッジの極性を設定するには、Edges タブを選択し、Positive または Negative の
いずれかの極性を選択します。
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コントロール・パネル Control Panel はアプリケーション・ウィンドウの右に表示されます。このパネルを

使用して、アプリケーションおよびオシロスコープのプロセスのシーケンスを開始
または停止して、波形から情報を取り込むことができます。

 

 

プロットが選択されている場合、コントロール・パネルには Show Plots が含まれ

ます。

 

 

次のリストは、各コントロールについて説明しています。

■ Clear は、現在の結果画面をクリアし、すべての統計結果およびオートセット

基準レベルをリセットします

■ Recalc は、現在のアクイジションに対して選択した測定を実行します

■ Single は、新規のアクイジションを開始し、選択した測定を実行します

■ Run ボタン は、新規のアクイジションを開始し、Stop がクリックされるまで、選

択した測定を繰り返し実行します Run ボタン は、ライブ・ソースにのみ使用

されます。

■ Show Plots はプロットの要約ウィンドウを表示します。このボタンは、プロット

が選択されている場合にのみコントロール・パネルに表示されます
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スイッチング測定および解析

スイッチング・ロス 測定の選択および設定 - スイッチング・ロス：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択して、Select ナビゲーション・タブを押して、デフォルトの画面を表示

します。

2. Switching Analysis をクリックして、Switching Analysis 画面を表示します。

3. Switching Analysis フィールドで、Switching Loss をクリックします。

Configure をクリックします。

1. スイッチング・ロス・オプションでは、定常動作状態においてスイッチング・デ
バイス全体で消散した電力量が計算されます。結果は、選択した測定に応
じて異なります。

2. Type タブ、On-Off Level タブ、Options タブ、および Global タブをクリックす

ると、パラメータを設定できます。

注： 最適な信号が得られるように垂直および水平ソースのオートセットを実行し
ます。

注： スイッチング・ロスを解析する場合は、ハイレゾ・アクイジション・モードを使
用することをお勧めします。

1. スイッチング・ロス・オプションでは、定常動作状態においてスイッチング・デ
バイス全体で消散した電力量が計算されます。結果は、選択した測定に応
じて異なります。

2. Type タブ、On-Off Level タブ、Options タブ、および Global タブをクリックす

ると、パラメータを設定できます。

図 7 : スイッチング・ロス
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スイッチング・ロス・エッジ・ソース：

Edge Source フィールドでスイッチング・ロス制御信号パラメータを設定するに

は、次の手順を実行します。

1. エッジ・ソースは Source Configuration パネルで設定された電圧ソースとなり

ます。

アプリケーションは次のものを識別します。

■ スイッチ電圧のエッジ

■ 電源オフ部分と電源オンの部分（スイッチ電圧およびスイッチ電流を使
用）

2. Units ドロップダウン・メニューの Percentage オプションを選択して、Ref
Level の値および Hysteresis の値をパーセンテージとして設定するか、また

は、Absolute オプションを選択して、ピーク・ツー・ピーク信号の絶対値を設

定します。

3. Ref Level ボックスをダブルクリックし、表示されたキーパッドを使用して、基

準レベル値の絶対値またはパーセンテージを設定するか、または
Hysteresis ボックスをダブルクリックし、表示されたキーパッドを使用して、ヒ

ステリシス値の絶対値またはパーセンテージを設定します。

測定が正常に実行されると、結果が自動的に表示されます。
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スイッチング・ロス・タイプ： Type タブでスイッチング・ロスのパラメータを設定す

るには、次の手順を実行します。

1. スイッチング・デバイス・タイプ・オプションを有効にするには、Device フィー

ルドで User ボタンをクリックします。MOSFET または BJT/GBT スイッチン

グ・デバイスを選択します。MOSFET を選択した場合は、RDS(on) ボックス

をダブルクリックし、表示されたキーパッドを使用して、データ・シート内にあ
る、指定された動作温度における RDS 値を入力します。Auto ボタンを選択

した場合は、スイッチ電圧および電流を使用して合計電力損失およびエネ
ルギーが計算されて、スイッチ電圧の垂直軸スケールがチェックされます。
スイッチ電圧スケールが 1 目盛あたり 10 ボルトを超えている場合、アプリケ

ーションには次の警告メッセージが表示されます。"Vertical Scale of Switch
Voltage > 10 V and the user defined RDSon is not selected.So the calculated
energy and loss may not be accurate."

PFC が選択されているとき、アプリケーションは少なくとも 20 ミリ秒、または

電源周波数（50 または 60 Hz）の少なくとも 2 サイクル相当を取り込むように

オシロスコープを設定します。PFC タイプの詳細については、ここをクリック
してください。

 

 

測定が正常に実行されると、結果が自動的に表示されます。

注： PFC タイプが選択されると、カーソル・ゲートがオンになります。PFC タイプ
の選択を解除しても、カーソルの状態は以前のまま保たれます。ユーザはグロ
ーバル設定を使用して、カーソルのオンまたはオフを制御できます。
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スイッチング・ロスの Ton および Toff 基準レベル： Ton and Toff Levels フィール

ドでスイッチング・ロスの Ton および Toff 基準レベルのパラメータを設定するに

は、次の手順を実行します。
 

 

1. Device ドロップダウン・メニューから半導体タイプ（DUT）を選択します。使用

可能なオプションは次のとおりです。N-Channel および P-ChannelN-
Channel のデバイスでは、スイッチ電圧、スイッチ電流、およびゲート電圧は

正です。P-Channel のデバイスでは、ゲート電圧は正と負のいずれかとなる

か、または負のみとなります。

2. Units ドロップダウン・メニューの Percentage オプションを選択して、Ref
Level の値および Hysteresis の値をパーセンテージとして設定するか、また

は、Absolute オプションを選択して、ピーク・ツー・ピーク信号の絶対値を設

定します。

3. V-Level ボックスをダブルクリックし、表示されたキーパッドを使用して、V レ
ベル値を絶対値またはパーセンテージとして設定します。Ton の開始の V
レベル値はスイッチの電流の 5%、Ton の終了の V レベル値は最大スイッ

チ電圧の 5% です。

4. I-Level ボックスをダブルクリックし、表示されたキーパッドを使用して、I レベ

ル値を絶対値またはパーセンテージとして設定します。

5. Math Destination ドロップダウン・メニューから演算の保存先を選択します。

デフォルトの保存先は Math1 です。

注： エンベロープ形状でのスイッチング電流または電圧振幅が異なる場合は、
正確な結果を得るために TON および TOFF のレベルを絶対値の単位で指定
する必要があります。

測定が正常に実行されると、結果が自動的に表示されます。
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スイッチング・ロス・オプション： Options タブでスイッチング・ロス・オプションのパ

ラメータを設定するには、次の手順を実行します。
 

 

1. 電源オンの間の電流信号のリンギングが低いレベルに抑えられている場合
には、Signal Condition オプションおよび Filter Current オプションを有効に

します。デフォルト値は、最大 Vg の 5% と Vg の 1.5 V のうちの小さい方で

す。

2. Units ドロップダウン・メニューの Percentage オプションを選択して、Ref
Level の値および Hysteresis の値をパーセンテージとして設定するか、また

は、Absolute オプションを選択して、ピーク・ツー・ピーク信号の絶対値を設

定します。

3. Ref Level フィールドをダブルクリックし、表示されたキーパッドを使用して、

基準レベル値を絶対値またはパーセンテージとして設定します。

4. Hysteresis フィールドをダブルクリックし、表示されたキーパッドを使用して、

ヒステリシス値を絶対値またはパーセンテージとして設定します。

5. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

6. Run を押してデータを取り込みます。

測定が正常に実行されると、結果が自動的に表示されます。
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スイッチング・ロス - PFC： このセクションでは、PCF を選択して測定を実行すると

きの流れを説明します。

1. アプリケーションでは、カーソルを配置して対象領域を指定できます。
 

 

2. PFC 制御にゲート電圧が使用される可能性が示されています。
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3. アプリケーションによって Vg にリンギングが検出された場合は、エラー・メッ

セージが表示されるので、ノイズが多い VG ソースでの REF レベルの計算
の説明に従って RF レベルを調整します。
 

 

4. スイッチ電圧が良好なことが確認されたら、Vds に変更して、測定を実行し

ます。
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スイッチング・ロス PFC - カーソル・ゲート： カーソル・ゲートは、スイッチング・ロ

ス測定において、すべてのスイッチング・サイクル全体の損失を表す値がライン
電圧の半サイクルを示す整数値（通常は電源周波数の半サイクル）の範囲内に
なるようにしたいときに使用されます。AC/DC スイッチング電源では、定常動作

状態のデバイスから放出されたすべての熱エネルギーを取り除くために、ヒー
ト・シンクが設計されます。この放散熱の量は、デバイス全体から測定される損
失に比例します。初期位相の段階では、電流はきわめて低く、スイッチング電圧
は DC モードになります。そのため、取り込まれた波形の電源 1 周期に相当す

る領域についての平均損失が測定されます。

カーソルは、50/60 Hz の半サイクルの時間分をカバーできるように、ライン電圧

のゼロ交差の近くに配置しなければなりません。スイッチング波形をズームして、
電流がゼロに近づく地点を観察しながら、カーソルを配置します。ライン電圧の
ゼロ交差付近にカーソルを配置しておけば、カーソルを正確な位置に配置する
ことはそれほど重要ではなくなります。ライン電圧のゼロ交差付近ではスイッチン
グ損失が最も低くなるため、あらゆる測定誤差が最小に抑えられるためです。カ
ーソル間の領域が 100/120 Hz になっていることを確認しておきます。

図 8 : カーソルがゼロに近い位置のスイッチング波形

図 9 : スイッチング波形とゼロ交差近くのカーソル

ポスト・プロセスで PFC トポロジを使用する場合には、エッジ・ソースとしてゲート

電圧を使用することをお勧めします。次の図に示すように、スイッチ電圧はデュ
ーティ・サイクルや動作周波数が変化する可能性があります。スイッチ電圧は連
続伝導モードと非連続伝導モードのどちらにも見られるため、スイッチ電圧を使
用してスイッチング・サイクルを識別することはできません。そのため、正しいスイ
ッチング・サイクルを識別するためにゲート・ドライブ信号が使用されます。また、
ゲート電圧はパルスがクリーンであり、IC によるパルス制御のようなリンギングが

発生しません。
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次の図は、デューティ・サイクルおよび周波数の変化を示しています。Ref1 はス

イッチング・デバイスで取り込まれたスイッチ電圧、Ref2 はゲート・ドライブ信号を

それぞれ示しています。Ref1 は、スイッチング・サイクルの周期内に非連続伝導

モードになっています。
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結果の表示 - スイッチング・ロス： 結果の事後解析中には、オシロスコープ設定

を変更しないでください。設定を変更すると、オシロスコープがプレビュー・モー
ドになります。変更すると、結果が正しく解釈されなくなることがあります。

オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis >
Results を選択してから、Current を押して、現在の結果を表示します。現在の結

果には、全体平均損失の元になる各種の統計値が表示されます。
 

 

オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis >
Results を選択してから、Detailed を押して、詳細な結果を表示します。詳細な

結果には、TOn、TOff、伝導損失およびエネルギーに関する統計値が表示され

ます。
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スイッチング・ロス測定の結果は、Power Loss と Energy という 2 つのセクション

に表示されます。

1. Power Loss 列の Min フィールドには、取り込みにおける最小損失がワット

単位で表示されます。Max 列には、取り込みにおける最大損失がワット単

位で表示されます。Average 列には、TOn 平均、TOff 平均、および伝導損

失の合計が表示されます。

2. Energy 列の Min フィールドには、各サイクルに対して計算されたすべての

エネルギー値の最小値が表示されます。Max 列には、各サイクルに対して

計算されたすべてのエネルギー値の最大値が表示されます。Average 列に

は、TOn エネルギー、TOff エネルギー、および伝導エネルギーの合計がジ

ュール単位で表示されます。

注： Detailed 結果タブの Total Avg には伝導損失が含まれており、アクイジショ
ン全体についての結果が計算されています。

注： 結果のスイッチング・ロスが負になる場合は、使用されている電圧および電
流プローブの DC オフセットが原因である可能性があります。これを回避するに
は、プローブの DC オフセットを補正して、アプリケーションを起動する前にオシ
ロスコープで SPC（信号パス補正）オプションを実行します。DC カップリングの
みを使用してください。
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注： リンギングにより間違ったエッジが検出される可能性があるため、アプリケー
ションはスイッチング電圧や電流波形ではエッジを計算できません。そのため、
PFC やフライバック方式などのトポロジを使用する場合には、エッジ・ソースとし
てゲート電圧を使用することをお勧めします。

注： ゲート電圧を使用する場合のスイッチング・ロスの測定における TOn および
TOff の定義は次のようになります。

■ TOn は、ゲート信号がオンになったときから、スイッチング・デバイスがオン
になるまでの時間として定義されます。

■ TOff は、ゲート信号がオフになったときから、スイッチング・デバイスがオフ
になるまでの時間として定義されます。

スイッチング・ロスのプロット. Switching ON OFF プロットが選択された場合、
Show Plots をクリックしてプロットを表示します。
 

 

Plot View を使用して、すべてのサイクル、または 1 つのサイクルに基づいたテ
ーブルの値のプロットを表示できます。

■ Selected SW Cycle：1 つのサイクルに基づいたテーブルの値のプロットを表
示します。

■ All SW Cycles：すべてのサイクルのテーブルの値のプロットを表示します。

NOTE. スイッチング・ロスのプロットに使用される Plot View および Maker Value
テーブルは、Details 表示に表示されます。
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NOTE. 選択したサイクルのプロット表示が、ON または OFF のいずれかの領域
だけになってしまう場合があります。これは、PFC 波形で 50/60 Hz 領域を選択
したときに起こります。PFC 波形を読み込み、120 Hz 領域でカーソルを選択しま
す。測定を実行すると、プロットと結果が表示されます。個々のサイクルのプロッ
ト表示には、OFF サイクルのみが存在します。これは、ON 損失が存在しない
か、またはタイム・ドメインの波形で ON 損失がゼロであるためです。ON だけの
場合も同じです。従って、プロットに ON と OFF が同時に表示されることはあり
ません。

次の項目も参照してください。：

測定の選択および設定 - スイッチング・ロス

コンポーネントのプロットと機能
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スイッチング・ロス結果のトラブルシューティング：

左の図は、スイッチング・デバイスの電流波形を示しています。右の図は、ズー
ムインされた信号を示しています。スイッチ電流のターン・オン中に、これらの図
に示すようなスパイクが発生しています。Ton and Toff タブで I 値を 5% に設定

している場合、この 5% という値は、解析中にスイッチ電流の最大値に 0.05 を乗

算した絶対値に変換されます。この場合、スイッチ電流の最大値は、信号のス
パイクを示しています。このことは、Ton 中のみ当てはまります。計算された最大

スイッチ電流値は、ターン・オフの終了を識別するために使用されます。Ton と
Toff の計算に最大スパイク値を使用しているため、Ton の終了の値が正確でな

くなります。このことを回避するには、基準値を絶対値の単位でのみ入力してく
ださい。

スイッチング・ロスの結果としてゼロの値が表示される場合は、どのようにすれば
よいでしょうか。

 

 

■ Options タブで Filter Current チェック・ボックスをオフにし、かつ、スイッチン

グ電流波形が前の図のようになった場合、Ton の開始はカーソル 2 の位置

から検出されます。アルゴリズムでは、設定されたレベルがカーソル 2 の位

置から検索され、その後、最初のレベルに移ります。この場合は、Ton の開

始が Ton の終了の後として計算され、エネルギーと損失がゼロになります。

■ 設定された I レベルが信号範囲を超えている場合、Ton および Toff のエネ

ルギーと損失はゼロとなり、警告メッセージが表示されます。
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■ Edge Finder タブで Vg オプション・ボタンを選択した場合、ゲート電圧は、

前の図に示したようなグリッチやリンギングのない、クリーンなパルスである
必要があります。ゲート電圧は、エッジ、つまり Ton または Toff 部分を識別

するために使用されます。グリッチが発生すると、誤った結果が表示されま
す。たとえば、スイッチング・サイクル中に複数のエッジ（誤ったエッジ）が検
出される場合があります。

 

 

信号（プッシュ・プル・デバイス）が前の図のようである場合は、電圧のスイッチン
グ部分でのみ基準レベルを設定します。スイッチングは、スイッチ電圧の下部で
のみ発生します。基準値として、下部スイッチング部分の中間に当たる 30% を
入力します。

P チャンネル・デバイスを選択した場合、スイッチング電圧および電流は負とな

り、ゲート電圧は負、または正と負のいずれかとなります。アプリケーションによっ
て波形が反転され、N チャンネル・デバイスと同様に解析されます。スイッチ電
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圧、電流、ゲートを反転して、デバイスを N チャンネルに設定するには、オシロ

スコープ・メニューで Vertical Setup > Invert オプションを選択します。

ハイパワー・ファインダ 測定の選択および設定 - ハイパワー・ファインダ：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択して、Select ナビゲーション・タブを押して、デフォルトの画面を表示

します。

2. Switching Analysis をクリックして、スイッチング解析測定画面を表示しま

す。

3. Switching Analysis フィールドで Hi-Power Finder をクリックします。ハイパワ

ー・ファインダでは、スイッチング波形上の瞬間的なピーク・パワーが計算さ
れます。結果は、選択した測定に応じて異なります。

4. Configure をクリックします。PWM Type タブ、On-Off Level タブ、Edges タブ

および Global タブをクリックすると、パラメータを設定できます。

注： 測定するには、波形が 8 目盛より高くなければなりません（垂直軸のオート
セットを使用可能）。ハイパワー・ファインダ解析を行う場合は、ハイレゾ・アクイ
ジション・モードを使用することをお勧めします。

ハイパワー・ファインダ.

ハイパワー・ファインダ・エッジ・ソース：

Edge Source フィールドでハイパワー・ファインダのパラメータを設定するには、

次の手順を実行します。

1. エッジ・ソースは Source Selection パネルで設定された電圧ソースとなりま

す。

アプリケーションは次のものを識別します。

■ スイッチ電圧のエッジ

■ 電源オフ部分と電源オンの部分（スイッチ電圧およびスイッチ電流を使
用）

2. Units ドロップダウン・ボックスの Percentage オプションを選択して、Ref Level
の値および Hysteresis の値をパーセンテージとして設定するか、または

Absolute オプションを選択して、ピーク・ツー・ピーク信号の絶対値を設定し

ます。

3. Ref Level ボックスをダブルクリックし、表示されたキーパッドを使用して、基

準レベル値の絶対値またはパーセンテージを設定するか、または
Hysteresis ボックスをダブルクリックし、表示されたキーパッドを使用して、ヒ

ステリシス値の絶対値またはパーセンテージを設定します。

測定が正常に実行されると、結果が自動的に表示されます。
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ハイパワー・ファインダ・タイプ： Type タブでハイパワー・ファインダのパラメータ

を設定するには、次の手順を実行します。
 

 

1. スイッチング・デバイスが可変デューティ・サイクルで動作している場合（非
連続伝導モードあり、またはなし）、Variable ボタンをクリックします。Variable
オプションを選択すると、On-Off Level タブの電圧エッジ・ソース選択は Vg
（ゲート・ドライブ信号）に切り替わります。Fixed オプションが選択されている

場合は、デューティ・サイクルが一定である、すべてのトポロジのスイッチン
グ・ロスが測定されます。

測定が正常に実行されると、結果が自動的に表示されます。
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ハイパワー・ファインダの Ton および Toff 基準レベル： OnOff Level フィールド

でハイパワー・ファインダのパラメータを設定するには、次の手順を実行します。
 

 

1. Device ドロップダウン・メニューから半導体タイプ（DUT）を選択します。使用

可能なオプションは次のとおりです。N-Channel および P-ChannelN-
Channel のデバイスでは、スイッチ電圧、スイッチ電流、およびゲート電圧は

正です。P-Channel のデバイスでは、ゲート電圧は正と負のいずれかとなる

か、または負のみとなります。

2. Units ドロップダウン・ボックスで Percentage オプションを選択して V-Level
および I-Level の値をピーク・ツー・ピーク信号に対するパーセンテージとし

て設定するか、または Absolute オプションを選択して V-Level および I-
Level の絶対値をアンペア単位で設定します。V-level と I-level の値は、

Ref Level の値と Hysteresis を 2 で割った値の和よりも小さい値にする必要

があります。

3. V-Level ボックスをダブルクリックし、表示されたキーパッドを使用して、V レ
ベル値を絶対値またはパーセンテージとして設定します。Ton の開始の V
レベル値はスイッチの電流の 5%、Ton の終了の V レベル値は最大スイッ

チ電圧の 5% です。

4. I-Level ボックスをダブルクリックし、表示されたキーパッドを使用して、I レベ

ル値を絶対値またはパーセンテージとして設定します。

5. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

6. Run を押してデータを取り込みます。

測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - ハイパワー・ファインダ： 結果の事後解析中には、オシロスコープ

設定を変更しないでください。変更すると、結果が正しく解釈されなくなることが
あります。

結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 次の図に示すように、ハイパワー・ファインダ測定の結果が表示されます。

3. Peak Finder タブおよび Switching Finder オプションの結果を表示します。

 

 

Peak Finder タブでは、次の結果が表示されます。

■ Summary には、電力波形のピークの最大値と最小値が表示されます。ま

た、単一の波形におけるオン・タイプのピークとオフ・タイプのピークの出現
回数または位置が表示されます。

■ Range フィールドの End ボックスと Start ボックスには、範囲内のピークが表

示されます。これらのボックスをダブルクリックし、表示されたキーパッドを使
用して、数値を入力します。その後、Update をクリックします。

■ Peak Value フィールドには、End と Start の範囲内のピークが降順に表示さ

れます。電圧と電流の波形上でのピーク位置を特定するには、Link をクリッ

クします。現在リンクされているピークの 1 つ前のピークにカーソル位置を移

動するには、Prev ボタンを使用します。現在リンクされているピークの 1 つ
後のピークにカーソル位置を移動するには、Next ボタンを使用します。デフ

ォルトで、1 つ目のピークにカーソルが置かれています。
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■ カーソル位置にズームインするには、Zoom を選択します。

More タブ・オプションでは、次の結果が表示されます。

■ カーソル間のオン時間とエネルギーの結果が表示されます。エネルギー
は、波形のオンからオフまでに消散したエネルギー量です。

■ オン時間は、任意のスイッチング・デバイスの伝導時間を表しています。ピ
ークのペアを示すカーソルは、配置された順序に応じて移動できます。

■ カーソルのペアを前のカーソル位置に移動するには Prev Pair ボタンを、次

のカーソル位置に移動するには Next Pair ボタンを使用します。

注： ハイパワー・ファインダの Current および Accumulated 結果タブの下の母集
団の列に表示された値は、ピーク数の合計を示します。サイクル数の合計は、
Detailed 結果タブに表示されます。

注： 結果テーブルの値のクリックを有効にするには、Link ボタンを選択して、カ
ーソルとオシロスコープ画面の時間領域の波形とを関連付けます。ズーム機能
を有効にする場合も同じ操作が必要です。Zoom チェックボックスを選択し、次
に Link ボタンを選択するとズーム操作が有効になります。

注： 電流波形が 1 つの目盛よりも小さい場合は、"Unable to find the correct
edges." というエラー・メッセージが表示されます。これは、単一の目盛内ではデ
ータ・ポイントの変動幅が非常に大きく、正しいエッジを検出するための十分なヒ
ステリシス帯がないためです。したがって、電圧波形の垂直範囲は 1 つの目盛
よりも大きい必要があります。

注： 結果のスイッチング・ロスが負になる場合は、使用されている電圧および電
流プローブの DC オフセットが原因である可能性があります。これを回避するに
は、プローブの DC オフセットを補正するとともに、アプリケーションを起動する
前に、オシロスコープで SPC（信号パス補正）オプションを実行します。

次の項目も参照してください。：

測定の選択および設定 - ハイパワー・ファインダ
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RDS(on) 測定の選択および設定 - RDS(on)：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Switching Analysis をクリックして、スイッチング解析測定画面を表示しま

す。

3. Switching Analysis フィールドで RDS(on) をクリックします。次に、Configure
ボタンをクリックします。

4. 次の図は、RDS(on) を測定するための一般的な機器設定を示しています。

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

 

 

測定の設定. 選択された測定を設定するには、次の手順を実行します。

NOTE. Source Configuration パネルの Ref オプションおよび Deskew オプション
は、動的抵抗によってライブ信号が測定されるため、無効になります。
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1. Source Configuration パネルでオプションを設定します。

 

 
2. 測定方法は 2 つあり、1 つは瞬間的な電圧値と電流値サンプルの比である

V/I です。これは、スイッチング・デバイスに向いています。もう 1 つの方法
は dV/dI で、これは電圧値と電流値の変化率を表します。これは PN 接合と
ダイオードに向いています。

いずれの場合も、抵抗のゼロ値と無限値は補間されています。

デフォルトは V/I です。

3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

4. Run を押してデータを取り込みます。

測定が正常に実行されると、結果が自動的に表示されます。

 拡張電源測定および解析ソフトウェア

拡張電源解析 89



結果の表示 - RDS(on)： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択し、Results を押して、瞬間 RDS(on) および平均 RDS(on) の結果を

表示します。オシロスコープ・パネルのカーソル・ボタンを使用して、カーソ
ルを配置します。

 

 

注： 状況によっては、結果画面に値が表示されない場合があります。その
場合には、カーソル・ゲートを使用して、対象領域を指定します。

2. Configure > Global および Cursor Gating On ボタンをクリックして、カーソ

ル・ゲートを有効にします。

3. Single をクリックして測定します。入力を求められたら、伝導領域に手動でカ

ーソルを置いて、目的の領域を選択し、OK をクリックします。これにより、ア

プリケーションでは波形の選択した部分に対してのみオン抵抗が測定され
ます。

4. 瞬間 RDS(on) の保存先、最小、最大、および平均値が表示されます。Run
モードを選択すると、表内の抵抗値が自動的に更新されます。

Time Trend プロットが選択された場合、Show Plots をクリックしてプロットを表示

します。
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次の項目も参照してください。：

測定の選択および設定 - RDS(on)

コンポーネントのプロットと機能
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di/dt 測定の選択および設定 - di/dt： 電源品質測定を選択して設定するには、次の

手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Switching Analysis タブをクリックして、Switching Analysis 画面を表示しま

す。

3. Switching Analysis フィールドで di/dt をクリックします。次に、Configure ボタ

ンをクリックします。

4. 次の図は、di/dt を測定するための一般的な機器設定を示しています。

警告： 警告：危険な高電圧を使用する回路に接続する場合は、個々の製品の
警告を参照し、使用するプローブおよびその他のコンポーネントが定格内であ
ることを確認してください。また、詳細については、トピック安全にご使用いただく
ためにを参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

NOTE. Source Configuration パネルの Ref、Deskew、および Voltage は無効にな
ります。Current オプションのみを設定できます。

1. Source Configuration パネルで Current オプションを設定します。

 

 
2. Ref Level および Hysteresis の値をピーク・ツー・ピーク信号に対するパーセ

ンテージとして設定するには、Units コンボ・ボックスで Percentage オプショ
ンを選択します。Ref Level および Hysteresis の値をアンペア単位の絶対値
として設定するには、Units コンボ・ボックスで Absolute オプションを選択し
ます。デフォルトで、Ref Level は 50%、Hysteresis は 5% に設定されます。
Ref High および Ref Low を使用して、エッジの高低レベルを設定します。
デフォルト値は 90% および 10% に設定されています。

3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。
Ref High と Ref Low は、この測定が行われる立上りエッジと立下りエッジの
開始と終了の領域を設定します。

4. Single を押して測定します。

5. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - di/dt： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. すべてのエッジ結果は結果表に表示され、Rise & Fall エッジはそれぞれ別

の表になります。

 

 

3. 詳細結果のエッジをクリックすると、そのエッジとカーソルが関連付けられま
す。

Time Trend および Histogram プロットが選択されている場合、プロットが表示さ

れます。
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次の項目も参照してください。：

測定の選択および設定 - di/dt

コンポーネントのプロットと機能
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dv/dt 測定の選択および設定 - dv/dt：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Switching Analysis をクリックして、Switching Analysis 画面を表示します。

3. Measurements フィールドで dv/dt をクリックします。

4. Configure ボタンをクリックします。

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

NOTE. Source Configuration パネルの Ref、Current、Deskew、および I-Probe
Settings は無効になります。Voltage オプションのみを設定できます。

1. Source Configuration パネルで Voltage オプションを設定します。

 

 
2. Ref Level および Hysteresis の値をピーク・ツー・ピーク信号に対するパーセ

ンテージとして設定するには、Units コンボ・ボックスで Percentage を選択し
ます。Ref Level および Hysteresis の値をボルト単位の絶対値として設定す
るには、Units コンボ・ボックスで Absolute を選択します。Ref High および
Ref Low を使用して、エッジの高低レベルを設定します。デフォルト値は
90% および 10% に設定されています。

3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

4. Single を押して測定します。

測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - dv/dt： 結果を表示するには、次の手順を実行します。

1. すべてのエッジ結果は結果表に表示され、Rise & Fall エッジはそれぞれ別

の表になります。

2. エッジ番号をクリックして、オシロスコープのカーソルを波形のハイ・レベルと
ロー・レベル、および設定したエッジに置きます。これにより、選択されたエッ
ジの結果の表示が更新されます。

 

 

3. 結果は、V/μs 単位の、時間に関する電圧波形の差動として表示されます。

注： 下図のオシロスコープ画面でカーソル位置を観察すると、カーソルによって
読み取られた信号レベルの絶対値が、結果パネルに入力されたハイ・レベルお
よびロー・レベルと一致していません。これは、ロー・レベルおよびハイ・レベル
に入力された値が波形のサンプルの間に位置しているためです。このことは、
di/dt および dv/dt 測定で発生します。

Rise Edge、Fall Edge、Histogram プロットが選択された場合、Show Plots をクリッ

クしてプロットを表示します。
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次の項目も参照してください。：

測定の選択および設定 - dv/dt

コンポーネントのプロットと機能
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安全動作領域 測定の選択および設定 - 安全動作領域：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Switching Analysis タブから、SOA 測定を選択します。Configure オプション

を選択します。

次の図は、安全動作領域を測定するための一般的な機器設定を示していま
す。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

1. SOA を選択します。
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2. Source Configuration パネルでオプションを設定します。

NOTE. オシロスコープに波形が表示されていることを確認してください。表
示されていない場合は、エラー・メッセージが表示されます。

プロットの種類 説明

SOA XY モードで単一レコードの電圧および電流波形をプロットし

ます。

3. Mask X および Mask Y の各フィールドをダブルクリックし、表示されたキー
パッドを使用してマスク値の XY 座標を設定します。

4. Add ボタンをクリックし、新規のマスク・ポイントとしてマスク値を追加します。

5. Update ボタンをクリックし、選択したマスク・ポイントを新規のマスク値で更新
します。

6. Clear ボタンをクリックし、選択したマスク・ポイントを削除します。

7. Clear All ボタンをクリックし、すべてのマスク・ポイントを削除します。

8. Save ボタンをクリックし、マスクを保存します。

9. Recall ボタンをクリックし、デフォルト・ディレクトリまたは任意のディレクトリに
保存されているマスクを取得します。

10. Graph をクリックして、マスクのプレビューを表示します。

11. Global タブで、Cursor Gating パネルの On または OFF をクリックし、カーソ
ル・ゲートを有効化します。Run ボタン または Single ボタンを押します。
Cursor Gating がオンになっている場合、"Set cursors to required position" と
いうメッセージが表示されます。OK を選択して、選択された波形の部分の
結果を表示します。

12. Config タブの Mask フィールドで Enable を選択して、SOA プロットにマスク
を定義および適用します。Enable を選択した場合にマスクが定義されてい
ないときは、Run ボタン ボタンを選択すると "SOA Mask is enabled, but not
defined. Do you wish to continue?" という警告メッセージが表示されます。マ
スクなしで続行するには、Yes を選択します。

13. Run を押して、SOA プロットを表示します。

14. プロット上にカーソルを置いて、次の結果を表示します。

■ 電圧値

■ 電流値

■ 電力値
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結果の表示 - 安全動作領域： SOA 測定では、SOA プロットに電流および波形

の結果がプロットされます。結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 次のような SOA 結果が表示されます。

 

 
3. Plot をクリックして SOA0 プロットを表示します。

 

 

SOA プロットは、電流／電圧波形やマスクに関する情報を表示します。

SOA プロット上の点を選択すると、その近傍の領域の点のリストが作成さ
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れ、Marker Value テーブルが更新されます。また、オシロスコープでその領

域がズームされるため、それらの点を時間領域で確認できます。ユーザはさ
まざまなサイクルにおいて Maker Value テーブルの点を検証できます。オシ

ロスコープ上で波形の領域を解析できるため、マスク座標で違反が発生し
た波形を確認できます。

4. Global タブで、Cursor Gating パネルの On または OFF をクリックし、カーソ

ル・ゲートを有効化します。Run ボタン ボタンを押すと、"Set cursors to
required position." というメッセージが表示されます。

5. アプリケーションを実行するには、Yes を選択します。Cursor Linkage を使

用すると、タイム・ドメイン波形に対して SOA プロット内のポイントを特定で

き、波形のデータ・インデックスをリンクできます。波形内の、SOA をプロット

する領域にカーソルを置き、プロットされた領域を表示します。

6. Detailed タブを選択します。Plot をクリックしてプロットを表示します。

7. Save をクリックして、プロット・データを .csv フォーマットで保存します。デフ

ォルトのディレクトリおよびファイル名は、C: \User\Public\ TekApplications
\Advanced Power Analysis です。

注： Linear から Log-Log に変更しても、マスクの Linear と Log-Log スケー
ルの変換は行われません。しかし、Linear から Log または Log から Linear
の変更により、プロット・データは変換されます。

注： Cursor コントロール・ボタンが有効化されている場合は、ズーム・ボタン
は無効化されています。

8. カーソルを置いて、プロット内の任意のデータ・ポイントを選択します。

9. 拡大するには、+ ボタンをクリックします。対象の領域はマウスをドラッグして

定義します。縮小するには、- ボタンをクリックします。+ ボタンおよび - ボタ

ンを使用して、最大または最小のズームの限界に達するまでズームできま
す。Zoom ボタンには次の 3 通りの使用方法があります。

■ ドラッグによる拡大：表示ウィンドウ上でドラッグによって領域を選択しま
す。

■ シングルクリックによる拡大：表示されたウィンドウ上でポイントをクリック
すると、元のウィンドウの 1/4 に等しいウィンドウが表示されます。

■ シングルクリックによる縮小：表示されたウィンドウ上でポイントをクリック
すると、表示されたウィンドウの、前のズーム状態のプロットが表示されま
す。

10. ズームの後、プロットの元の表示をリストアするには、Reset Display オプショ

ンを選択します。

11. オシロスコープのカーソルおよび Link ボタンを使用して、波形から SOA プ
ロットにリンクします。Link ボタンを選択すると、プロットは自動的に半画面

モードにサイズ変更されます。Link Cursor Position フィールドには、特定の
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データ・ポイントが出現する回数が表示されます。最小は 1、最大はデータ・

ポイントが出現する回数です。

12. 十字カーソルをプロット上の目的のポイントに置き、Link ボタンを押します。

これにより、オシロスコープ上でカーソルが有効になり、プロット・パネルで選
択したデータ・ポイントに対応する波形上の位置にカーソルが配置されま
す。

13. 複数回出現する場合は、Prev ボタンを押すと前のデータ・ポイントが選択さ

れ、Next ボタンを押すと次のデータ・ポイントが選択されます。

14. プロットとタイム・ドメイン波形を同時に表示できます。Link チェック・ボックス

をオンにして、オシロスコープの波形から SOA プロットにリンクするデータ・

ポイントを選択します。プロット上に十字カーソルを置いて、Cursor Linkage
ボックスに値を入力します。プロット内の対象の領域をズームしてオシロスコ
ープに表示するには、Zoom ボタンを使用します。

注： 結果は、半画面モードまたは全画面モードで表示できます。

15. カーソル位置の電圧、電流、電力、平均電力、および標準偏差の結果が表
示されます。

次の項目も参照してください。：

測定の選択および設定 - 安全動作領域

コンポーネントのプロットと機能
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SOA オーバーレイ： このユーティリティを使用する前に、プロットを .plt ファイルと

して保存するには、Detailed results ウィンドウの SOA Graph プロットで Save Plot
ボタンを選択します。

目的：さまざまな負荷条件で動作するデバイスの SOA プロットをプロット、表示、

および比較します。SOA オーバーレイ・ユーティリティを使用すると、複数の

SOA プロットを同時にオーバーレイできます。この機能を使用して、同一グリッド

上で複数のプロットを表示します。

最初に、選択されたプロットに応じて SOA スケールが調整されます。この状態

から、さまざまな条件における動作の電圧レンジおよび電流レンジのプロットを
観察することもできます。

 

 

X 軸は、ボルト単位の電圧値を、Y 軸はアンペア単位の電流を表しています。

SOA オーバーレイを実行するには、次の手順を実行します。

1. アプリケーションの最近の実行で保存された SOA プロットを自動的にロード

するには、Recent ボタンをクリックします。

最新の 10 件のプロットのみをロードできます。任意のフォルダ、またはデフ

ォルト・フォルダである C: \ User\Public\Tektronix\TekApplications
\Advanced Power Analysis\SOA\Data ディレクトリから SOA プロットを手動で

ロードするには、Recall ボタンを選択します。任意の 10 件のプロットをロー

ドできます。

2. 画面のグリッド領域に SOA プロットを表示するには、プロット名の横にある

プロット選択チェック・ボックスをクリックします。最初のプロットが表示される
と、そのプロットのスケールが自動的に調節されます。この手順を繰り返し
て、すべてのプロットをオーバーレイして表示します。SOA オーバーレイで

は、プロット名フィールドで設定された色に基づいて、プロットが表示されま
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す。後で選択されたプロットが前に選択されたプロットの上に描画されます。
複数の条件下のさまざまな SOA プロットを同時に表示して比較できます。

3. グリッド領域からプロットを削除するには、Plot Name をクリックしてから Clear
ボタンをクリックします。

4. グリッド領域からすべてのプロットをクリアするには、Clear All をクリックしま

す。

5. 任意のフォルダ、またはデフォルト・フォルダ C: \User\Public\ Tektronix
\TekApplications\Advanced Power Analysis にプロットを .csv ファイルとして

保存するには、Save ボタンを選択します。

6. OK をクリックして表示ウィンドウを閉じます。

SOA マスク・エラー時の波形の保存： Free Run モードでは、SOA マスクに違反

があった場合には、エラーになったインシデントが対応する電圧／電流波形とと
もに保存されます。初回実行時には、SOA マスク・エラーは C:\Users\Public
\TekApplications\Advanced Power Analysis\MaskFail Waveforms\ Run1 に保存
されます。マスク・エラーが発生するたびに、2 つの波形が RUN フォルダに保
存されます。フォルダには、最大 20 の波形ファイルを保存できます（10 回分の
エラーに対応）。

最初の 25 回までの実行では、新しいフォルダが作成され、エラーになったイン

シデントがそれぞれのフォルダに保存されます。26 回目の実行では、初回に実

行したときにデータを保存したフォルダ（Run1 など）が、ユーザの同意のもとに

上書きされます。以降、同様の動作が繰り返されます。

注： 波形を保存するための十分な空き容量がない場合には、波形は保存され
ません。ユーザは C: ドライブに十分な空き容量が確保されていることを確認し
ておく必要があります。

例

C:\Users\Public\TekApplications\Advanced Power Analysis\MaskFail
Waveforms\ Run1 は、マスク・エラーの波形が保存された初回実行時に対応し

ます。
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安全動作領域 X-Y 測定の選択および設定 - 安全動作領域 X-Y：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Switching Analysis タブから、SOA X-Y 測定を選択します。Configure オプ

ションを選択します。

次の図は、安全動作領域 X-Y を測定するための一般的な機器設定を示してい

ます。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

1. SOA X-Y を選択します。
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2. Source Configuration パネルでオプションを設定します。

NOTE. オシロスコープに波形が表示されていることを確認してください。表
示されていない場合は、エラー・メッセージが表示されます。

プロットの種類 説明

SOA X-Y（DPX） オシロスコープの XY モード表示を使用して、電圧および電流

波形を測定してプロットします。リアルタイム・テストで同一波
形を複数取り込んで測定する場合にこのオプションを使用し
ます。

3. Run ボタン を押して、SOA X-Y プロットを表示します。

結果の表示 - 安全動作領域 X-Y： SOA 測定では、SOA プロットに電流および

波形の結果がプロットされます。結果を表示するには、次の手順を実行します。

SOA X-Y の結果の表示 (DPX). オシロスコープで、リアルタイム・プロットとして結
果を表示できます。

NOTE. 4 GHz 以上の周波数の場合は、Ch1 と Ch2、または Ch3 と Ch4 をペアに
してチャンネルを選択します。4 GHz 以上の周波数の場合は、Ch1 と Ch3、また
は Ch2 と Ch4 をペアにしてチャンネルを選択します。

 

 

次の項目も参照してください。：

測定の選択および設定 - 安全動作領域 X-Y

コンポーネントのプロットと機能
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タイミング測定および解析

パルス幅 測定の選択および設定 - パルス幅：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Timing Analysis をクリックして、Timing Analysis 画面を表示します。

3. Measurements フィールドで Pulse Width をクリックします。Configure をクリッ

クします。

4. 次の図は、パルス幅解析を測定するための一般的な機器設定を示していま
す。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
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1. Source フィールドをクリックすると、Source Configuration 画面が表示されま
す。この画面で、測定のための Source を選択します。チャンネル・ソースと
して使用可能なオプションは Ch1 ～ Ch4 です。

2. Options タブで、Ref Level および Hysteresis を絶対値またはピーク・ツー・
ピーク値に対するパーセンテージで設定します。Level オプションを選択す
ると、Ref Level および Hysteresis はボルト単位で表示されます。Mid 値を
電源電圧のピーク・ツー・ピークの 50% に設定することをお勧めします。

3. Ref Level ボックスおよび Hysteresis ボックスをダブルクリックし、表示された
キーパッドを使用して、Ref level の値および Hysteresis の値を入力します。

4. Edges タブで、Positive または Negative のいずれかをクリックして、パルス幅
の極性を選択します。

5. Global タブで、波形の特定部分を解析するには、Cursor Gating の On また
は OFF をクリックしてゲート測定オプションを有効にします。Cursor Gating
ボタンをクリックしてから Run ボタン をクリックすると、"Place the cursors at the
appropriate region of the waveform." というメッセージが表示されます。指示
に従ってカーソルを置きます。Yes を選択すると、複数のカーソルの間とし
て示された、波形の選択された部分に対する解析が実行され、タイム・トレン
ドがプロットされます。

6. Run を押して測定します。

測定が正常に実行されると、結果が自動的に表示されます。

NOTE. タイミングを解析および測定すると、選択されたリファレンス先内のすべて
のデータが置き換えられます。このとき、警告メッセージは表示されません。
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結果の表示 - パルス幅： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を選択します。

2. 次の図に示すように、選択されたパルスに従って結果が表示されます。オシ
ロスコープで、負または正のパルス幅および時間を表示するプロットに関す
る結果をチェックします。

 

 

Pulse Width プロットが選択された場合、Show Plots をクリックしてプロットを表示

します。

 

 

次の項目も参照してください。：

測定の選択および設定 - パルス幅
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コンポーネントのプロットと機能
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デューティ・サイクル 測定の選択および設定 - デューティ・サイクル：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Timing Analysis をクリックして、Timing Analysis 画面を表示します。

3. Measurements フィールドで Duty Cycle をクリックします。Configure をクリッ

クします。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Source フィールドをクリックすると、Source Configuration 画面が表示されま
す。この画面で、測定のための Source を選択します。使用可能なチャンネ
ル・ソースは Ch1 ～ Ch4 です。

2. Options タブで、Mid および Hysteresis を絶対値またはパーセンテージで
設定します。Level オプションを選択すると、Mid および Hysteresis はボルト
単位で表示されます。Mid 値を電源電圧のピーク・ツー・ピークの 50% に設
定するのが最適です。

3. Ref Level ボックスおよび Hysteresis ボックスをダブルクリックし、表示された
キーパッドを使用して、Ref Level の値および Hysteresis の値を入力しま
す。

4. Edges タブで、Positive または Negative のいずれかをクリックして、パルス幅
の極性を選択します。

5. Rise または Fall のいずれかをクリックすることによって、パルス幅の Edge
Type を選択します。

6. Global タブで、波形の特定部分を解析するには、Cursor Gating の On また
は OFF をクリックしてゲート測定オプションを有効にします。Cursor Gating
ボタンをクリックしてから Run ボタン をクリックすると、"Place the cursors at the
appropriate region of the waveform." というメッセージが表示されます。指示
に従ってカーソルを置きます。Yes を選択すると、複数のカーソルの間とし
て示された、波形の選択された部分に対する解析が実行され、タイム・トレン
ドがプロットされます。

7. Run を押してデータを取り込みます。

測定が正常に実行されると、結果が自動的に表示されます。

NOTE. タイミングを解析および測定すると、選択されたリファレンス先内のすべて
のデータが置き換えられます。このとき、警告メッセージは表示されません。
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結果の表示 - デューティ・サイクル： 結果を表示するには、次の手順を実行しま

す。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 選択されたデューティ・サイクルに従って結果が表示されます。オシロスコー
プで、正または負のデューティ・サイクルおよび時間を表示するトレンド・プ
ロットの結果をチェックします。

 

 

Duty Cycle プロットが選択された場合、Show Plots をクリックしてプロットを表示

します。

 

 

次の項目も参照してください。：
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測定の選択および設定 - デューティ・サイクル

コンポーネントのプロットと機能

周期 測定の選択および設定 - 周期：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Timing Analysis をクリックして、Timing Analysis 画面を表示します。

3. Measurements フィールドで Period （周期）をクリックします。Configure をクリ

ックします。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Source フィールドをクリックすると、Source Configuration 画面が表示されま
す。この画面で、測定のための Source を選択します。使用可能なチャンネ
ル・ソースは Ch1 ～ Ch4 です。

2. Options タブで、Ref Level および Hysteresis を絶対値またはパーセンテー
ジで設定します。Level オプションを選択すると、Mid および Hysteresis の
値はボルト単位で表示されます。Mid 値を電源電圧のピーク・ツー・ピーク
の 50% に設定するのが最適です。

3. Ref Level ボックスおよび Hysteresis ボックスをダブルクリックし、表示された
キーパッドを使用して、Ref level の値および Hysteresis の値を入力します。

4. Edges タブで、Rise または Fall のいずれかをクリックすることによって、パル
ス幅の Edge Type を選択します。

5. Global タブで、波形の特定部分を解析するには、Cursor Gating の On また
は OFF をクリックしてゲート測定オプションを有効にします。Cursor Gating
ボタンをクリックしてから Run ボタン をクリックすると、"Place the cursors at the
appropriate region of the waveform." というメッセージが表示されます。指示
に従ってカーソルを置きます。Yes を選択すると、複数のカーソルの間とし
て示された、波形の選択された部分に対する解析が実行され、タイム・トレン
ドがプロットされます。

6. Run を押してデータを取り込みます。

7. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 周期： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 選択された周期の結果が表示されます。オシロスコープに表示された周期
と時間のトレンド・プロットの結果を確認します。

 

 

Period Time Trend プロットが選択された場合、Show Plots をクリックしてプロット

を表示します。

 

 

次の項目も参照してください。：

測定の選択および設定 - 周期
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コンポーネントのプロットと機能

周波数 測定の選択および設定 - 周波数：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Timing Analysis をクリックして、Timing Analysis 画面を表示します。

3. Measurements フィールドで Frequency をクリックします。Configure をクリック

します。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Source フィールドをクリックすると、Source Configuration 画面が表示されま
す。この画面で、測定のための Source を選択します。使用可能なチャンネ
ル・ソースは Ch1 ～ Ch4 です。

2. Ref Dest ドロップダウン・メニューから、リファレンス先を選択します。使用可
能なリファレンス先は Ref1 ～ Ref4 です。

3. Options タブで、Units を Absolute または Percentage で設定します。Level
オプションを選択すると、Mid および Hysteresis はボルト単位で表示されま
す。Mid 値を電源電圧のピーク・ツー・ピークの 50% に設定するのが最適
です。

4. Ref Level ボックスおよび Hysteresis ボックスをダブルクリックし、表示された
キーパッドを使用して、Ref Level の値および Hysteresis の値を入力しま
す。

5. Edges タブで、Rise または Fall のいずれかをクリックすることによって、パル
ス幅の Edge Type を選択します。

6. Run をクリックしてデータを取り込みます。

7. 測定が正常に実行されると、結果が自動的に表示されます。

NOTE. 変調を解析および測定すると、選択されたリファレンス先内のすべてのデ
ータが置き換えられます。このとき、警告メッセージは表示されません。
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結果の表示 - 周波数： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 選択された周波数に応じて結果が表示されます。オシロスコープ上で、周
波数と時間が表示されたトレンド・プロットの結果を確認します。

3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

 

 

Frequency Time Trend プロットが選択された場合、Show Plots をクリックしてプロ

ットを表示します。
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次の項目も参照してください。：

測定の選択および設定 - 周波数

コンポーネントのプロットと機能
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スキュー 測定の選択および設定 - スキュー：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブをクリックします。

2. Timing Analysis をクリックして、Timing Analysis 画面を表示します。

3. Measurements フィールドで Skew をクリックします。Configure をクリックしま

す。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

 

 

1. Source configuration パネルで測定を設定します。Source Configuration 画
面を表示するには、測定する Source をクリックします。

2. From Edge として Rise、Fall、または Both をクリックし、To Edge として Same
as From または Inverse of From をクリックして、エッジを設定します。

3. Options タブでは、次のように設定します。

■ Units を Absolute または Percentage に設定します。Absolute を選択す
ると、Ref Level および Hysteresis がボルト単位で表示されます。

■ Ref レベルの値は、絶対値の単位では 100 mV ～ 5.99 kV の範囲、パ
ーセントの単位では 1% ～ 99% の範囲になるように設定します。

 

 
4. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを

グローバルに設定するには、グローバル設定の構成を参照してください。

5. Run をクリックしてデータを取り込みます。

6. 測定が正常に実行されると、結果が自動的に表示されます。
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NOTE. 変調を解析および測定すると、選択されたリファレンス先内のすべてのデ
ータが置き換えられます。このとき、警告メッセージは表示されません。

次の項目も参照してください。：

結果の表示 - スキュー
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結果の表示 - スキュー： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 選択された周波数に応じて結果が表示されます。

プロットによる結果の表示： すべての負のサイクルについてのタイム・トレンド・
プロット、およびヒストグラム・プロットにも、結果が表示されます。

スキュー測定のタイム・トレンド／ヒストグラム・プロット

 

 

次の項目も参照してください。：

測定の選択および設定 - スキュー

コンポーネントのプロットと機能
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磁気の測定および解析

測定の選択および設定 -
磁気 注： 電流波形が 1 つの目盛よりも小さい場合は、"Unable to find the correct

edges" というエラー・メッセージが表示されます。このことは、単一の目盛内でデ
ータ・ポイントの変動が大きく、かつ、ヒステリシス帯が不足するために正しいエッ
ジを検出できないことによって発生します。電流波形の場合、垂直範囲は 1 つ
の目盛よりも大きい必要があります。

1. アプリケーションのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Magnetics タブを選択します。Configure タブを押します。

次の図は、磁気を測定するための一般的な機器設定を示しています。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。
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測定の設定. 選択された測定を設定するには、次の手順を実行します。

1. Source Configuration パネルでオプションを設定します。

2. 測定ボタン、Inductance、Magnetic Property、Magnetic Loss、I vs∫ V のいず
れかをクリックします。

3. Configure をクリックして、測定の設定オプションを表示します。

 

 
4. 設定を行います。Single をクリックして磁気を測定します。

測定が正常に実行されると、結果が自動的に表示されます。

磁気損失  

 

Cursor Gating オプションを使用して、さまざまな周波数の信号の磁気損失を測

定するには、次の手順を実行します。

1. Global タブで、Cursor Gating の On ボタンをクリックして、オシロスコープの

カーソルを有効にします。

2. 指定された波形領域の間に垂直カーソルを置き、磁気損失を計算します。

3. Single ボタンを押して磁気損失を測定します。
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インダクタンス 測定の選択および設定 - インダクタンス：

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Magnetics をクリックして、Measurements 画面を表示します。

3. Measurements フィールドで Inductance をクリックします。Configure をクリック

します。

注： トランスフォーマのインダクタンスを測定する場合は、二次コイルに負荷をか
けないでください。無負荷条件において一次コイルでインダクタンスを測定する
と、単コイルのインダクタンス測定と同程度に正確な測定になります。同じコアに
複数のコイルを持つ結合インダクタのインダクタンスを測定すると、ほかのコイル
の電流から影響を受けるため、インダクタンスの測定値と実際の値との間にずれ
が発生します。この測定値を使用すると、リップル電流を計算できます。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Source フィールドをクリックすると、Edge Source 画面が表示されます。この
画面で、測定のための Source を選択します。

2. Edges タブで、Edge Source フィールドのドロップダウン・リストを使用して、エ
ッジ・ソースを設定します。使用可能なオプションは次のとおりです。

■ Ch1 ～ Ch4

■ Math1 ～ Math4

■ Ref1 ～ Ref4
3. Options タブで、Units を Absolute または Percentage で設定します。Level

オプションを選択すると、Mid および Hysteresis はボルト単位で表示されま
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す。Mid 値を電源電圧のピーク・ツー・ピークの 50% に設定するのが最適
です。

 

 
4. Ref Level ボックスおよび Hysteresis ボックスをダブルクリックし、表示された

キーパッドを使用して、Ref Level の値および Hysteresis の値を入力しま
す。

5. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

6. Run をクリックしてデータを取り込みます。

7. 測定が正常に実行されると、結果が自動的に表示されます。

NOTE. 磁気を解析および測定すると、選択されたリファレンス先内のすべてのデ
ータが置き換えられます。このとき、警告メッセージは表示されません。
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結果の表示 - インダクタンス： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. アプリケーションは結果を表示します。

 

 

次の項目も参照してください。：

測定の選択および設定 - インダクタンス

電流対電圧の積分  
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電流と積分電圧を測定するには、次の手順を実行します。

1. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

2. Single ボタンをクリックして、電流と積分電圧を測定します。

磁気特性 磁気特性測定では、回路内動作で使用される磁気コンポーネントの磁性材料
に関するパラメータを測定します。

 

 

Physical Chars1 タブを使用すると、磁気コアの寸法を定義できます。

 

 

1. Source タブで、回路内動作のタイプを Freq and Duty （周波数およびデュー

ティ）フィールドの Variable または Fixed ボタンで選択します。
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2. Source タブで、Edge Source フィールドのドロップダウン・リストを使用して、

エッジ・ソースを設定します。選択されたチャンネルに存在するデータを使
用して、取り込まれた波形の積分サイクル全体が特定されます。これにより、
インダクタの両端で複雑な波形を解析できます。使用可能なオプションは次
のとおりです。

■ Ch1 ～ Ch4

■ Math1 ～ Math4

■ Ref1 ～ Ref4

注： Variable 動作の場合は、インダクタの両端で取り込まれた電圧の振幅
が時間とともに変化するため、ゲート・ドライブ信号をエッジ・ソースに接続し
てください。

3. Global タブで、Cursor Gating フィールドの On ボタンを選択して、カーソル

間の波形データを測定します。

 

 

4. Physical Chars2 タブの # of Windings フィールドで Single または Multiple
をクリックして、コイル数を選択します。

 

 

注： Freq and Duty フィールドの Variable を選択すると、Cursor Gating フィ
ールドで Off が選択されていてもカーソル・ゲートが有効になります。
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5. Options タブで、Units ドロップダウンから Percentage オプションを選択して

Ref Level および Hysteresis の値をパーセンテージで設定するか、または

Absolute オプションを選択してピーク・ツー・ピーク信号の絶対値を設定しま

す。

 

 

Physical Chars2 タブでは、表示されているパラメータを使用して、磁気コンポー

ネントの特性を指定します。手順は次のとおりです。
 

 

1. トランスフォーマまたは同じコアに複数のコイルを持つインダクタの Multiple
Windings オプションを設定します。

2. Physical Chars 2 タブで、Number of Turns フィールドをダブルクリックし、表

示されたキーパッドを使用して、磁気コンポーネントの巻数を設定します。

3. Physical Chars 1 タブの Units コンボ・ボックスで、SI または CGS のオプショ

ン・ボタンを選択して、システムの単位を設定します。SI を選択すると、コン

ポーネント特性はメートル単位で測定され、磁気の単位はテスラおよびアン
ペア、または 1 メートルあたりの巻数となります。CGS を選択すると、測定単

位はセンチメートル、結果の単位はガウスおよびエルステッドとなります。
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4. Cross Section Area ボックスをダブルクリックし、表示されたキーパッドを使用

して、磁気コンポーネントの断面積を設定します。Cross Section Area 値の

許容範囲は次のとおりです。

■ 1 nm2 ～ 1 Mm2（SI を選択した場合）

■ 1 ncm2 ～ 1 Mcm2（CGS を選択した場合）

5. Magnetic Length フィールドの隣にある GP ノブを使用して、コンポーネント

の磁性物質の長さを設定します。長さの許容範囲は次のとおりです。

■ 0 m ～ 1 Mm（SI を選択した場合）

■ 0 cm ～ 1 Mcm（CGS を選択した場合）

Physical Chars2 タブの Multiple Windings フィールドでは、結合インダクタなど、

複数のコイルを持つコンポーネントの磁気特性を測定できます。手順は次のと
おりです。

1. コンポーネントのほかのコイルに接続している場合は、Winding2 Source お
よび Winding3 Source のコンボ・ボックスでドロップダウン・リストを使用しま

す。

2. Source Configuration パネルで選択された電圧プローブ／電流プローブを

次のコイルに接続します。

■ トランスフォーマ・コイルの一次コイル

■ 結合インダクタにおいてメインのコイルとみなされる 1 つのコイル

3. Source タブで、メインのコイルの電圧または電流チャンネルのいずれかをエ

ッジ・ソースとして使用します。

4. Physical Chars2 タブで、# of Turns ボックスに巻数を入力します。

5. Multiple Windings フィールドで、電流プローブをほかのコイルまたは二次コ

イルに接続し、コイルの巻数を入力します。コイル数が 1 の場合は、

Winding3 Source コンボ・ボックスから Unused オプションを選択します。

6. 一次コイルまたはメインのコイル、および二次コイルまたはその他のコイルの
電圧プローブと電流プローブの組み合わせを、次の図にドット（·）で示され

た位置に接続します。電圧プローブは、電流が立上がったときに正の電圧
として読み取られるように接続する必要があります。

7. Magnetising Current コンボ・ボックスで、リファレンス・チャンネルを選択して

磁化電流を表示します。
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警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

2 つのコイルで同時に波形を取り込む電流プローブがない場合は、Multiple
Windings フィールドを選択して次の手順を実行します。

1. Source タブで、メインのコイルの電圧または電流チャンネルのいずれかをエ

ッジ・ソースとして使用します。

2. Source Configuration パネルで選択された電圧プローブ／電流プローブを

次のコイルに接続します。

■ トランスフォーマ・コイルのメイン・コイル

■ 結合インダクタにおいてメインのコイルとみなされる 1 つのコイル
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3. アプリケーションで Run ボタンを押します。メインのコイルの電圧波形と電流

波形が取り込まれ、電流プローブをほかのコイルに接続するよう求めるメッ
セージが表示されます。ほかのコイルがある場合は Yes を選択し、次の手

順に進む場合は No を選択します。

4. ポップアップ・メッセージ・ボックスで電流チャンネルを設定し、電流プローブ
をほかのコイルに接続します。選択されたコイルの巻数を # of Turns ボック

スに入力します。
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結果の表示 - 磁気 磁気測定は、選択された測定によって結果が異なります。結果を表示するに
は、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. 磁気（磁気特性）測定の結果が表形式で表示されます。

 

 

フィールド 説明

Bpeak 磁気コンポーネント内で誘導された最大磁束密度。

Br 外部的にかかる磁界（H）がゼロに戻った後、ヒステリ

シス・ループが生成されている間に材料に残る、誘導
された磁束密度（B）。この場合は、Bpeak サイクル上

の Br の最大値が測定されます。

Hc H 軸とヒステリシス・ループの交点における H の値。こ

れは、ヒステリシス・ループの測定中に誘導される磁
束密度（B）をゼロにするのに必要な外部磁界を表しま

す。Hc は、正と負の H 軸で対称になります。

Hmax H 軸とヒステリシス・ループの交点における H の最大

値。
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フィールド 説明

I-ripple 電流のピーク・ピーク値。

 

 

3. Show Plots をクリックしてプロットを表示します。

 

 

4. カーソル・ボタンを使用して、最大磁束密度曲線上にカーソルを置きます。
Cursor1 および Cursor2 を使用すると、最大磁束密度曲線上の対象領域

で、透磁率、デルタ B、およびデルタ H を計算できます。

5. Bpeak ボタンを押すと、Bpeak サイクルとすべてのサイクルの間で切り替え

が行われます。Bpeak が選択された場合は、最大磁束密度を持つ 2 つの

Bpeak サイクルのみが表示されます。Bpeak が選択されていない場合は、コ

ンポーネントのすべてのサイクルが表示されます。
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6. 拡大するには、+ ボタンをクリックします。通常表示の 5 倍まで拡大できま

す。対象の領域はマウスをドラッグして定義します。縮小するには、- ボタン

をクリックします。+ ボタンおよび - ボタンを使用して、最大または最小のズ

ームの限界に達するまでズームできます。Zoom ボタンには次の 3 通りの使

用方法があります。

■ ドラッグによる拡大：表示されたウィンドウ上でドラッグして領域を選択し
ます。

■ シングルクリックによる拡大：表示されたウィンドウ上でポイントをクリック
すると、元のウィンドウの 1/4 に等しいウィンドウが表示されます。

■ シングルクリックによる縮小：表示されたウィンドウ上でポイントをクリック
すると、表示されたウィンドウの、前のズーム状態のプロットが表示されま
す。

注： 電流波形が 1 つの目盛よりも小さい場合は、"Unable to find the correct
edges." というエラー・メッセージが表示されます。このことは、単一の目盛内
でデータ・ポイントの変動が非常に大きく、かつ、ヒステリシス帯が不足する
ために正しいエッジを検出できないことによって発生します。したがって、電
流波形の場合、垂直範囲は 1 つの目盛よりも大きい必要があります。

7. ズームの後、プロットの元の表示をリストアするには、Reset オプションを選択

します。
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電流と積分電圧の結果：.
1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis

を選択してから、Results を押します。

2. 磁気測定の電流と積分電圧について結果が表示されます。

 

 
3. Show Plots オプションをクリックして、電流と積分電圧の磁気曲線プロットを

表示します。

 

 
4. 拡大するには、+ ボタンをクリックします。通常表示の 5 倍まで拡大できま

す。対象の領域はマウスをドラッグして定義します。縮小するには、- ボタン
をクリックします。Zoom In ボタンおよび Zoom Out ボタンを使用して、最大
または最小のズームの限界に達するまでズームできます。Zoom ボタンには
次の 3 通りの使用方法があります。
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■ ドラッグによる拡大：表示されたウィンドウ上でドラッグして領域を選択し
ます。

■ シングルクリックによる拡大：表示されたウィンドウ上でポイントをクリック
すると、元のウィンドウの 1/4 に等しいウィンドウが表示されます。

■ シングルクリックによる縮小：表示されたウィンドウ上でポイントをクリック
すると、表示されたウィンドウの、前のズーム状態のプロットが表示されま
す。

5. プロットの元の表示をリストアするには、Reset オプションを選択します。

6. Hits フィールドのカーソルを使用して、選択されたデータ・ポイントでカーソ
ルのヒット数を表示します。電流と積分電圧プロット上にクロスヘア・アイコン
を置いたとき、同じ位置に複数のデータ・ポイントが存在する場合は、その
値が Hits フィールドに表示されます。
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インダクタンスの結果：.
1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis

を選択してから、Results を押します。

 

 
2. Show Plots をクリックします。B-H 曲線のプロットがインダクタンスの値ととも

に表示されます。

 

 
3. Full Screen ボタンを選択すると、プロットが全画面モードで表示されます。

次の項目も参照してください。：

測定の選択および設定 - 磁気

コンポーネントのプロットと機能
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入力測定および解析

電源品質 測定の選択および設定 - 電源品質： 電源品質測定を選択して設定するには、

次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Power Quality オプションを選択します。Configure をクリックして電源品質を

設定します。

4. 次の図は、電源品質を測定するための一般的な機器設定を示しています。

 

 

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については、トピック安全にご使用いただくために
を参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
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1. Source Configuration パネルでオプションを設定します。

 

 
2. Run を押して測定します。

3. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 電源品質： 結果を表示するには、次の手順を実行します。
1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis

を選択してから、Results を押します。
2. 電源品質測定の結果が表示されます（下図を参照）。

■ Vrms
■ True Power
■ Voltage Crest Factor
■ 周波数
■ Irms
■ Apparent Power
■ Current Crest Factor
■ 無効電力
■ Power Factor
■ Phase Angle

power quality プロットが選択されている場合、プロットが表示されます。
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次の項目も参照してください。：

測定の選択および設定 - 電源品質

コンポーネントのプロットと機能
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電流高調波 測定の選択および設定 - 電流高調波： 電流高調波の測定を選択および設定

するには、次の手順を実行します。 測定の設定

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Measurements フィールドで Current Harmonics をクリックします。次に、

Configure ボタンをクリックします。

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品の警
告を参照し、使用するプローブおよびその他のコンポーネントが定格内であるこ
とを確認してください。

NOTE. 前の測定に使用した電源と同じ電源を使用する場合は、共通設定オプ
ションを設定する手順を省略できます。

選択された測定を設定するには、次の手順を実行します。

1. Source Configuration パネルでオプションを設定します。

2. Standard ボタンをクリックすると、次の画面が表示されます。このフィールド

には、国際的な EMC（電磁環境両立性）標準規格 61000-3-2、AM14、およ

び MIL 1399 が表示され、これらの標準規格のコンプライアンス・テストを実

行できます。

 

 

61000-3-2 標準規格を選択した場合のアプリケーションの動作を参照するに

は、このハイパーリンクをクリックしてください。

61000-3-2 標準規格の構成を設定するには、次の手順を実行します。

a. Type フィールドで 61000-3-2 ボタンをクリックします。デフォルトでは、Line
Frequency は Auto です。つまり、入力信号の周波数は自動的に計算されま

す。Line Frequency は 50Hz、60 Hz、または Custom にいずれかに設定で

きます。Custom の場合は、周波数の値を 1 Hz から 4 KHz の範囲で設定で
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きます。デフォルトの Harmonics Order は 40 です。高調波次数の設定範囲

は、40 ～ 100 です。

 

 

NOTE. Source Autoset では、Line Frequency および Harmonic Order の値が
使用されます。入力周波数の少なくとも 10 サイクル相当の信号を取り込む
ように設定するには、垂直軸および水平軸のソース・オートセットを実行しま
す。

b. Harmonics Table タブで、Harmonic ドロップダウン・ボックスを使用してテー

ブルを選択し、Edit ボタンをクリックしてテーブルを編集します。これらのテ

ーブルの値はリミット値として使用されます。

c. 使用可能な 10 個のテーブルのいずれか 1 つを選択します。Table 1 がデ

フォルト・テーブルです。高調波テーブルを選択すると、Class ドロップダウ

ン・ボックスに関連付けられたクラスが表示されます。アプリケーションを初め
て実行する場合は、Class A がすべての高調波テーブルに関連付けられま

す。クラスの設定を変更した場合、変更内容はアプリケーションを再実行し
た後も保持されます。

d. Edit ボタンをクリックしてテーブル・エディタを表示します。テーブル・エディ

タには、高調波の番号（61000-3-2 標準規格の場合は 1 ～ 40、MIL
1399 規格の場合は 1 ～ 50 または 1 ～ 100 （選択した設定パラメータに基

づく））、ミリアンペア単位の高調波限度、およびデシベル・マイクロアンペア
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単位の高調波限度が表示されます。OK をクリックしてテーブル内の値を更

新します。

 

 

NOTE. Amperes テーブルでは、高調波限度の値のみを編集できます。この
変更により、db μa 列も同じように更新されます。

e. Class フィールドのドロップダウン・リストを使用して、クラスを選択します。使

用可能なクラスは A ～ D です。

NOTE. クラス A とクラス B の高調波テーブルは編集できますが、クラス C と
クラス D は編集できません。

Class C を選択すると、力率のリミットが計算され、リミット・テーブルが更新さ

れます。Class D を選択すると、テスト対象の装置の有効電力から、高調波

のリミット値が計算されます。

f. これらのテーブルは、61000-3-2 標準規格および AM 14 標準規格にのみ

適用されます。

IEC によって、61000-3-2 高調波標準規格の修正条項（修正条項 14）が発行さ

れました。この条項は、61000-3-2 修正条項 14 として文書化されています。

この修正条項ではクラス定義が変更され、数多くの製品がクラス A に再分類さ

れて、クラス D の製品（クラス D 製品はパーソナル・コンピュータとモニタが

600 W 未満、テレビ受像機が　600 W 未満に制限）が明確に定義されました。

また、新たに定義されたクラス D にも変更が加えられました。クラス C およびクラ
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ス D の制限はメーカー評価が基本となり、この評価は、測定による検証が必要

です。

AM 14 標準規格を選択した場合のアプリケーションの動作を参照するに

は、このハイパーリンクをクリックしてください。

AM 14 の設定を行うには、次の手順を実行します。

a. Type フィールドで AM 14 ボタンをクリックします。デフォルトでは、Line
Frequency は Auto です。つまり、入力信号の周波数は自動的に計算されま

す。Line Frequency は 50Hz、60 Hz、または Custom にいずれかに設定で

きます。Custom の場合は、周波数の値を 1 Hz から 4 KHz の範囲で設定で

きます。デフォルトの Harmonics Order は 40 です。高調波次数の設定範囲

は、40 ～ 100 です。

 

 

NOTE. Source Autoset では、Line Frequency および Harmonic Order の値が
使用されます。入力周波数の少なくとも 16 サイクル相当の信号を取り込む
ように設定するには、垂直軸および水平軸のソース・オートセットを実行しま
す。

b. Harmonics Table タブで、Harmonic ドロップダウン・ボックスを使用してテー

ブルを選択し、Edit ボタンをクリックしてテーブルを編集します。使用可能な

10 個のテーブルのいずれか 1 つを選択します。Table 1 がデフォルト・テー

ブルです。高調波テーブルを設定すると、Class コンボ・ボックスに関連付け

られたクラスが表示されます。アプリケーションを初めて実行する場合は、
Class A がすべての高調波テーブルに関連付けられます。クラスの設定を

変更した場合、変更内容はアプリケーションを再実行した後も保持されま
す。

NOTE. クラス A とクラス B の高調波テーブルは編集できますが、クラス C と
クラス D は編集できません。

c. Edit ボタンをクリックしてテーブル・エディタを表示します。テーブル・エディ

タには、IEC 規格の高調波の番号 1 ～ 40、およびミリアンペア単位とデシ
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ベル・マイクロアンペア単位の高調波限度が表示されます。OK をクリックし

てテーブル内の値を更新します。

d. Class ドロップダウン・ボックスを使用して、クラスを選択します。使用可能な

クラスは A ～ D です。このコントロール・オプションでは、クラス C またはクラ

ス D に対してのみ追加入力を行うことができます。

 

 

e. Input Power、Power Factor または Fundamental Current ボックスをダブルク

リックし、表示されたキーパッドを使用して値を入力し、OK を選択します。各

ボックスの入力許容範囲は次のとおりです。

■ Input Power は 0 W ～ 600 W。デフォルト値は 100 W です。

■ Power Factor は 0 ～ 1。デフォルト値は 0.9 です。

f. Fundamental Current は 0 A ～ 16 A。デフォルト値は 16 A です。

g. Filter チェック・ボックスをオンにして、フィルタリングされた高調波の値を取

得します。

NOTE. Tobs 期間中、信号は安定状態にあると想定されます。Tobs とは、この測
定のアクイジション期間のことです。この測定は非常に短いサイクルに設定され
ており、Tsv = 3 秒です。

MIL 1399 標準規格を選択した場合のアプリケーションの動作を参照するに

は、このハイパーリンクをクリックしてください。

Type フィールドで MIL 1399 ボタンをクリックします。デフォルトでは、Line
Frequency は Auto です。つまり、入力信号の周波数は自動的に計算されます。

Line Frequency は 50Hz、60 Hz、または Custom にいずれかに設定できます。

Custom の場合は、周波数の値を 1 Hz から 4 KHz の範囲で設定できます。デ
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フォルトの Harmonics Order は 50 です。高調波次数の設定範囲は、50 ～
100 です。

NOTE. Source Autoset では、Line Frequency および Harmonic Order の値が
使用されます。入力周波数の少なくとも 10 サイクル相当の信号を取り込む
ように設定するには、垂直軸および水平軸のソース・オートセットを実行しま
す。

 

 

3. I-Probe Impedance タブで、電流測定に使用する任意のカスタム・プローブ

の周波数ディレーティングを入力します。I プローブは、61000-3-2、AM 14、
および MIL 1399 の標準規格の測定で、周波数ディレーティングが補正さ

れている電流ソースが選択されている場合に使用できます。Impedance ドロ
ップダウン・リストを使用して、使用可能な 10 個のテーブルのいずれか 1 つ
を選択します。インピーダンス・テーブルを使用すると、プローブの周波数
応答を入力できます。これにより、プローブの周波数応答によって変更され
た周波数成分を測定できます。Table 1 がデフォルト・テーブルです。Edit
ボタンを使用してインピーダンス・テーブルを編集します。
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4. Impedance Table Editor の Reset ボタンを使用して、比率と dB の値をデフ

ォルト値にリセットします。

 

 

インピーダンス・テーブルを使用して、高調波の周波数のそれぞれにおける
プローブの転送インピーダンスを設定します。テーブル・エディタには、高調
波の番号（IEC 規格の場合は 1 ～ 40、MIL 規格の場合は 1 ～ 50 または

1 ～ 100 （選択した設定パラメータに基づく））、インピーダンス比率、および

デシベル単位のインピーダンス比率が表示されます。

5. 高調波の値を編集するには、値を選択します。Edit Selected Harmonic
Ratio ボックスをダブルクリックし、表示されたキーパッドを使用して、インピ

ーダンス比率の値を入力します。OK を選択します。

NOTE. クラス A とクラス B の高調波テーブルは編集できますが、クラス C と
クラス D は編集できません。

6. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

7. Run をクリックして測定します。

測定が正常に実行されると、結果が自動的に表示されます。

NOTE. IEC61000-3-2 および AM14 タイプの場合、電流高調波は、任意のレコ
ード長と時間軸の組み合わせで作動します。MIL1399 タイプの場合は、アプリ
ケーションのオートセットによる時間軸セットで作動します。
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結果の表示 - 電流高調波： 結果を表示するには、次の手順を実行します。

オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis >
Results をクリックしてから、Detailed フィールドの下の View Results をクリックし

ます。

 

 

61000-3-2 および MIL 1399 の結果. 61000-3-2 または MIL 139 標準規格を選択
した場合、Current Harmonic Results には次の情報が表示されます。
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オプション 説明

Harmonic 高調波の番号が表示されます。

Value 測定値が dB μA 単位で表示されます。

Limit 高調波限度が dB μA 単位で表示されます。

Margin Value の値と Limit の値の差が dB μA 単位で表示されます。ステ

ータスはマージンの値が正または負のいずれであるかに応じて
決定されます。

ステータス 測定の結果（Pass または Fail）が表示されます。

Table 1: 結果

フィールド Value
Class 設定されたクラスが表示されます。

V-THD 電圧信号の総合高調波歪みが表示されます。

I-THD 電流信号の総合高調波歪みが表示されます。

Irms 電流信号の実効値が表示されます。

Vrms 電圧信号の実効値が表示されます。

Harmonic Frequency 設定された電源周波数が表示されます。

実際の信号周波数
が表示されます。

実際の入力電源周波数が表示されます。

True Power 波形の有効電力が表示されます。
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Table 2: 結果のカスタマイズ

フィールド Value
Unit
dBμA マージンの値が測定単位 dB μA で表示されます。

A マージンの値が測定単位 A（アンペア）で表示されます。

高調波

All 偶数次と奇数次の両方の高調波の値が表示されます。

Odd 偶数次の高調波の値のみが表示されます。

Even 奇数次の高調波の値のみが表示されます。

Margin
Diff Limit と Value の値の差が Margin に表示されます。

% of F Limit と Value の値の差が Margin に表示されます（%単位）。

Save Data 結果を *.csv ファイル・フォーマットで保存できます。

AM 14 の結果.
AM 14 標準規格を選択すると、Current Harmonic Results には、40 の高調波の
値と次の情報が表示されます。

 

 

オプション 説明

Harmonic 高調波の番号が表示されます。

Value 測定値が dB μA 単位で表示されます。
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オプション 説明

Limit 高調波限度が dB μA 単位で表示されます。

Margin Value の値と Limit の値の差が dB μA 単位で表示されます。ステ

ータスはマージンの値が正または負のいずれであるかに応じて
決定されます。

結果 測定の結果（Pass または Fail）が表示されます。

Table 3: 結果

フィールド Value
Class 設定されたクラスが表示されます。

V-THD 電圧信号の総合高調波歪みが表示されます。

I-THD 電流信号の総合高調波歪みが表示されます。

Irms 電流信号の実効値が表示されます。

Vrms 電圧信号の実効値が表示されます。

Harmonic Frequency 設定された電源周波数が表示されます。

実際の信号周波数
が表示されます。

実際の入力電源周波数が表示されます。

POHC Measured 測定された部分奇数次高調波電流が表示されます。

POHC Limit 部分奇数次高調波電流のリミット値が表示されます。

POHC Status 部分奇数次高調波電流の Pass/Fail ステータスが表示されます。

True Power 波形の有効電力が表示されます。

Table 4: 結果のカスタマイズ

フィールド Value
Unit
dBμA マージンの値が測定単位 dB μA で表示されます。

A マージンの値が測定単位 A（アンペア）で表示されます。

高調波

All 偶数次と奇数次の両方の高調波の値が表示されます。

Odd 偶数次の高調波の値のみが表示されます。

Even 奇数次の高調波の値のみが表示されます。

Margin
Diff Limit と Value の値の差が Margin に表示されます。

% of F Limit と Value の値の差が Margin に表示されます（%単位）。

Filter を指定して AM 14 標準規格を選択すると、Current Harmonic Results に
は、50 の高調波の値と次の情報が表示されます。
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オプション 説明

Average Filtered
Harmonics

テスト期間全体から取得された、個別の高調波電流の平均値が
表示されます（測定された平均高調波、限界平均高調波、およ
びマージン（限界値と測定値の差））。

Peak Filtered
Harmonics

フィルタリングされた高調波ごとの最大値が表示されます。

Value 測定値が dB μA 単位で表示されます。

Limit 高調波限度が dB μA 単位で表示されます。

Margin Value の値と Limit の値の差が dB μA 単位で表示されます。ステ

ータスはマージンの値が正または負のいずれであるかに応じて
決定されます。

結果 測定の結果（Pass または Fail）が表示されます。

Table 5: 結果

フィールド Value
Class 設定されたクラスが表示されます。

V-THD 電圧信号の総合高調波歪みが表示されます。

I-THD 電流信号の総合高調波歪みが表示されます。

Irms 電流信号の実効値が表示されます。

Vrms 電圧信号の実効値が表示されます。

Harmonic Frequency 設定された電源周波数が表示されます。

実際の信号周波数
が表示されます。

実際の入力電源周波数が表示されます。

POHC Measured 測定された部分奇数次高調波電流が表示されます。

POHC Limit 部分奇数次高調波電流のリミット値が表示されます。

POHC Status 部分奇数次高調波電流の Pass/Fail ステータスが表示されます。

True Power 波形の有効電力が表示されます。

Table 6: 結果のカスタマイズ

フィールド Value
Unit
dBμA マージンの値が測定単位 dB μA で表示されます。

A マージンの値が測定単位 A（アンペア）で表示されます。

高調波

All 偶数次と奇数次の両方の高調波の値が表示されます。

Odd 偶数次の高調波の値のみが表示されます。

Even 奇数次の高調波の値のみが表示されます。

Margin
Diff Limit と Value の値の差が Margin に表示されます。

% of F Limit と Value の値の差が Margin に表示されます（%単位）。
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プロット： Show Plots をクリックしてプロットを表示します。

図 10 : 偶数次高調波のバー・グラフ

図 11 : 奇数次高調波のバー・グラフ

注： Marker Value、Overview of Results テーブル・フィールド、および計算に関
する情報は、電流／電圧高調波で説明しています。

次の項目も参照してください。：

測定の選択および設定 - 電流高調波

コンポーネントのプロットと機能
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電圧高調波 測定の選択および設定 - 電流高調波： 電圧高調波の測定を選択および設定

するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Measurements フィールドで Voltage Harmonics をクリックします。次に、

Configure ボタンをクリックします。

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。

注： 前の測定に使用した電源と同じ電源を使用する場合は、共通設定オプショ
ンを設定する手順を省略します。

測定の設定. 選択された測定を設定するには、次の手順を実行します。

1. Source Configuration パネルでオプションを設定します。

2. Line Frequency ボタンをクリックして設定します。Auto を選択すると、入力信
号の周波数が自動的に検出されます。または、50 Hz、60 Hz を選択する
か、Custom を選択して 1 Hz ～ 4kHz の範囲で電源周波数を選択できま
す。高調波次数は、40 ～ 100 の範囲で設定します。

 

 
3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを

グローバルに設定するには、グローバル設定の構成を参照してください。

4. Run をクリックして測定します。

測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 電圧高調波： 結果を表示するには、次の手順を実行します。

オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis >
Results をクリックしてから、Detailed フィールドの下の View Results をクリックし

ます。

 

 

オプション 説明

Harmonic 高調波の番号が表示されます。

Frequency (Hz) 周波数（Hz）が表示されます。

Value 値が表示されます。

表 7 : 結果

フィールド Value
V-THD 電圧信号の総合高調波歪みが表示されます。

Vrms 電圧信号の実効値が表示されます。

Harmonic Frequency 設定された電源周波数が表示されます。

実際の信号周波数
が表示されます。

実際の入力電源周波数が表示されます。

表 8 : 結果のカスタマイズ

フィールド Value
Unit
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フィールド Value
dBμV マージンの値が測定単位 dB μV で表示されます。

V マージンの値が測定単位 V（ボルト）で表示されます。

高調波

All 偶数次と奇数次の両方の高調波の値が表示されます。

Odd 偶数次の高調波の値のみが表示されます。

Even 奇数次の高調波の値のみが表示されます。

Save Data 結果を *.csv ファイル・フォーマットで保存できます。

プロット： オシロスコープのメニュー・バーから、Analyze > Advanced Power
Analysis > Plots をクリックしてから、Harmonics Bar Graph をクリックして、プロット
を表示します。

図 12 : 高調波のバー・グラフによる電圧高調波の表示

ヒント： プロットが閉じている場合は、Show Plots をクリックして 開きま
す。

注： Marker Value、Overview of Results テーブル・フィールド、および計算に関
する情報は、電流／電圧高調波で説明しています。

次の項目も参照してください。：

測定の選択および設定 - 電流高調波

コンポーネントのプロットと機能
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全体の電源品質 測定の選択および設定 - 全体の電源品質： 測定の選択および設定 - 全体の電

源品質測定の設定

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Measurements フィールドで、Total Power Quality をクリックします。次に、

Configure ボタンをクリックします。

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品の警
告を参照し、使用するプローブおよびその他のコンポーネントが定格内であるこ
とを確認してください。また、詳細については、トピック安全にご使用いただくた
めにを参照してください。

NOTE. 前の測定に使用した電源と同じ電源を使用する場合は、ソース設定オプ
ションを設定する手順を省略できます。

選択された測定を設定するには、次の手順を実行します。

1. Standard ボタンをクリックします。Standard フィールドには、ユーザおよび国

際的な EMC（電磁環境両立性）標準規格 61000-3-2、AM14、および MIL
1399 が表示され、これらの標準規格のコンプライアンス・テストを実行できま

す。

 

 

61000-3-2 標準規格を選択した場合のアプリケーションの動作を参照するには、

このハイパーリンクをクリックしてください。

61000-3-2 標準規格の構成を設定するには、次の手順を実行します。

1. Standard タブで、61000-3-2 ボタンを選択します。デフォルトでは、Line
Frequency は 50 Hz、Harmonics Order は 40 です。Auto を選択すると入力

信号の周波数が自動的に検出されます。60 Hz をクリックするか、または
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Custom をクリックして、1 Hz ～ 4,000 Hz の範囲で電源周波数を設定しま

す。 高調波次数の設定範囲は、40 ～ 100 です。

 

 

2. Harmonics Table タブで、Harmonic コンボ・ボックスをクリックしてテーブルを

選択し、Edit ボタンをクリックしてテーブルを編集します。

3. 使用可能な 10 個のテーブルのいずれか 1 つを選択します。Table 1 がデ

フォルト・テーブルです。高調波テーブルを設定すると、Class コンボ・ボック

スに関連付けられたクラスが表示されます。アプリケーションを初めて実行
する場合は、Class A がすべての高調波テーブルに関連付けられます。クラ

スの設定を変更した場合、変更内容はアプリケーションを再実行した後も保
持されます。

4. Edit ボタンをクリックしてテーブル・エディタを表示します。テーブル・エディ

タには、高調波の番号（IEC 標準規格の場合は 1 ～ 40、MIL 規格の場合

は 1 ～ 50 または 1 ～ 100 （選択した設定パラメータに基づく））、ミリアンペ

ア単位の高調波限度、およびデシベル・マイクロアンペア単位の高調波限
度が表示されます。OK をクリックしてテーブル内の値を更新します。

NOTE. mA テーブルでは、高調波限度の値のみを編集できます。

5. Class コンボ・ボックスをクリックしてクラスを選択します。使用可能なクラスは

A ～ D です。

NOTE. クラス A とクラス B の高調波テーブルは編集できますが、クラス C とクラ
ス D は編集できません。

1. Class C を選択すると、力率のリミットが計算され、リミット・テーブルが更新さ

れます。Class D を選択すると、テスト対象の装置の有効電力から、高調波

のリミット値が計算されます。

2. Set ボタンをクリックして、選択した標準規格に高調波テーブルを設定しま

す。

IEC によって、61000-3-2 高調波標準規格の修正条項（修正条項 14）が発行さ

れました。この条項は、61000-3-2 修正条項 14 として文書化されています。
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この修正条項ではクラス定義が変更され、数多くの製品がクラス A に再分類さ

れて、クラス D の製品（クラス D 製品は、パーソナル・コンピュータとモニタが

600 W 未満、テレビ受像機が 600 W 未満に制限）が明確に定義されました。

AM 14 標準規格を選択した場合のアプリケーションの動作を参照するには、こ

のハイパーリンクをクリックしてください。

AM 14 標準規格の設定を行うには、次の手順を実行します。

1. Standard タブで、AM 14 ボタンを選択します。デフォルトでは、Line
Frequency は 50 Hz、Harmonics Order は 40 です。Auto を選択すると入力

信号の周波数が自動的に検出されます。60 Hz をクリックするか、または

Custom をクリックして、1 Hz ～ 4,000 Hz の範囲で電源周波数を設定しま

す。 高調波次数の設定範囲は、40 ～ 100 です。

1. Harmonics Table タブで、Harmonic ドロップダウン・リストをクリックしてテー

ブルを選択し、Edit ボタンを使用してテーブルを編集します。

 

 

2. 使用可能な 10 個のテーブルのいずれか 1 つを選択します。Table 1 がデ

フォルト・テーブルです。高調波テーブルを設定すると、Class コンボ・ボック

スに関連付けられたクラスが表示されます。アプリケーションを初めて実行
する場合は、Class A がすべての高調波テーブルに関連付けられます。クラ

スの設定を変更した場合、変更内容はアプリケーションを再実行した後も保
持されます。

3. Edit ボタンをクリックしてテーブル・エディタを表示します。テーブル・エディ

タには、IEC 規格の高調波の番号 1 ～ 40、およびミリアンペア単位とデシ

ベル・マイクロアンペア単位の高調波限度が表示されます。OK をクリックし

てテーブル内の値を更新します。
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4. Class コンボ・ボックスを使用してクラスを選択します。使用可能なクラスは A
～ D です。このコントロール・オプションでは、クラス C またはクラス D に対

してのみ追加入力を行うことができます。

5. Controls ボタンを選択して、制御画面を表示します。

6. Input Power、Power Factor または Fundamental Current ボックスをダブルク

リックし、表示されたキーパッドを使用して値を入力し、OK を選択します。各

ボックスの入力許容範囲は次のとおりです。

■ Input Power は 0 W ～ 2 KW。デフォルト値は 100 W です。

■ Power Factor は 0 ～ 1。デフォルト値は 1 です。

■ Fundamental Current は 0 A ～ 16 A。デフォルト値は 16 A です。

7. フィルタリングされた高調波の値を取得しない場合は、Filter をオフに設定し

ます。

MIL 1399 標準規格を選択した場合のアプリケーションの動作を参照するには、

このハイパーリンクをクリックしてください。

Standard タブで、MIL 1399 ボタンを選択します。デフォルトでは、Line
Frequency は 400 Hz、Harmonics Order は 50 です。Auto を選択すると入力信

号の周波数が自動的に検出されます。60 Hz をクリックするか、または Custom
をクリックして、1 Hz ～ 4,000 Hz の範囲で電源周波数を設定します。 高調波次

数の設定範囲は、50 ～ 100 です。

I プローブ・インピーダンスを設定するには、次の手順を実行します。

1. Harmonics Table タブで、Edit ボタンをクリックしてテーブル・エディタを表示

します。テーブル・エディタには、高調波の番号（61000-3-2 規格の場合は

1 ～ 40、MIL 規格の場合は 1 ～ 50 または 1 ～ 100 （選択した設定パラメ

ータに基づく））、およびデシベル単位のインピーダンス比率が表示されま
す。編集できるのは、テーブルのインピーダンス比率の列のみです。OK を
選択します。

2. Impedance Table Editor の Reset ボタンをクリックして、比率と dB の値をデ

フォルト値にリセットできます。高調波限度および高調波の番号は、デシベ
ル・マイクロアンペア単位で表示できます。インピーダンス・テーブルを使用
して、高調波の周波数のそれぞれにおけるプローブの転送インピーダンス
を設定します。テーブル・エディタには、高調波の番号（IEC 規格の場合は

1 ～ 40、MIL 規格の場合は 1 ～ 50 または 1 ～ 100 （選択した設定パラメ
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ータに基づく））、インピーダンス比率、およびデシベル単位のインピーダン
ス比率が表示されます。

NOTE. クラス C およびクラス D の高調波テーブルは編集できません。

3. 高調波の値を編集するには、値を選択します。Edit Selected Harmonic
Ratio コンボ・ボックスをダブルクリックし、表示されたキーパッドを使用して、

インピーダンス比率の値を入力します。OK を選択します。

4. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

5. Run をクリックして測定します。

6. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 全体の電源品質： 結果を表示するには、次の手順を実行します。

1. Analyze > Advanced Power Analysis を選択してから、Results を押して次の

画面を表示します。

 

 

注： この測定は電源品質と電流高調波の測定を組み合わせた測定である
ため、結果もこれらの測定を組み合わせた結果となります。
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2. View ボタンを選択して次の結果を表示します。

 

 

オプション 説明

Harmonic 高調波の番号が表示されます。

Value 測定値が表示されます。

Limit IEC 規格のリミットまたはユーザが定義したリミットが表示され

ます。

Margin Value の値と Limit の値の差が表示されます。

結果 測定の結果（Pass または Fail）が表示されます。

表 9 : 結果

フィールド Value
Class クラスが表示されます。

V-THD 電圧信号の総合高調波歪みが表示されます。

I-THD 電流信号の総合高調波歪みが表示されます。

Irms 電流信号の実効値が表示されます。

Vrms 電圧信号の実効値が表示されます。

Harmonic Frequency 指定した電源周波数設定が表示されます。

実際の信号周波数
が表示されます。

実際の入力電源周波数が表示されます。

POHC Measured 測定された部分奇数次高調波電流が表示されます。

POHC Limit 部分奇数次高調波電流のリミット値が表示されます。
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フィールド Value
POHC Status 部分奇数次高調波電流の Pass/Fail ステータスが表示されま

す。

True Power 波形の有効電力が表示されます。

Apparent Power 波形の皮相電力が指定されます。

V Crest Factor 電圧の波高率が表示されます。

I Crest Factor 電流の波高率が表示されます。

Power Factor 波形の力率が表示されます。

注： MIL 1399 標準規格を選択した場合には、Class、POHC Measured、
POHC Limit、および POCH Status は結果表には表示されません。

MIL 1399 標準規格を選択した場合は、アプリケーションは設定に基づいて

50 または 100 の高調波の値が表示されます。Field and Value テーブルで

は、Class 値に NA、Mode に MIL Standard と表示され、Line Frequency 値
と総合高調波はそれぞれヘルツ単位とパーセンテージ単位で表示されま
す。

3. View フィールドから Table オプションまたは Graph オプションを選択しま

す。MIL 規格を設定した場合、View フィールドのマスク・オプションは使用

できません。Mask オプションは、高調波テーブルにクラス A またはクラス D
のデバイスが存在する場合にのみ使用できます。Mask の結果では、赤は

マスク境界を示し、黄色は入力電流波形の半サイクル 1 回を示します。X
軸には波形の角度が度単位で表示されます。Y 軸には i/I ピークが示され

ます。ここで、i は電流であり、I ピークは 1 回の半サイクルにおける電流の

ピークです。

4. 棒グラフでは、赤は Fail ステータスを示し、緑は Pass および灰色は設定さ

れたリミットを示します。マスク・オプションには、有効電力および検出された
デバイスのクラスが表示されます。

5. Harmonics フィールドでドロップダウン・リストを選択して、高調波を 3 つのモ

ード（All、Even、および Odd）で表示します。All の高調波を指定すると、一

連の高調波の値がすべて表示されます。Even の高調波を指定すると、2 ～
40 の偶数の値が表示されます。Odd の高調波を指定すると、1 ～ 39 の奇

数の値が表示されます。

6. Units フィールドで dB μA または A をクリックして、単位をデシベル・マイク

ロアンペアまたはアンペアに設定します。デフォルトの単位は dB μA です。

注： 単位を変更すると、その変更は表および棒グラフの Value、Limit、およ
び Margin の各フィールドに反映されます。表形式を選択した場合にの
み、.csv ファイルをエクスポートします。

Harmonics Bar Graph プロットが選択されている場合、Show Plots をクリックして

プロットを表示します。
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次の項目も参照してください。：

測定の選択および設定 - 全体の電源品質

コンポーネントのプロットと機能
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突入電流 測定の選択および設定 - 突入電流： 測定の選択および設定 - 突入電流測定の

設定

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Measurements フィールドで In Rush Current をクリックします。次に、

Configure ボタンをクリックします。

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品の警
告を参照し、使用するプローブおよびその他のコンポーネントが定格内であるこ
とを確認してください。また、詳細については、トピック安全にご使用いただくた
めにを参照してください。

NOTE. 前の測定に使用した電源と同じ電源を使用する場合は、ソース設定オプ
ションを設定する手順を省略できます。

選択された測定を設定するには、次の手順を実行します。

1. Options タブの Units コンボ・ボックスで、Percentage オプションを選択して

Ref Level および Hysteresis の値をパーセンテージで設定するか、または

Absolute オプションを選択してピーク・ツー・ピーク信号の絶対値を設定しま

す。REF Level はスレッショルド・レベルのように機能し、これにより関心領域

が決まります。

入力電流波形は複数の領域に分割することができます。領域は、電流波形
がスレッショルド・レベルに入り、再び出る時点として定義されます。各領域
について、正と負のピークが計算されます。REF Level は最初の有効なピ

ークの検出に使用されます。その後、他の REF Level の上か下のピークが

検出されます。

2. Options タブをクリックします。Peak (Amps) テキスト・ボックスをダブルクリック

して、希望値を入力します。

 

 
3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを

グローバルに設定するには、グローバル設定の構成を参照してください。

4. Run をクリックして測定します。

5. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 突入電流： 結果を表示するには、次の手順を実行します。

1. Analyze > Advanced Power Analysis を選択してから、Results を押して次の

画面を表示します。

 

 
突入電流の詳細な結果
 

 

次の項目も参照してください。：

測定の選択および設定 - 突入電流
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入力キャパシタンス 測定の選択および設定 - 入力キャパシタンス： 測定の選択および設定 - 入力

キャパシタンス測定の設定

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Input Analysis をクリックして、Input Analysis 画面を表示します。

3. Measurements フィールドで Input Capacitance をクリックします。次に、

Configure ボタンをクリックします。数値は正負のピークの数を表します。

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品の警
告を参照し、使用するプローブおよびその他のコンポーネントが定格内であるこ
とを確認してください。また、詳細については、トピック安全にご使用いただくた
めにを参照してください。

NOTE. 前の測定に使用した電源と同じ電源を使用する場合は、ソース設定オプ
ションを設定する手順を省略できます。

選択された測定を設定するには、次の手順を実行します。

1. Options タブの Units コンボ・ボックスで、Percentage オプションを選択して

Ref Level および Hysteresis の値をパーセンテージで設定するか、または

Absolute オプションを選択してピーク・ツー・ピーク信号の絶対値を設定しま

す。

2. Options タブをクリックします。Peak (Amps) テキスト・ボックスをダブルクリック

して、希望値を入力します。

 

 

3. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

4. Run をクリックして測定します。

5. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - 入力キャパシタンス： 結果を表示するには、次の手順を実行しま

す。

1. Analyze > Advanced Power Analysis を選択してから、Results を押して次の

画面を表示します。

 

 

次の項目も参照してください。：

測定の選択および設定 - 入力キャパシタンス
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出力の測定および解析

ライン・リップル 測定の選択および設定 - ライン・リップル： リップル測定を選択して設定するに

は、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Output Analysis をクリックして、Output Analysis 画面を表示します。

3. Measurements フィールドで Line Ripple をクリックします。次に、Configure
ボタンをクリックします。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Global タブの Coupling フィールドで、AC カップリングまたは DC カップリン
グを選択します。

2. Bandwidth Limit フィールドで、Bandwidth オプション 20 MHz、250 MHz、
または Full のいずれかを選択します。これらのオプションは、サポートされ
ているオシロスコープのうち、一部のものでは使用できない場合があります。
使用しているオシロスコープの帯域幅オプションを参照してください。

3. Acquisition Mode フィールドで、オシロスコープのアクイジション・モードを
Hi Res モード、Average モード、または Sample モードに設定します。

4. LineRipple Freq タブの Ripple Frequency フィールドで、電源周波数を
50 Hz、60 Hz、または 400 Hz に設定します。

5. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - ライン・リップル： 結果を表示するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. ライン・リップル測定の結果が表示されます（下図を参照）。

 

 

注： 解像度帯域幅 (RBW) が小さければ小さいほど、スペクトラム測定結果の解
像度は向上します。Update ボタンが選択されると、RBW は範囲（開始値および
停止値）に基づいて計算され、適切なレコード長およびサンプル・レートが選択
されます。RBW 値のリストがドロップダウン・リストに表示されます。希望する解像
度に基づいて特定の RBW 値を設定し、RBW の効果を得るために、Autoset ボ
ックスをチェックすることができます。これにより、ソースのオートセットが有効にさ
れ、RBW 値が考慮され、最終的にオシロスコープで水平パラメータがセットアッ
プされます。オートセットが実行されていない場合は、必要な水平時間軸が
RBW に含まれていないことを示すエラー・メッセージが表示されます。

次の項目も参照してください。：

測定の選択および設定 - ライン・リップル

拡張電源測定および解析ソフトウェア  

172  拡張電源解析



スペクトラム解析 測定の選択および設定 - スペクトラム解析： 目的：電磁干渉の一因となる周波

数成分を解析し、DC 出力電圧の周波数範囲でノイズおよびリップルを測定しま

す。表示されるプロット・コンポーネントには、Y 軸にスペクトラムの振幅、X 軸に

周波数（単位：Hz）がプロットされます。スペクトラム解析ツールを使用するには、

次の手順を実行します。

1. Output Analysis タブをクリックして、Output Analysis 画面を表示します。

2. Measurements フィールドで Spectral Analysis をクリックします。

3. Configure をクリックして次の画面を表示します。

 

 
4. Source Configuration パネルでオプションを設定します。Source には、DUT

の接続先となる入力ソースを指定します。使用可能なオプションは次のとお
りです。Ch1 ～ Ch4、Math1 ～ Math4、および Ref1 ～ Ref4。これらの選択

肢は、オシロスコープのチャンネル数によって異なります。

5. Start ボックスおよび Stop ボックスをダブルクリックし、表示されたキーパッド

を使用して、周波数の値を設定します。周波数の開始オプションおよび停
止オプションでは、解析対象となる入力信号の周波数値の範囲を定義しま
す。Start フィールドでは、0 Hz ～ 499 MHz の範囲の値を設定します。デフ

ォルト値は 50 Hz です。Stop フィールドでは、50 Hz ～ 500 MHz の範囲の

値を設定します。デフォルト値は 10 KHz です。

6. Window Type コンボ・ボックスをクリックして、ウィンドウ・タイプを設定しま

す。Rectangular ウィンドウ以外のウィンドウ・タイプでは、スペクトラム解析使

用時のスペクトラム・リークが減少します。使用できるウィンドウ・タイプは、
Rectangular、Hamming、Hanning、Black-Harris、Gaussian、Flattop2、
Kaiser-Bessel、および TekExp です。

Options フィールドでは、Auto Setup がデフォルトでオンになっています。指

定した Start、Stop、および Window Type の入力に対して、レコード長およ

び時間軸が自動的に設定されます。Frequency フィールドの Res BW ドロッ

プダウン・リストを使用して、RBW（分解能と帯域幅）値を設定します。Start、
Stop、および Window Type の入力に従って、RBW 値が計算されます。

RBW 値を更新するには、Update ボタンをクリックしてください。Auto Setup
チェック・ボックスがオフの場合、Update ボタンは無効になります。また、ア

プリケーションは、オシロスコープで使用可能な既存のレコード長および時
間軸を使用して実行されます。

Options フィールドは、次の場合に有効になります。

■ Source フィールドで Ref ソースを選択した場合
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■ Mode フィールドで Single 実行オプションを選択した場合

Source フィールドでライブ・ソースを選択した場合は、DC Block を有効にし

ます。DC Block をクリックすると信号の垂直感度が調整され、DC 出力電圧

でノイズの周波数成分が測定されます。

7. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

8. Run ボタンを選択してデータを取り込みます。開始と停止の周波数値を入

力した場合は、選択した RBW 値が計算され、この値が RBW の最大値に

設定されて測定が実行されます。測定が正常に実行されると、結果が自動
的に表示されます。
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結果の表示 - スペクトラム解析： 結果を表示するには、次の手順を実行しま

す。

1. 適切な設定を行った後、オシロスコープのメニュー・バーから、Analyze >
Advanced Power Analysis を選択し、Plots ボタンを押してから Spectrum ボ
タンを押します。Single ボタンをクリックし、以下のようにスペクトラム・プロット

を表示します。

 

 

X 軸に周波数の値、Y 軸に振幅の値がプロットされ、開始から停止範囲ま

での値が表示されます。Y 軸は、各区間の電圧ピークの最大と最小の範囲

を示しています。

Vertical Scale フィールドでは、プロットの垂直軸スケールを dB および RMS
などに切り替えることができます。

スペクトラム・プロット領域をダブルクリックすると、Marker Value、Vertical
Scale が表示され、プロット・オプションが保存されます。

2. Zoom In ボタンをクリックして特定の領域にカーソルを置き、プロットを拡大

します。また、Zoom Out ボタンを使用して、縮小することもできます。

3. Save ボタンをクリックすると、プロットが .csv フォーマットでデフォルト・ディレ

クトリ C:\ Program Data\Tektronix\TekApplications\Advanced Power
Analysis\Images\ に保存されます。
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ピーク周波数とその振幅を表示するには、Results > Detailed をクリックします。

注： 結果要約では、すべてのピークの統計が表示されます。結果詳細では、上
位 10 のピークが表示されます。

次の項目も参照してください。：

測定の選択および設定 - スペクトラム解析

コンポーネントのプロットと機能

スペクトラム解析のエラー・メッセージのトラブルシューティング： 開始と停止の

値を設定するのに必要な最小レコード長が、アプリケーションでサポートされる
最大レコード長を超過する場合は、"Frequency Range higher than range
supported." というエラー・メッセージが表示されます。
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スイッチング・リップル 測定の選択および設定 - スイッチング・リップル： リップル測定を選択して設定

するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Output Analysis をクリックして、Output Analysis 画面を表示します。

3. Measurements テーブルで Switching Ripple をクリックします。次に、

Configure ボタンをクリックします。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Source Configuration パネルでオプションを設定します。

2. Global タブで、Coupling フィールドから、AC または DC のカップリング・オ
プションを選択します。

3. Bandwidth Limit フィールドの 20 MHz、250 MHz、または Full のオプション
から、帯域幅オプションを選択します。Full オプションは、オシロスコープで
使用可能な最大帯域幅を表します。これらのオプションは、サポートされて
いるオシロスコープのうち、一部のものでは使用できない場合があります。
使用しているオシロスコープの帯域幅オプションを参照してください。

4. Acquisition Mode フィールドで、オシロスコープのアクイジション・モードを
High Res、Pk Detect、または Sample に設定します。

5. Ripple Freq タブで、Switching Frequency フィールドをダブルクリックし、表
示されたキーパッドを使用して、スイッチング周波数を選択します。デフォル
ト値は 10 KHz です。

 

 
6. Run を選択してデータを取り込みます。

7. 測定が正常に実行されると、結果が自動的に表示されます。
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結果の表示 - スイッチング・リップル： 結果を表示するには、次の手順を実行し

ます。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. リップル測定の結果が表示されます（下図を参照）。

 

 

次の項目も参照してください。：

測定の選択および設定 - スイッチング・リップル
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ターン・オン時間 測定の選択および設定 - ターン・オン時間： ターン・オン時間測定を選択して設

定するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Select ナビゲーション・タブを押します。

2. Select をクリックします。Output Analysis タブをクリックして、Output Analysis
画面を表示します。

3. Measurements フィールドでで、Turn-On Time をクリックします。次に、

Configure ボタンをクリックします。

警告： 危険な高電圧を使用する回路に接続する場合は、個々の製品の警告を
参照し、使用するプローブおよびその他のコンポーネントが定格内であることを
確認してください。また、詳細については関連するトピックを参照してください。

測定の設定. 選択された測定を設定するには、次の手順を実行します。
 

 

1. Input タブの Convertor フィールドで、使用するコンバータのタイプを DC-
DC または AC-DC から選択します。AC-DC オプションを選択して、
Frequency オプションを有効にします。Frequency ボックスをダブルクリック
し、表示されたキーパッドを使用して、ライン入力周波数を設定します。

■ Source パネルで、最大電圧とトリガ・レベル（1 V ～ 500 V）を入力する
には、対応するフィールドをダブルクリックし、表示されるキーパッドを使
用します。

2. Max Turn-On Time ボックスをダブルクリックし、表示されたキーパッドを使
用して、予想されるターン・オン時間を入力します。この値を入力すると、オ
シロスコープのタイミング・ウィンドウを設定できます。

3. Output タブで、OFF ボタンまたは On ボタンをクリックします。Source1 コン
ボ・ボックスをクリックして、チャンネル・ソースを選択します。ソースには Ch1
～ Ch4 を指定できます。

4. Max Voltage ボックスをダブルクリックし、表示されたキーパッドを使用して、
最大電圧値を入力します。

5. Source 2 と Source 3 の選択項目についても、手順  2 ～  3 を繰り返します。

6. 被測定装置の電源をオンにします。

7. カップリング、帯域幅制限、カーソル・ゲート、およびアクイジション・モードを
グローバルに設定するには、グローバル設定の構成を参照してください。

8. Single を押して測定します。
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9. 測定が正常に実行されると、結果が自動的に表示されます。

結果の表示 - ターン・オン時間： 結果を表示するには、次の手順を実行します。

注： アプリケーションの実行中に結果を表示するには、一旦電源をオフにしてか
らオンにし、結果を表示してください。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択してから、Results を押します。

2. ターン・オン時間の測定の結果が表示されます（下図を参照）。

 

 

次の項目も参照してください。：

測定の選択および設定 - ターン・オン時間
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振幅

サイクル最小値 測定の選択および設定 - サイクル最小値： サイクル最小値の測定を選択およ

び設定するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. 測定パネルの測定項目をクリックして、Cycle Min を選択します。

4. Configure ボタンをクリックして、サイクル最小値の測定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Signal Type タブで、信号タイプとして AC または DC を選択します。大きな

DC 成分を持つ測定では、信号タイプを DC に設定しなければなりません。

3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。
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4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - サイクル最小値

Source Configuration パネル

ソース・オートセット
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測定結果の表示 - サイクル最小値： 次の図は、サイクル最小値を表示した結果

タブを示しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、サイクル最小値の結果が表示されます。

サイクル最小値測定のタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - サイクル最小値
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サイクル最大値 測定の選択および設定 - サイクル最大値： サイクル最小値の測定を選択およ

び設定するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. 測定パネルの測定項目をクリックして、Cycle Max を選択します。

4. Configure ボタンをクリックして、サイクル最大値の測定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Signal Type タブで、信号タイプとして AC または DC を選択します。大きな

DC 成分を持つ測定では、信号タイプを DC に設定しなければなりません。

3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。
 

 

4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - サイクル最大値
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Source Configuration パネル

ソース・オートセット

測定結果の表示 - サイクル最大値： 次の図は、サイクル最大値を表示した結果

タブを示しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、サイクル最大値の結果が表示されます。

サイクル最大値のタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - サイクル最大値
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サイクル・ピーク（Pk-Pk） 測定の選択および設定 - サイクル・ピーク： サイクル・ピークの測定を選択およ

び設定するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. 測定パネルの測定項目をクリックして、Cycle PkPk を選択します。

4. Configure ボタンをクリックして、サイクル・ピークの測定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Signal Type タブで、信号タイプとして AC または DC を選択します。大きな

DC 成分を持つ測定では、信号タイプを DC に設定しなければなりません。

3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。
 

 

4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - サイクル・ピーク
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Source Configuration パネル

ソース・オートセット

測定結果の表示 - サイクル・ピーク： 次の図は、サイクル・ピークを表示した結

果タブを示しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、サイクル・ピークの結果が表示されます。

サイクル・ピークのタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - サイクル・ピーク
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High 測定の選択および設定 - 振幅（ハイ）： 振幅（ハイ）の測定を選択および設定す

るには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. パネルの測定項目をクリックして、High を選択します。

4. Configure ボタンをクリックして、（ハイ）の設定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Edge タブで、以下の項目を設定します。

■ Measure the Center X% of the signal では、各測定においてビット・ストリ

ームの中心からどの程度の範囲（単位間隔の 1 ～ 100%）が測定される

かを指定します。パーセンテージで選択された波形ポイントにより分布
（垂直ヒストグラム）が形成され、そこから Method 設定に基づいて単一

の値が抽出されます。

■ Method では、各単位間隔の測定値として、選択された分布に対する

Mean または Median のいずれの値が使用されるかを指定します。
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3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。
 

 

4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - 振幅（ハイ）

Source Configuration パネル

ソース・オートセット
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測定結果の表示 - 振幅（ハイ）： 次の図は、振幅（ハイ）を表示した結果タブを示

しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、振幅（ハイ）の結果が表示されます。

振幅（ハイ）のタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - 振幅（ハイ）
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Low 測定の選択および設定 - 振幅（ロー）： 振幅（ロー）の測定を選択および設定す

るには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. パネルの測定項目をクリックして、Low を選択します。

4. Configure ボタンをクリックして、（ロー）の設定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Edge タブで、以下の項目を設定します。

■ Measure the Center X% of the signal では、各測定においてビット・ストリ

ームの中心からどの程度の範囲（単位間隔の 1 ～ 100%）が測定される

かを指定します。パーセンテージで選択された波形ポイントにより分布
（垂直ヒストグラム）が形成され、そこから Method 設定に基づいて単一

の値が抽出されます。

■ Method では、各単位間隔の測定値として、選択された分布に対する

Mean または Median のいずれの値が使用されるかを指定します。
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3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。この設定は、波形

のエッジを検出するのに使用されます。
 

 

4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - 振幅（ロー）

Source Configuration パネル

ソース・オートセット
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測定結果の表示 - 振幅（ロー）： 次の図は、振幅（ロー）を表示した結果タブを示

しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、振幅（ロー）の結果が表示されます。

振幅（ロー）のタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - 振幅（ロー）
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（ハイ）-（ロー） 測定の選択および設定 - 振幅（（ハイ）-（ロー））： 振幅（ハイ）の測定を選択およ

び設定するには、次の手順を実行します。

1. オシロスコープのメニュー・バーから、Analyze > Advanced Power Analysis
を選択します。

2. Amplitude をクリックして、Amplitude の下にカテゴライズされた測定項目を

表示します。

3. パネルの測定項目をクリックして、High Low を選択します。

4. Configure ボタンをクリックして、（ハイ）-（ロー）の設定画面を表示します。

 

 

測定の設定

選択された測定を設定するには、次の手順を実行します。

1. Source フィールドをクリックすると、Source Configuration ウィンドウが表示さ

れます。この画面で、測定のための Source を選択します。チャンネル・ソー

スとして使用可能なオプションは、Ch 1、Ch 2、Ch 3、Ch 4、Ref 1、Ref 2、
Ref 3、Ref 4、Math 1、Math 2、Math 3、Math 4 です。

2. Edge タブで、以下の項目を設定します。

■ Measure the Center X% of the signal では、各測定においてビット・ストリ

ームの中心からどの程度の範囲（単位間隔の 1 ～ 100%）が測定される

かを指定します。パーセンテージで選択された波形ポイントにより分布
（垂直ヒストグラム）が形成され、そこから Method 設定に基づいて単一

の値が抽出されます。

■ Method では、各単位間隔の測定値として、選択された分布に対する

Mean または Median のいずれの値が使用されるかを指定します。
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3. Options タブで、Ref Level および Hysteresis をボルト（絶対値）、または選択

された Units に基づいたパーセンテージで設定します。
 

 

4. Global タブの各項目の設定を行います。グローバル設定については、ここ
をクリックしてください。

次の項目も参照してください。：

測定結果の表示 - 振幅（（ハイ）-（ロー））

Source Configuration パネル

ソース・オートセット
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測定結果の表示 - 振幅（（ハイ）-（ロー））： 次の図は、振幅（（ハイ）-（ロー））を表

示した結果タブを示しています。

プロットによる結果の表示

各サイクルの下部すべてについてのタイム・トレンド・プロット、およびヒストグラ
ム・プロットにも、振幅（（ハイ）-（ロー））の結果が表示されます。

振幅（（ハイ）-（ロー））のタイム・トレンド／ヒストグラム・プロット

次の項目も参照してください。：

測定の選択および設定 - 振幅（（ハイ）-（ロー））
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チュートリアル

アプリケーションの起動

アプリケーションを起動するには、オシロスコープのメニューを開き、Analyze >
Advanced Power Analysis を選択します。

チュートリアルの概要

このチュートリアルでは、アプリケーションの設定方法、2 種類の測定の実行方

法、および結果の表示方法を説明します。

チュートリアルを開始する前に、次の作業を実行する必要があります。

オシロスコープの設定

アプリケーションの起動

オシロスコープの設定

オシロスコープを設定するには、オシロスコープのメニュー・バーで File メニュー

を開き、Recall Default Setup を選択して、オシロスコープをデフォルトの出荷時

設定に戻します。
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スイッチング・ロスの測定

このセクションでは、スイッチング・ロスの測定方法、結果の表示方法、およびレ
ポートの生成方法について説明します。これらの作業を実行するには、DPO/
DSA7000C シリーズ、MSO/DPO5000/B シリーズ、MSO/DSA/DPO70000C シリ

ーズ、DPO/DSA700000D シリーズ、MSO/DPO/DSA70000DX シリーズのオシ

ロスコープでアプリケーションのオプション・キーをインストールして有効にしま
す。アプリケーションのインストール

スイッチング・ロスを測定するには、次の手順を実行します。

1. オシロスコープのメニューから、 > > > File > Recall > Waveform > Recall
Waveform を選択します。

2. Destination を Ref 1 に設定して、C:\Users\Public\Tektronix
\TekApplications\Advanced Power Analysis\Waveforms\Switching Wfms フ
ォルダから、HighPowerFinderVoltage.wfm 波形ファイルを Ref 1 に呼び出

します。

3. オシロスコープのメニューから、File > Recall > Waveform を選択します。

4. Destination を Ref 2 に設定して、C:\Users\Public\Tektronix
\TekApplications\Advanced Power Analysis\Waveforms\Switching Wfms フ
ォルダから、HighPowerFinderCurrent.wfm 波形ファイルを Ref 2 に呼び出

します。

5. DPOPWR アプリケーションで、Switching Analysis タブを選択します。

Switching Loss をクリックしてから Configure ボタンをクリックします。
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6. Source Selection パネルで、Source を Ref、Voltage を Ref1、および Current
を Ref2 に設定します。

 

 

7. Type、On-Off Level、および Options の各タブでオプションを設定します。

Single ボタンを押します。

 

 

8. ターン・オン電力損失、ターン・オフ電力損失、および電力損失として結果
が表示されます。

9. ここをクリックして、結果を表示します。

 チュートリアル
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スイッチング・ロスの結果の表示

 

 

磁気の測定

このセクションでは、磁気の測定方法、結果の表示方法、およびレポートの生成
方法について説明します。これらの作業を実行するには、DPO/DSA7000C シリ

ーズ、MSO/DPO5000/B シリーズ、MSO/DSA/DPO70000C シリーズ、DPO/
DSA700000D シリーズ、MSO/DPO/DSA70000DX シリーズのオシロスコープで

アプリケーションをインストールして有効にします。「アプリケーションのインストー
ル」を参照して、アプリケーションをインストールしてください。

磁気を測定するには、次の手順を実行します。

1. オシロスコープのメニューから、 > > File > Reference Wfm > Recall
Waveform を選択します。

2. Destination を Ref 1 に設定して、C:\User\Public\Tektronix\TekApplications
\Advanced Power Analysis\waveforms\Magnetic Wfms フォルダから、

MagVoltage.wfm 波形ファイルを Ref 1 に呼び出します。

3. オシロスコープのメニューから、File > Reference Wfm を選択します。

4. Destination を Ref 2 に設定して、C:\User\Public\Tektronix\TekApplications
\Advanced Power Analysis\waveforms\Magnetic Wfms フォルダから、

MagCurrent.wfm 波形ファイルを Ref 2 に呼び出します。

5. DPOPWR アプリケーションで、Magnetics タブを選択します。
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1. Magnetic Property オプションを選択して、Configure をクリックします。

 

 
2. Source Configuration パネルで、Source を Ref、Voltage を Ref1、および

Current を Ref2 に設定します。

 

 

1. Source、Global、Physical Chars2 タブから、Freq and Duty のボタン、Cursor
Gating の Off ボタン、# of Windings のボタンを選択します。

2. Physical Chars1 タブで、SI 単位を選択し、Magnetic Length を 0.0265 m、

Cross section Area を .00001358 m2 に設定します。Physical Chars2 タブで、

# of Turns を 50 に設定します。

 チュートリアル
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3. Single をクリックして、結果を B-H 曲線形式で表示します。Bpeak、Br、Hc、
HMax、および I-ripple の結果が表示されます。

4. ここをクリックして、磁気特性の結果を表示します。

磁気特性の結果の表示

 

 

チュートリアルの停止

チュートリアルのレッスンを完了するまでに複数のセッションが必要な場合は、
チュートリアルを停止して、後で再開します。

アプリケーション設定を保存するには、「設定の保存」を参照してください。

チュートリアルに戻る

チュートリアルに戻るには、アプリケーションを起動して、保存した設定を呼び出
します。アプリケーション設定を呼び出すには、「保存された設定の呼び出し」を
参照してください。
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使用例

使用例について

このセクションでは、いくつかの使用例を示します。簡単な AC/DC 回路図の例

を示してアプリケーションによる測定を詳しく説明し、アプリケーションで実際に
テストを行うときに発生する問題を解決するためのヒントを示します。

使用例を実行するには、オシロスコープに拡張電源解析アプリケーションをイン
ストールして有効にし、被測定装置にプローブを接続してデバイスを設定しま
す。アプリケーションをインストールするには、「アプリケーションのインストール」
を参照してください。互換性のあるプローブの詳細については、「互換性」およ

び「電流プローブ」のセクションを参照してください。アプリケーションを設定する

には、「アプリケーションの設定と測定の実行」を参照してください。

次の項目も参照してくだ
さい。

スイッチング・ロスの測定

ハイパワー・ファインダの測定

磁気損失の測定

スイッチング電源の効率を改善するには

スイッチング・ロスの測定 目的：スイッチング・デバイスでの電力損失を最適化し、電源の効率を改善しま
す。

機器の指定：.
1. 当社のオシロスコープ（「互換性」のセクションに記載）

2. DPOPWR アプリケーション

3. 適切な電流プローブおよび差動プローブ
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機器設定：. 回路に接続する前に「安全にご使用いただくために」を参照してく
ださい。

1. ドレインの両端の電圧を測定するには、電圧プローブと電流プローブを
MOSFET のスイッチング電源に接続します（下図を参照）。

 

 

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品
の警告を参照し、使用するプローブおよびその他のコンポーネントが定格
内であることを確認してください。また、詳細については、トピック安全にご使
用いただくためにを参照してください。

2. DPOPWR アプリケーションを実行します。

3. Switching Analysis タブを選択します。

4. Switching Loss を選択して、Configure ボタンを押します。Preferences ウィン
ドウで、I プローブ設定を適切に行います。Perform Deskew ボタンを選択し
て、プローブとチャンネルをデスキューします。

5. Switching Loss 測定を選択します。

6. Run を選択してデータを取得し、次の結果を表示します。

結果 説明

最小値 取り込まれたデータの最小電力損失またはサイクルを測定しま
す。

最大値 取り込まれたデータの最大電力損失またはサイクルを測定しま
す。

Average 複数アクイジションの電力損失の変動を測定します。
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ハイパワー・ファインダの

測定

目的：動的環境にあるスイッチング・デバイスのハイパワー・ファインダを解析し
ます。

機器の指定：.
1. 当社のオシロスコープ（「互換性」のセクションに記載）

2. DPOPWR アプリケーション

3. 適切な電流プローブおよび差動プローブ

 使用例
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機器設定：. 回路に接続する前に「安全にご使用いただくために」を参照してく
ださい。

1. ドレインの両端の電圧を測定するには、当社の差動プローブと電流プロー
ブを MOSFET のスイッチング電源に接続します（下図を参照）。

 

 

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品
の警告を参照し、使用するプローブおよびその他のコンポーネントが定格
内であることを確認してください。また、詳細については、トピック安全にご使
用いただくためにを参照してください。

2. DPOPWR アプリケーションを実行します。

3. Switching Analysis タブを選択します。

4. Hi-Power Finder オプションを選択して、Configure ボタンを押します。

5. 共通設定パネルで、I プローブ設定を適切に行います。Preferences ウィンド
ウで、Deskew ボタンを選択して、プローブとチャンネルをデスキューしま
す。

6. Hi-Power Finder 測定を選択します。

使用例  
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7. Deskew ボタンを選択してデスキューを行います。動的環境に関連する適切
なトリガを設定して Run を選択し、結果を表示します。

 

 

結果には、スイッチング時の瞬時ピーク電力と取り込まれたデータのピーク
数が表示されます。対象範囲を選択して、瞬時ピーク電力の対象領域を表
示します。

8. テーブルから瞬時ピーク電力を選択すると、カーソルをリンクできます。

9. Zoom ボタンを選択して、カーソル付近の詳細な情報を表示します。

磁気損失の測定 目的：磁気損失を測定します。

機器の指定：.
1. 当社のオシロスコープ（「互換性」のセクションに記載）

2. DPOPWR アプリケーション

3. 適切な電流プローブおよび差動プローブ

 使用例
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機器設定：. 回路に接続する前に「安全にご使用いただくために」を参照してく
ださい。

1. インダクタの両端の電圧を測定するには、当社の差動プローブと電流プロ
ーブをスイッチング電源に接続します（下図を参照）。

WARNING. 危険な高電圧を使用する回路に接続する場合は、個々の製品
の警告を参照し、使用するプローブおよびその他のコンポーネントが定格
内であることを確認してください。また、詳細については、トピック安全にご使
用いただくためにを参照してください。

2. DPOPWR アプリケーションを実行します。

3. Magnetics タブを選択します。

4. Magnetic Loss 測定を選択します。Configure を選択します。Global タブで、
Cursor Gating オプションを選択します。

5. Configuration タブで、I プローブ設定を適切に行います。Preferences ウィン
ドウで、Deskew ボタンを選択し、電圧信号と電流信号をデスキューします。

6. Run を押して測定を実行し、結果を表示します（下図を参照）。

 

 
7. 結果には、磁性材料の電力損失が表示されます。

結果：. スイッチング・ロス、ハイパワー・ファインダ、および磁気損失の結果は、
電力損失の特定と削減、および効率の改善に役立ちます。
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GPIB コマンド

DPOPWR LAUnch
拡張電源解析アプリケーションを起動します。

構文 DPOPWR LAUnch

DPOPWR:ADDMeas
この設定専用コマンドは、拡張電源解析の測定リストの末尾に、指定した測定を
追加します。追加した測定は結果要約ページに表示されます。

構文

DPOPWR:ADDMeas {SWITCHingloss | HIGHPOwerfinder | SOA | RDSon |
DVDt | DIDt | SOAXY | PULSEWidth | DUTYCycle | PERIod | FREQuency |
SKEw | INDuctance | MAGNeticproperty | MAGNETICLOSS | IV | PQuality |
CURRENTHarmonics | TOTALPowerquality | INRUSHCurrent |
INPUTCAPacitance | VOLTAGEHarmonics | LINERipple | SWITCHINGRipple
| SPECTralanalysis | TURNontime | HIGh | LOW | HIGHLow | CYCLICMIn |
CYCLICMAx | CYCLICPKpk}

引数 UI 名 説明

SWITCHingloss スイッチング・ロス 電圧／電流信号の各サイクルのターン・オ
ン、ターン・オフ、および伝導損失を測定し
ます。

HIGHPOwerfinder Hi-Power Finder ターン・オン／ターン・オフ領域のピーク電
力を測定し、電力損失が最大になる位置
を特定します。

SOA SOA 電力半導体素子の安全動作領域をグラフ
ィカルに測定し、取り込まれた波形のレコ
ード長全体における最大動作電圧／電流
を示します。

RDSon RDS(on) スイッチング・デバイスがオン状態にある
間に、そのデバイスによって発生する抵抗
を測定します。

DVDt dv/dt スイッチング中の電圧の変化を表す過渡
応答を測定します。

DIDt di/dt スイッチング中に電流が変化するレートを
表す電流過渡応答を測定します。

SOAXY SOA X-Y（DPX） X 軸の電圧と Y 軸の電流の関係をプロット

します。
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引数 UI 名 説明

PULSEWidth パルス幅 パルスの立上りエッジと立下りエッジ間の
時間差（正または負）です。

DUTYCycle デューティ・サイクル 周期に対するサイクルの正（または負）の
部分の割合を計算します。

PERIod 周期 クロック周期の測定では、開始エッジと終
了エッジで定義されたサイクルの時間を計
算します。

FREQuency 周波数 クロック周波数の測定では、各サイクルの
クロック周期の逆数を計算します。

SKEw スキュー 2 つの周期的信号の間の遅延を測定しま

す。

INDuctance インダクタンス インダクタンスの値は、稼動中のコアの動
作状況の把握に役立ちます。

MAGNeticproperty 磁気特性 回路内動作で使用される磁気コンポーネ
ントの磁性材料に関するパラメータを測定
します。

MAGNETICLOSS 磁気損失 電流波形のサイクルを基準として使用し
て、積分波形のデータ・ポイントのサイクル
が特定されます。

IV 電流に対する電圧の積分を表す XY プロッ

トです。

PQuality 電源品質 電源品質の測定では、電力変換回路の
AC 入力セクションの測定値と統計値が

1 つのテーブルで示されます。

CURRENTHarmonics 電流高調波 さまざまな規格の基本調波周波数に基づ
いて、dBA および RMS 単位で高調波を計

算します。

TOTALPowerquality 全体の電源品質 電源品質と電流高調波の測定値を 1 つの

画面に表示します。

INRUSHCurrent 突入電流 インサーキット動作時のスイッチング電源
のピーク突入電流とキャパシタンス値を測
定します。

INPUTCAPacitance 入力キャパシタンス スイッチング・デバイスのターン・オン中
に、スイッチング電圧／電流を使用してキ
ャパシタンス値を測定します。

VOLTAGEHarmonics 電圧高調波 基本調波周波数に基づいて、電圧ソース
のチャンネルの高調波を計算します。

LINERipple ライン・リップル 各サイクルの DC または低周波数の AC 電
圧に存在するピーク・ツー・ピークのリップ
ル電圧を測定します。

SWITCHINGRipple スイッチング・リップ
ル

スイッチング周波数に関連した AC 信号の

量を測定します。

SPECTralanalysis スペクトラム解析 スペクトラム解析は電力変換装置の出力
電圧の周波数成分を測定します。
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引数 UI 名 説明

TURNontime ターン・オン時間 AC のターン・オン時間は、システムに入力

電圧が印加された時間と、出力電圧に達
するまでの時間の時差です。

HIGh High 振幅（ハイ）は各単位間隔の選択された部
分の平均またはモードを計算します。

LOW Low 振幅（ロー）は各単位間隔の選択された部
分の平均またはモードを計算します。

HIGHLow （ハイ）-（ロー） （ハイ）-（ロー）測定は波形が遷移する間

の電圧レベルの変化を計算します。

CYCLICMIn サイクル最小値 サイクル最小値はすべてのサイクルの波
形の負のピークを測定します。各サイクル
の立下りスロープの中間レベルから立上り
スロープまでの間の最小電圧です。

CYCLICMAx サイクル最大値 サイクル最大値はすべてのサイクルの正
のピークを測定します。各サイクルの立上
りスロープの中間レベルから立下りスロー
プまでの間の最大電圧です。

CYCLICPKpk サイクル・ピーク サイクル・ピークは、波形の各サイクルの
最大振幅と最小振幅の絶対差を測定しま
す。

例

DPOPWR:ADDMeas HIGh は、測定テーブルに振幅（ハイ）の測定を追加しま
す。

 GPIB コマンド
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DPOPWR:CLEARALLMeas
このクリア専用コマンドは、追加された測定をすべてクリアします。

構文

DPOPWR:CLEARALLMeas
例

DPOPWR:CLEARALLMeas は、追加されたすべての測定をクリアします。

DPOPWR:CLEARALLPlots
このクリア専用コマンドは、追加されたプロットをすべてクリアします。

構文

DPOPWR:CLEARALLPlots
例

DPOPWR:CLEARALLPlots は、追加されたすべてのプロットをクリアします。

DPOPWR:FREerun
この設定専用コマンドは、測定リストでの連続実行を開始します。

構文

DPOPWR:FREerun
例

DPOPWR:FREerun は、測定リストでの連続実行を開始します。
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DPOPWR:GENREPAS
レポートを作成し、指定した文字列のファイル名で保存します。

構文

DPOPWR:GENREPAS <String>
引数

<String> はレポートに指定するファイル名です。引数は二重引用符で囲む必要
があります。ファイル名の最大文字数は 240 で、"、<、>、|、#、*、? は使用できま
せん。

出力

*.MHTML フォーマットのレポートが生成されます。

例

DPOPWR:GENREPAS "SwitchingLossPFC" は、レポートを作成して、
SwitchingLossPFC.MHTML というファイルに保存します。

DPOPWR:GENREPort
実行済みの測定リストに関するレポートを生成し、開きます。

構文

DPOPWR:GENREPort
例

DPOPWR:GENREPort は、実行済みの測定リストに関するレポートを生成し、開
きます。

 GPIB コマンド
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DPOPWR:LASTError?
この問い合わせ専用コマンドは直前に発生したエラーを返します。

構文

DPOPWR:LASTError?
出力

直前に発生したエラーのエラー・コードと説明を返します。

例

DPOPWR:LASTError? は、直前に発生したエラーを問い合わせます。

DPOPWR:MEAS(x):ACCMAx?
測定の累積最大値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCMAx?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果の最大値を返します。

例

DPOPWR:MEAS2:ACCMAx? は、追加されたリストの 2 番目の測定について、
累積結果の最大値を問い合わせます。
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DPOPWR:MEAS(x):ACCMEAn?
測定の累積平均値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCMEAn?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果の平均値を返します。

例

DPOPWR:MEAS2:ACCMEAn? は、追加されたリストの 2 番目の測定につい
て、累積結果の平均値を問い合わせます。

DPOPWR:MEAS(x):ACCMIn?
測定の累積最小値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCMIn?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果の最小値を返します。

例

DPOPWR:MEAS2:ACCMIn? は、追加されたリストの 2 番目の測定について、
累積結果の最小値を問い合わせます。

 GPIB コマンド
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DPOPWR:MEAS(x):ACCPKTopk?
測定の累積ピーク・ピーク値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCPKTopk?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果のピーク・ピーク値を返します。

例

DPOPWR:MEAS2:ACCPKTopk? は、追加されたリストの 2 番目の測定につい
て、累積結果のピーク・ピーク値を問い合わせます。

DPOPWR:MEAS(x):ACCPOPulation?
測定の累積母集団値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCPOPulation?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果の母集団値を返します。

例

DPOPWR:MEAS2:ACCPOPulation? は、追加されたリストの 2 番目の測定につ
いて、累積結果の母集団値を問い合わせます。
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DPOPWR:MEAS(x):ACCResult?
測定の累積ステータス値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCResult?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

Success または Fail
例

DPOPWR:MEAS2:ACCResult? は、追加されたリストの 2 番目の測定につい
て、累積結果のステータスを問い合わせます。

DPOPWR:MEAS(x):ACCSTDdev?
測定の累積標準偏差値を問い合わせます。

構文

DPOPWR:MEAS<x>:ACCSTDdev?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の累積結果の標準偏差値を返します。

例

DPOPWR:MEAS2:ACCSTDdev? は、追加されたリストの 2 番目の測定につい
て、累積結果の標準偏差値を問い合わせます。
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DPOPWR:MEAS(x):ACQmode
アクイジション・モードを問い合わせるか、または Sample、Hi Res、または

Average のいずれかに設定します。

構文

DPOPWR:MEAS<x>:ACQmode?

DPOPWR:MEAS<x>:ACQmode {SAMple | HIRes | AVErage}

引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

SAMple：アクイジション・モードを Sample に設定

HIRes：アクイジション・モードを Hi-Res に設定

AVErage：アクイジション・モードを Average に設定

出力

測定に設定されているアクイジション・モードを返します。

例

DPOPWR:MEAS2:ACQmode HIR は、追加されたすべての測定のアクイジショ
ン・モードを Hi Res に設定します。

DPOPWR:MEAS3:ACQmode? は、追加されたすべての測定に設定されている
アクイジション・モードを問い合わせます。

DPOPWR:MEAS(x):ADDPLOT
この設定専用コマンドは、プロットを測定に追加します。

構文

DPOPWR:MEAS<x>:ADDPLOT {SWITCHINGLOSS | TIMEtrend | RISEedge
| FALLEdge | HISTogram | POWERTIMEtrend | ENErgytimetrend | BARgraph |
SPECTrum | INDUctanceplot | BHPlot | IVPlot}

引数 UI 名 説明

SWITCHINGLOSS スイッチング ON/OFF
曲線

アクイジションのすべての ON/OFF サイク

ルを対象としたスイッチング電圧対電流波
形の曲線プロット。

TIMEtrend タイム・トレンド 測定対時間の波形トレース。各測定値は
測定が行われた時間に正確に配置されま
す。

RISEedge 立上りエッジ - タイ

ム・トレンド

di/dt および dv/dt 測定の立上りエッジのタイ

ム・トレンド・プロット。

FALLEdge 立下がりエッジ - タイ

ム・トレンド

di/dt および dv/dt 測定の立下りエッジのタイ

ム・トレンド・プロット。

HISTogram ヒストグラム 水平軸は測定値、垂直軸はそれぞれの値
が測定された回数を表します。
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引数 UI 名 説明

POWERTIMEtrend 電力波形（V*I） 電力（V*I）波形の対時間のプロットです。

ENErgytimetrend

エネルギー

波形

エネルギー波形のプロットは、V * I の積分

です。

BARgraph 高調波のバー・グラ
フ

X 軸は高調波の番号を表し、Y 軸は高調

波の値を dB または RMS で表します。

SPECTrum スペクトラム 周波数領域のプロットで、Y 軸は X 軸の周

波数成分の振幅を dB/RMS で表します。

INDUctanceplot インダクタンス曲線 同一回路（自己誘導）または隣接する回路
（相互誘導）での電流の変化によって引き
起こされた起電力で表された電気回路の
特性。ヘンリーという単位で表され、時系
列でプロットされます。

BHPlot BH 曲線 磁性材料の BH プロットは、Y 軸の最大磁

束密度（B）と X 軸の磁界強度（H）の関係

として表されます。

IVPlot

例

DPOPWR:MEAS2:ADDPLOT SWITCHINGLOS は、追加されたリストの 2 番
目の測定にスイッチング・ロス・プロットを追加します。

NOTE. 測定機能で指定したプロットがサポートされている場合にのみ、プロット
の追加が成功します。測定機能とプロットの相関関係については、ここをクリック
してください。

 GPIB コマンド

拡張電源解析 219



DPOPWR:MEAS(x):AUTOZero
この設定専用コマンドは、プローブの入力信号が存在しないときに、DC オフセ

ットを削除します。

構文

DPOPWR:MEAS<x>:AUTOZero
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

例

DPOPWR:MEAS2:AUTOZero は設定専用コマンドで、追加されたリストの 2 番
目の測定の DC オフセットを削除します。

DPOPWR:MEAS(x):BWLimit
帯域幅を問い合わせます。または、20 MHz、250 MHz、または Full のいずれか

に設定します。

構文

DPOPWR:MEAS<x>:BWLimit?

DPOPWR:MEAS<x>:BWLimit BWL20MHz

DPOPWR:MEAS<x>:BWLimit BWL250MHz

DPOPWR:MEAS<x>:BWLimit Full
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

BWL20MHz：帯域幅制限を 20MHz に設定

BWL20MHz：帯域幅制限を 250 MHz に設定

Full：帯域幅制限をスコープでサポートされている最大値に設定

出力

測定に設定されている帯域幅制限値を返します。

例

DPOPWR:MEAS2:BWLimit BWL20MHz は、追加されたすべての測定の帯域
幅制限を 20 MHz に設定します。

DPOPWR:MEAS3:BWLimit? は、追加されたすべての測定に設定されている
帯域幅制限値を問い合わせます。
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DPOPWR:MEAS(x):COUPling
カップリングを問い合わせるか、あるいは AC または DC に設定します。

構文

DPOPWR:MEAS<x>:COUPling?

DPOPWR:MEAS<x>:COUPling {AC | DC}
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

{AC | DC} は信号カップリング・タイプを AC または DC に設定します。

出力

測定の信号カップリング・タイプを返します。

例

DPOPWR:MEAS2:COUPling DC は、追加されたすべての信号カップリング・タ
イプを DC に設定します。

DPOPWR:MEAS3:COUPling? は、追加されたすべての測定の信号カップリン
グ・タイプを問い合わせます。

DPOPWR:MEAS(x):CURGATing
カーソル・ゲートのステータスを問い合わせるか、あるいは On または Off に設

定します。

構文

DPOPWR:MEAS<x>:CURGATing?

DPOPWR:MEAS<x>:CURGATing {ON | OFF}
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

{ON | OFF} はカーソル・ゲートをオンまたはオフに設定します。

出力

測定のカーソル・ゲートのステータスを返します。

例

DPOPWR:MEAS2:CURGATing ON は、追加されたすべての測定のカーソル・
ゲートを On に設定します。

DPOPWR:MEAS3:CURGATing? は、追加されたすべての測定のカーソル・ゲ
ートのステータスを問い合わせます。
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DPOPWR:MEAS(x):CURRENTMAx?
測定の現在の結果の最大値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTMAx?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果の最大値を返します。

例

DPOPWR:MEAS2:CURRENTMAx? は、追加されたリストの 2 番目の測定につ
いて、現在の結果の最大値を問い合わせます。

DPOPWR:MEAS(x):CURRENTMEAn?
測定の現在の結果の平均値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTMEAn?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果の平均値を返します。

例

DPOPWR:MEAS2:CURRENTMEAn? は、追加されたリストの 2 番目の測定に
ついて、現在の結果の平均値を問い合わせます。
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DPOPWR:MEAS(x):CURRENTMIn?
測定の現在の結果の最小値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTMIn?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果の最小値を返します。

例

DPOPWR:MEAS2:CURRENTMIn? は、追加されたリストの 2 番目の測定につ
いて、現在の結果の最小値を問い合わせます。

DPOPWR:MEAS(x):CURRENTPKTopk?
測定の現在のピーク・ピーク値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTPKTopk?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果のピーク・ピーク値を返します。

例

DPOPWR:MEAS2:CURRENTPKTopk? は、追加されたリストの 2 番目の測定
について、現在の結果のピーク・ピーク値を問い合わせます。
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DPOPWR:MEAS(x):CURRENTPOPulation?
測定の現在の結果の母集団値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTPOPulation?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果の母集団値を返します。

例

DPOPWR:MEAS2:CURRENTPOPulation? は、追加されたリストの 2 番目の測
定について、現在の結果の母集団値を問い合わせます。

DPOPWR:MEAS(x):CURRENTResult?
測定の現在の結果のステータス値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTResult?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

Success または Fail
例

DPOPWR:MEAS2:CURRENTResult? は、追加されたリストの 2 番目の測定に
ついて、現在の結果のステータスを問い合わせます。
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DPOPWR:MEAS(x):CURRENTSTDdev?
測定の現在の結果の標準偏差値を問い合わせます。

構文

DPOPWR:MEAS<x>:CURRENTSTDdev?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定の現在の結果の標準偏差値を返します。

例

DPOPWR:MEAS2:CURRENTSTDdev? は、追加されたリストの 2 番目の測定
について、現在の結果の標準偏差値を問い合わせます。

DPOPWR:MEAS(x):CUSTomname?
テーブルの測定インスタンス名を問い合わせます。このコマンドは、同一測定の
複数のインスタンスが追加されているときに役に立ちます。

構文

DPOPWR:MEAS<x>:CUSTomname?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定のインスタンス名および番号

例

DPOPWR:MEAS2:CUSTomname? は、リストの 2 番目にある測定の測定インス
タンスを問い合わせます。たとえば、リストの 2 番目にある測定が Switching
Loss1 であれば、出力は Switching Loss1 になります。
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DPOPWR:MEAS(x):DEGauss
この設定専用コマンドは、電流プローブに対して消磁を実行します。

構文

DPOPWR:MEAS<x>:DEGauss
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

例

DPOPWR:MEAS2:DEGauss は設定専用コマンドで、追加されたリストの 2 番目
の測定で電流プローブに対して消磁を実行します。

DPOPWR:MEAS(x):GATESOURce
選択した測定のソースを問い合わせるか、または設定します。

構文

DPOPWR:MEAS<x>:GATESOURce?

DPOPWR:MEAS<x>:GATESOURce <source>
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

<source> = CH1、CH2、CH3、CH4、MATH1、MATH2、MATH3、MATH4、
REF1、REF2、REF3、REF4
出力

測定のゲート・ソースのチャンネルを返します。

例

DPOPWR:MEAS3:GATESOURce CH1 は、追加されたリストの 3 番目の測定に
対して、ゲート・ソースのチャンネルを設定します。

DPOPWR:MEAS2:GATESOURce? は、追加されたリストの 2 番目の測定につ
いて、ゲート・ソースのチャンネルを問い合わせます。
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DPOPWR:MEAS(x):ISOURce
選択した測定の電流ソースを問い合わせるか、または設定します。

構文

DPOPWR:MEAS<x>:ISOURce?

DPOPWR:MEAS<x>:ISOURce <source>
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

<source> = CH1、CH2、CH3、CH4、MATH1、MATH2、MATH3、MATH4、
REF1、REF2、REF3、REF4
出力

測定の電流ソースのチャンネルを返します。

例

DPOPWR:MEAS3:ISOURce CH1 は、追加されたリストの 3 番目の測定に対し
て、電流ソースのチャンネルを設定します。

DPOPWR:MEAS2:ISOURce? は、追加されたリストの 2 番目の測定について、
電流ソースのチャンネルを問い合わせます。

DPOPWR:MEAS(x):NAMe?
追加されたリストの測定項目名を問い合わせます。

構文

DPOPWR:MEAS<x>:NAMe?
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

出力

測定項目名

例

DPOPWR:MEAS3:NAMe? は、追加されたリストの 3 番目の測定の測定項目名
をを問い合わせます。たとえば、リストの 3 番目にある測定が Switching Loss1
であれば、出力は Switching Loss になります。
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DPOPWR:MEAS(x):SELectmeas
測定が追加されたリストからインスタンスを選択します。

構文

DPOPWR:MEAS<x>:SELectmeas
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

例

DPOPWR:MEAS1:SELectmeas は、測定が追加されたリストの最初の測定を選
択します。

DPOPWR:MEAS(x):SOURCEAPPLYAll
この設定専用コマンドは、測定 <x> のソース設定を、追加されたリストのすべて

の測定に適用します。

構文

DPOPWR:MEAS<x>:SOURCEAPPLYAll
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

例

DPOPWR:MEAS1:SOURCEAPPLYAll は、追加されたリストのすべての測定
に、測定 1 ソース設定を提供します。
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DPOPWR:MEAS(x):SOURCEAutoset
測定のソース・オートセットを問い合わせるか、または設定します。

構文

DPOPWR:MEAS<x>:SOURCEAutoset?

DPOPWR:MEAS<x>:SOURCEAutoset {VERTical | HORizontal | Both |
UNDO}
入力

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

VERTical：ソース・オートセットの設定（垂直軸）

HORizontal：ソース・オートセットの設定（水平軸）

Both：ソース・オートセットの設定（垂直軸および水平軸）

UNDO：ソース・オートセット設定の削除

出力

測定のソース・オートセットの設定を返します。

例

DPOPWR:MEAS2:SOURCEAutoset VERTical は、追加されたリストの 2 番目
の測定に対して、垂直軸のソース・オートセットを設定します。

DPOPWR:MEAS3:SOURCEAutoset? は、追加されたリストの 3 番目の測定に
ついて、ソース・オートセットの設定を問い合わせます。

注： ソース・オートセットはスコープのスケールを設定します。これは、リストに追
加されるすべての機能に対して有効な機能です。
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DPOPWR:MEAS(x):VSOURce
測定の電圧ソースのチャンネルを問い合わせるか、または設定します。

構文

DPOPWR:MEAS<x>:VSOURce?

DPOPWR:MEAS<x>:VSOURce <source>
引数

<x> は測定行番号を指定します。指定可能な値は 1 ～ 10 の範囲です。

<source> = CH1、CH2、CH3、CH4、MATH1、MATH2、MATH3、MATH4、
REF1、REF2、REF3、REF4
出力

測定の電圧ソースのチャンネルを返します。

例

DPOPWR:MEAS3:VSOURce CH1 は、追加されたリストの 3 番目の測定に対し
て、電圧ソースのチャンネルを設定します。

DPOPWR:MEAS2:VSOURce? は、追加されたリストの 2 番目の測定について、
電圧ソースのチャンネルを問い合わせます。

DPOPWR:OPC?
最後に実行された操作が完了したかどうかを問い合わせます。

構文 DPOPWR:OPC?

出力 最後に実行した操作が完了している場合には 1、完了していない場合には 0 を
返します。
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例 DPOPWR:OPC? は、最後に実行した操作が完了したかどうかを問い合わせま
す。

DPOPWR:RECalc
現在のアクイジションで選択された測定を実行します

構文

DPOPWR:RECalc
例

DPOPWR:RECalc は、取り込まれた波形についてリストの測定の結果を再計算
します。

DPOPWR:SELECTEDMeas?
この問い合わせコマンドは、選択された測定に関する情報を表示します。

構文

DPOPWR:SELECTEDMeas?
出力

選択された測定の名前を返します。

例

DPOPWR:SELECTEDMeas? は、選択された測定の名前を返します。
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DPOPWR:SINgle
追加された測定のリストに対して、Single モードで測定を実行します。

構文

DPOPWR:SINgle
例

DPOPWR:SINgle は、測定のリストに対して Single モードで測定を実行します。

DPOPWR:Stop
この設定専用コマンドは、測定リストに対する連続実行を停止します。

構文

DPOPWR:Stop
例

DPOPWR:Stop は、測定リストでの連続実行を停止します。

DPOPWR:VERsion?
インストールされている拡張電源解析アプリケーションのバージョン番号を問い
合わせます。

構文 DPOPWR:VERsion?

出力 インストールされている拡張電力解析アプリケーションのバージョン番号を返し
ます。
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リファレンス

DPOPWR のエラー・コード

エラー・コード エラー・メッセージ 説明 一般的な対処

800 Selected point is not
valid.

単体試験により発生
するエラー。

単体試験により解決
されるエラー。

1000 To avoid potential
shock while using " +
DPOPowerConstants.A
pplicationLongName +
" application, use only
appropriately rated
voltage and current
probes, accessories
and other
equipment.Refer to
manufacturer's
documentation for each
product.

プローブが動作状態
であることを確認し
ます。

プローブが動作状態
であることを確認し
ます。

1001 The maximum number
of MATH dependent
measurements has
been reached.

測定を表示または入
力するために、すべ
ての演算チャネルが
消費されました。

他の測定を実行する
には、少なくとも 1 つ
の演算依存測定を
削除してください。

1002 Mismatch in
measurements group
detected.Press Yes to
clear the list and add
the new
measurement.Press No
to return without any
modification.

SOA X-Y (DPX)、Turn
On Time などの測定

および同様の測定
は、独自のオートセ
ットを必要とするた
め、他の測定と一緒
に実行することはで
きません。

他の測定を実行する
には、これらの測定
をリストから削除して
ください。Yes をクリッ

クすると、リストがク
リアされ、新規の測
定が追加されます。
No をクリックすると、

古い測定が保持さ
れます。

1003 Conflict in selection of
Math Input and
Destination in
<Measurement Name>.

Math が入力と出力

の両方に設定されて
いる測定では、選択
した Math チャネルに

競合が存在してはな
りません。

Math 入出力の保存

先の 1 つを変更し

て、測定を継続しま
す。

1004 Empty waveform. 取り込まれた波形に
サンプルが含まれて
いません。

選択したチャネルに
有効な信号を接続
し、デバイスをオン
にします。
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1005 Conflict in selection of
output sources.

Turn On Time 測定で

は、3 つの出力ソー

スを選択できます。
それらのうち 2 つが

同じである場合に、
このエラーが表示さ
れます。

Turn On Time の 3 つ
の出力すべてに異
なるチャネルを選択
してください。

1006 Conflict in selection of
input and output
sources.

Turn On Time 測定で

は、1 つの入力と最

大 3 つの出力ソース

を選択できます。入
力ソース・チャネル
が出力ソース・チャ
ネルのいずれかと一
致する場合、このエ
ラーが表示されま
す。

選択した出力チャネ
ルのいずれとも異な
る入力チャネルを選
択してください。

1007 Cannot select Live and
Ref sources together in
<Measurement Name>.

ソース OCW では、

特定の測定用に、
Ref ソースと Live ソー

スの両方を入力とし
て選択することはで
きません。競合が発
生している測定は、
エラー・メッセージの
最後に記載されま
す。

両方のチャネルで
Ref または Live のい

ずれかを選択してく
ださい。

1008 Conflict in selection of
sources in
<Measurement Name>.

このエラーは、
Magnetic Property の
二次コイルなどの、
設定パネルからソー
スを設定できる任意
の測定で競合が発
生している場合に生
成されます。

Magnetic Property の
一次ソースと二次ソ
ースでは異なるチャ
ネルを選択してくだ
さい。

1009 Cannot select Ref as
Input source and Live
as Output source.

Turn On Time 測定

で、Ref が入力ソー

ス、Live が出力ソー

スに選択されていま
す。

入力と出力の両方
に Ref を選択する

か、入力と出力の両
方に Live を選択して

ください。

1010 Please disconnect
probes on <Channel(s)
Name> and click Ok to
continue.

プローブが切断さ
れ、OK がクリックさ

れるまで実行を停止
することを示す、消
磁前に表示されるメ
ッセージです。

プローブを切断し、
OK をクリックして消

磁手順を続行してく
ださい。

1011 DeGauss Done,
reconnect the probes.

消磁が完了しまし
た。

プローブを再度接続
してください。
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1012 Positive and/or
negative clipping
detected.Please check
the device and run
again.

波形に正または負
のクリッピングが含
まれており、測定を
実行できません。

垂直軸スケールが
適切に設定されてい
て、デバイスが適切
に動作していること
を確認してください。

1013 Conflict in selection of
Math destinations in
<Measurement Name>.

スイッチング・ロスお
よびハイパワー・ファ
インダにおいて、異
なるチャネルで実行
されている場合、出
力用に設定されてい
る演算の保存先が
同じです。

選択されている測定
のいずれかで、出力
の演算の保存先を
変更してください。

1014 カーソルを必要な位
置に設定します。継
続するには Yes を押

します。処理を停止
するには No を押し

ます。

測定を継続する前に
カーソルを設定する
必要があります。

カーソルを必要な位
置に設定します。継
続するには Yes を押

します。処理を停止
するには No を押し

ます。

1015 Degauss hasn't been
done.Please Degauss
before autoset.

接続されている電流
プローブを消磁しな
いまま、オートセット
が実行されていま
す。これにより、オー
トセット処理は停止
します。

電流プローブを最初
に消磁してから、オ
ートセット・メソッドの
いずれかをクリックし
てください。

1016 Degauss Failed. 電流プローブの顎部
が開いているか、あ
るいは電力が流れ
ているプローブ・ポイ
ントに接続されたま
まです。

顎部を適切に閉じる
かプローブ・ポイント
から電流プローブを
外すか（またはその
両方）してください。

1017 SOA is a plot
dependent
measurement and the
maximum number of
plots has been
reached.Please clear a
measurement or a plot
and then add the SOA
measurement for
analysis.

最大 4 つのプロット

をプロット・リストに
追加できますが、
SOA はプロットに依

存した測定であるた
め、一度に実行でき
る SOA のインスタン

スは最大 4 つです。

プロットでその他の
測定を実行するに
は、少なくとも 1 つの

SOA 測定を有効リス

トから削除してくださ
い。

1018 Unable to acquire the
waveform.Run the
measurement again.

波形をトリガして取り
込むことができませ
ん。

トリガ・レベルを適切
に設定し、有効な信
号をプローブに接続
し、測定を再度実行
してください。
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1019 Magnetic Property
cannot be analyzed
with other
measurements with
More windings
configuration.

複数コイルの設定を
使用した場合、実行
できる磁気特性のイ
ンスタンスは 1 つだ

けです。また、この
場合に他の測定とグ
ループ化することは
できません。

複数コイルの設定だ
けで磁気特性を実
行するか、2 つ/1 つ
のコイルに設定を変
更してから他の測定
と一緒に実行してく
ださい。

1020 The maximum number
of Current Harmonics
or Total Power Quality
measurements has
been reached.

電流高調波および
電源品質測定で一
度に使用できるのは
1 つのインスタンス

のみです。

電流高調波および
全体の電源品質測
定では、一度に 1 つ
のインスタンスのみ
を選択してください。

1021 Unable to Degauss
probe on
<ChannelName>.

消磁に時間がかかり
すぎています。プロ
ーブが故障している
と考えられます。

プローブを確認し
て、故障している場
合には動作するプロ
ーブと交換してくださ
い。

1022 No Data available to
plot in
<MeasurementName>.
Check the waveform(s)
and configurations and
then re-run the
measurement.

アクイジションが故
障または測定（また
はその両方）が失敗
している可能性があ
ります。

再度取り込み、適切
な設定で測定を再実
行してください。
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1023 No ON cycle data
available to
plotting.Check the
waveform(s) and then
re-run the
measurement.

波形の選択領域に
ON サイクルがありま

せん (カーソル・ゲー

トがオンになってい
て、波形の狭い領域
が選択されている場
合に発生します)。ま
たは、アプリケーショ
ンのグローバル・パ
ラメータでカップリン
グが AC に設定され

ているときにも発生
します。

少なくとも 1 つの ON
サイクルが選択され
るようにスケールを
調整して、測定に戻
ります。または、DC
除去が行われたとき
に、電圧と電流がど
ちらも負になること
がないように、アプリ
ケーションのグロー
バル・パラメータのカ
ップリングをチェック
して、適切なカップリ
ングが設定されてい
ることを確認します。
カップリングを DC に
設定し、オートセット
を実行します。

1024 No OFF cycle data
available to
plotting.Check the
waveform(s) and then
re-run the
measurement.

波形の選択領域に
OFF サイクルがあり

ません（カーソル・ゲ
ートがオンになって
いて、波形の狭い領
域が選択されている
場合に発生しま
す）。

少なくとも 1 つの

OFF サイクルを持つ

ようにスケールを調
整し、測定を再実行
してください。
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エラー・コード エラー・メッセージ 説明 一般的な対処

1700 Unable to perform
computation on the
waveform data. Source
waveforms have
different time/div
settings.

電圧波形と電流波
形の時間／div 設定

が異なります。

同時に取り込まれた
電圧波形と電流波
形を使用して、選択
した測定を実行しま
す。

1701 Unable to perform
computation on the
waveform data. Source
waveforms have
different record lengths.

電圧波形と電流波
形のレコード長が異
なります。

同時に取り込まれ、
同じレコード長を持
つ電圧波形と電流
波形を使用して、選
択した測定を実行し
ます。

1702 Higher sample rate is
required for accurate
measurement.

選択された波形の時
間／div 設定が高す

ぎます。または、サ
ンプリング・レートが
低すぎます。

オシロスコープのメ
ニュー・バーで、
Horiz/Acq > Horizontal/
Acquisition Setup をク

リックします。
Horizontal タブで、時

間軸の値を小さくす
るか、またはレコード
長の値を大きくしま
す。

1703 Ensure that at least one
complete cycle is
available for analysis.

指定されたレコード
長内で、信号に 1 つ
以上のサイクルがあ
りません。

オシロスコープの時
間／div 設定を小さく

して、サイクル数を
増やします。

1704 Ensure that the cycle
has more than
20 sample points.

サイクルに 20 を超

えるサンプル・ポイン
トが含まれているこ
とを確認してくださ
い。

レコード長の値を大
きくするか、またはオ
シロスコープの時間
／div 設定を小さくし

ます。

1705 Unable to get the
frequency value when
queried from the
oscilloscope.

サイクル全体が取得
できないため、周波
数を測定できませ
ん。

測定を再実行してく
ださい。
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1706 Insufficient edges for
the Modulation Analysis
measurement.

ソース波形で検出さ
れたエッジが不十分
です。測定を実行す
るには、少なくとも
2 つのエッジが必要

です。

1) 水平軸スケールを

小さくして、波形のサ
イクルが完全に取得
できるようにします。
2) 繰り返す性質の信

号を持つソースを選
択します。
3) エッジを検出する

ための信号の基準
レベルおよびヒステ
リシス・レベルを必
要なレベルに調整し
ます。

1707 The Ref Level value is
outside the voltage
range of the waveform.
Enter a proper Ref
Level value.

電圧レベルが波形
の遷移に適合しない
ため、遷移での波形
のエッジを検出でき
ません。

波形で遷移が発生し
ている基準レベル値
を入力します。ピー
ク・ツー・ピークの遷
移レベルの 50% の
レベルを入力しま
す。

1708 Unable to plot SOA
because of insufficient
data points.

プロットするための
十分なデータ・ポイ
ントがありません。

カーソル間に少なく
とも 2 つのデータ・ポ

イントが存在するよ
うに、波形上にカー
ソルを配置します。

1709 Change the time/div
setting to 10 ms/div.

電流高調波アルゴリ
ズム（IEC 規格）で

は、水平軸スケール
を 10 ms にする必要

があります。

オシロスコープのフ
ロント・パネルにある
ノブを使用して、水
平軸スケールを
10 ms に変更します。

1710 Incorrect record length. 電流高調波アルゴリ
ズム（IEC 規格）で

は、波形のレコード
長の値を 2,500 にす

る必要があります。

設定された時間軸に
おける利用可能なレ
コード長は、アクティ
ブなチャンネル数に
応じて異なります。
測定に必要のない
チャンネルをオフに
します。オシロスコー
プのメニュー・バー
で、Horiz/Acq >
Horizontal/Acquisition
Setup をクリックしま

す。Horizontal タブ

で、レコード長の値
を 2,500 に変更しま

す。
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1711 Calculated true power
is negative.

このエラーは、次の
場合に発生します。
1) 電流と電圧の極

性の方向が逆になっ
ている場合。2) 電流

が電圧に対して
90 度の位相シフトを

持っている場合。3)
信号の周波数が、高
調波測定で選択され
た入力周波数と等し
くない場合。

電流および電圧の
極性の方向が正し
いことを確認します。
信号の周波数と選
択された周波数が等
しいことを確認しま
す。

1712 Class D detected;
Harmonic limits will be
set to Class D.

Class A の装置が選

択されていますが、
Class D が検出され

ました。

Class D を設定して、

再度測定を実行しま
す。

1713 Class A detected;
Harmonic limits will be
set to Class A.

Class D の装置が選

択されていますが、
Class D が検出され

ませんでした。

Class A を設定して、

再度測定を実行しま
す。

1714 Set the horizontal scale
to 200 ms and the
record length value to
1 M.

電流高調波アルゴリ
ズム（MIL 規格）で

は、水平軸スケール
を 200 ms に、レコー

ド長の値を 1 M にす

る必要があります。

1) 要求された長さと

時間軸の組み合わ
せを設定できませ
ん。これは、設定さ
れた時間軸でどのよ
うなレコード長を使
用できるかは、アク
ティブなチャンネル
数によって決定され
るためです。2) 測定

に必要のないチャン
ネルをオフにしま
す。3) 水平軸スケー

ルを 200 ms に、レコ

ード長の値を 1 M に
変更します。
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1715 Set the horizontal scale
to 400 ms and the
record length value to
2 M.

電流高調波アルゴリ
ズム（MIL 規格）で

は、水平軸スケール
を 400 ms に、レコー

ド長の値を 2 M にす

る必要があります。

1) 要求された長さと

時間軸の組み合わ
せを設定できませ
ん。これは、設定さ
れた時間軸でどのよ
うなレコード長を使
用できるかは、アク
ティブなチャンネル
数によって決定され
るためです。2) 測定

に必要のないチャン
ネルをオフにしま
す。3) オシロスコー

プのフロント・パネル
を使用して、水平軸
スケールを 400 ms
に変更します。レコ
ード長の値を 2 M に
設定します。

1716 Set the horizontal scale
to 200 ms and the
record length value to
125000.

電流高調波アルゴリ
ズム（MIL 規格）で

は、水平軸スケール
を 200 ms に、レコー

ド長の値を
125,000 にする必要

があります。

水平軸スケールを
200 ms に、レコード

長の値を 125,000 に
変更します。

1717 Set the horizontal scale
to 400 ms and the
record length value to
1 M.

電流高調波アルゴリ
ズム（IEC A14 標準

規格）では、水平軸
スケールを 400 ms
に、レコード長の値
を 1 M にする必要が

あります。

水平軸スケールを
400 ms に、レコード

長の値を 1 M に変更

します。

1718 Set the horizontal scale
to 400 ms and the
record length value to
125000.

電流高調波アルゴリ
ズム（MIL 規格）で

は、水平軸スケール
を 400 ms に、レコー

ド長の値を
125,000 にする必要

があります。

水平軸スケールを
400 ms に、レコード

長の値を 125,000 に
変更します。

1719 Unable to calculate
harmonics for the
record length and
sampling rate
combination.

このレコード長とサ
ンプル・レートの組
み合わせでは、電流
高調波を実行できま
せん

水平軸スケールとレ
コード長の値を変更
します。
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1720 Calculated power is
more than 25 W. Set
the value greater than
25 W and enter the
power factor and input
current.

IEC 修正条項 14 で
は、Class C の装置

において電源が
25 W を超える場合

には、ユーザが力率
および入力電流を入
力することを要求し
ています。

25 W を超える電源を

入力し、電流および
力率の値を入力しま
す。

1721 Not enough samples
available for analysis.

スロープの計算に
は、少なくとも 3 つの

サンプルが必要で
す。

オシロスコープのメ
ニュー・バーで、
Horiz/Acq > Horizontal/
Acquisition Setup をク

リックします。
Horizontal タブで、レ

コード長の値を増や
します。

1722 Low level cannot be
greater than high level.

dv/dt のロー・レベル

をハイ・レベルよりも
大きくすることはでき
ません。

ロー・レベルがハイ・
レベルよりも小さくな
るようにレベルを入
力します。

1723 Levels entered are not
within the range of the
waveform.

電圧レベルが波形
の遷移に適合しない
ため、遷移での波形
のエッジを検出でき
ません。

波形で遷移が発生し
ている基準レベル電
圧を入力します。ピ
ーク・ツー・ピークの
遷移レベルの 50%
のレベルを入力しま
す。

1724 Oscilloscope settings
changed. Run the
measurements di/dt
and dv /dt again.

di/dt および dv/dt を実

行してエッジ解析を
行った後、垂直軸ま
たは水平軸の設定
を変更すると、オシ
ロスコープはプレビ
ュー・モードになりま
す。

di/dt および dv/dt の
結果を取得した後に
設定を変更しないで
ください。

1725 Unable to perform di/dt
for the configured
levels.

設定されたレベルが
エッジで検出されま
せん。カーソルは最
大 di/dt に配置されて

います。

レベルを再設定しま
す。測定を再実行し
てください。

1726 Unable to associate
cursor to the selected
data.

カーソルを、特定さ
れた電源のデータに
関連付けることがで
きません。

オシロスコープ設定
が変更されていま
す。測定を再実行し
てください。

1727 Unable to calculate dv /
dt for the configured
levels.

設定されたレベルが
エッジで検出されま
せん。

レベルを再設定しま
す。
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1728 Set the coupling to
1 M Ohm.

選択されたチャンネ
ル入力カップリング
は、50 Ω に設定され

ています。

DC ブロックが有効な

状態で、TCS-1M コン

バータを使用して測
定を実行します。次
に、DC ブロックが無

効な状態で測定を実
行します。オシロスコ
ープでカップリングを
1 M に変更します。

1729 Start frequency cannot
be more than or equal
to stop frequency.

入力された開始周波
数の値が、終了周波
数よりも大きくなって
います。

入力された開始周波
数の値が、終了周波
数よりも大きくなって
います。

1730 The frequency
resolution (sample rate/
record length) is more
than the stop
frequency.

指定したレコード長
とサンプリング・レー
トの組み合わせにお
ける信号の周波数
分解能が、終了周波
数成分よりも大きく
なっています。

レコード長を大きくす
るか、またはサンプ
リング・レートを小さ
くして、終了周波数
が周波数分解能より
も大きくなるように
し、再度測定を実行
します（周波数分解
能 = サンプリング・レ

ート / レコード長）。

1731 Configured sample rate
is less than twice the
stop frequency.

正確に解析を行い、
エイリアシングを防
止するためには、サ
ンプリング・レートを
終了周波数の 2 倍
以上にする必要が
あります。

サンプリング・レート
を大きくして、サンプ
リング・レートが終了
周波数の 2 倍以上

になるようにします。

1732 Frequency resolution
(sample rate/record
length) is larger than
the range of frequency.

指定したレコード長
とサンプリング・レー
トの組み合わせにお
ける信号の周波数
分解能が、解析する
周波数帯域よりも大
きくなっています。

終了周波数値を小さ
くして、レコード長お
よび時間軸を自動的
に設定するオートセ
ット・オプションを実
行または使用しま
す。

1733 1 M Coupling required;
DC block cannot be
performed.

DC ブロック操作に

は、50 Ω カップリング

が必要です。

カップリングを 1 Meg
に設定します。

1734 File path not available
to save the Spectral
Analysis plot.

プロットの保存のた
めに入力されたパス
が無効です。

有効なパス名を入力
します。

1735 The RBW value was
not updated. It will be
set to the maximum
value.

選択された開始周波
数、終了周波数、お
よびウィンドウ・タイ
プに対して RBW 値
が更新されていませ
ん。

開始周波数、終了周
波数、およびウィンド
ウ・タイプを選択した
後、測定を実行する
前に、RBW 値を更新

します。
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1736 The oscilloscope
settings have changed.
Cannot set the selected
RBW value.

選択された開始周波
数、終了周波数、お
よびウィンドウ・タイ
プに対して RBW 値
を更新した後、オシ
ロスコープの設定を
変更した可能性があ
ります。

開始周波数、終了周
波数、およびウィンド
ウ・タイプを選択した
後に RBW 値を更新

します。RBW 値を更

新した後は、オシロ
スコープの設定を変
更しないでください。

1737 The configured
frequency range is not
supported by the
spectral analysis
measurement.

選択された範囲にお
いて、スペクトラム解
析測定に利用できる
RBW 値がありませ

ん。

開始周波数の値を
大きくするか、また
は終了周波数の値
を小さくします。オー
トセットなしで実行す
るには、Options フィ

ールドで Auto Setup
チェック・ボックスを
オフにします。

1738 Timing synchronization
of the previously
acquired waveform is
not matching the
current acquisition.

波形が同時に取り込
まれなかった場合
も、結果の計算では
タイム・ドメインの同
期が重要となりま
す。

以前に取り込まれた
波形と現在の波形
について、特定のト
リガ・レベル、トリガ
位置、およびカーソ
ル位置に関する同
期がチェックされま
す。これらの設定は
変更しないでくださ
い。変更すると、同
期が失われます。再
度磁気特性測定を
実行します。

1739 Number of data points
in a cycle is less than
10.

特定のサイクル内の
データ・ポイント数が
10 未満です。エッ

ジ・ソースを正しく識
別するためには、ヒ
ステリシス・レベルお
よび基準レベルを大
きくします。

磁気コンポーネント
の電圧波形でより多
くのリンギングが発
生している場合は、
エッジ・ソースとして
スイッチング・デバイ
ス・ゲート波形を使
用します。
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1740 Not enough samples
for correct calculation
of the DC flux density
to position the
Hysteresis curve on the
plot.

磁束密度の DC 値の

計算に使用できるデ
ータ・ポイント数が不
足しています。次の
場合があります。1)
指定されたサイクル
内のデータ・ポイント
数が不足していま
す。2) 指定された整

数サイクルにおい
て、サイクル数よりも
データ・ポイント数が
少なくなっています。

1) エッジ・ソースとし

て電流ソースを使用
している場合は、電
流波形の目盛の数
を多くします。
2) 電流波形にノイズ

が多い場合は、ハイ
レゾ・モードを使用し
てノイズを除去しま
す。
3) エッジおよび整数

サイクルを正しく特
定できるように、ヒス
テリシス・レベルを大
きくし、基準レベルを
調整します。

1741 Amplitude of each cycle
is improper for
computation.

信号の振幅が非常
に小さくなっていま
す。

電圧および電流チャ
ンネルの垂直軸スケ
ールを小さくします。

1742 The calculated skew
value is more than the
oscilloscope deskew
range.

計算されたスキュー
が、オシロスコープ
のデスキュー範囲よ
りも大きくなっていま
す。そのため、デス
キューは範囲の最
大値で実行されま
す。

デスキューは、オシ
ロスコープに適用可
能な最大デスキュー
値に対して実行され
ます。

1743 Edges on the waveform
are lesser than the
number of edges
configured. Number of
edges set by the user
to deskew is not
available on the
waveform.

設定されたエッジ数
の値が波形に見つ
かりません。

波形内のエッジ数、
および数値入力表
示が同じであること
を確認します。水平
軸スケールを調整し
て、デスキューを調
整するために必要な
遷移の数を大きくし
ます。

1744 Edges on the waveform
are more than the
required number of
edges for internal
deskew.

内部デスキューで
は、デスキューの波
形にエッジが 1 つだ

け存在することが想
定されています。

波形または設定が
誤っている可能性が
あります。正確に接
続するには、オンラ
イン・ヘルプの「プロ
ーブとチャンネルの
デスキュー」の項の
手順に従います。

1745 (Hysteresis Level/2 +
Ref Level) cannot be
more than 100 percent
of the maximum signal
level.

エッジ検出用レベル
が信号の最大レベ
ルを超えています。

基準レベルおよびヒ
ステリシス・レベルを
調整して、パーセン
テージでの信号の最
大レベルを超えない
ようにします。
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1746 Error in copying the
delays.txt file.

静的なデスキュー測
定を実行するための
ファイルが破損して
います。

正しいデスキュー・フ
ァイルを使用してア
プリケーションを再
起動します。

1747 Unable to find the
required edges.
Reacquire waveform.

次の理由で、波形に
おいて必要なエッジ
を検出できません。
1) 信号のノイズが多

いため 2) ヒステリシ

ス帯のレベルが低い
ため 3) オシロスコー

プがプレビュー・モー
ドであるため 4) この

エラーは、レコード長
が小さいためにサン
プル数が少なくなっ
ていることも示してい
ます。

信号にノイズが多す
ぎる場合は、サンプ
ル・モードではなくア
ベレージ・モードを有
効にして信号を取り
込みます。これによ
り、信号のジッタが
減少し、信号が滑ら
かになります。アプリ
ケーションでヒステリ
シス帯のレベルを大
きくして、信号のノイ
ズを補正します。

1748 Number of sample
points available for
analysis during Ton or
Toff is zero.

レコード長が短いた
めに、Ton または Toff
中に存在するサンプ
ル数がゼロになり、
スイッチングごとに
計算されるスイッチ
ング周波数を計算す
ると無限大になって
います。

レコード長の値を大
きくして、再度測定を
実行します。各スイ
ッチングの間に十分
なサンプルを格納で
きるように、レコード
長の値を大きくしま
す。

1749 Number of sample
points available for
analysis during Ton or
Toff should be more
than two.

電圧波形の電源オ
ンまたは電源オフ部
分の 10 ～ 90% の間

におけるサンプル数
が 2 未満である場合

は、警告メッセージ
が表示されます。

各スイッチングの間
に十分なサンプルを
格納できるように、レ
コード長の値を大き
くします。

1750 All three outputs are
OFF.Ensure that at
least one output is ON.

測定を実行する前
に、使用する出力の
状態をオン状態に設
定します。

少なくとも 1 つの出

力がオンに設定され
ていることを確認し
ます。

1751 The trigger voltage
cannot be set to more
than the maximum line
voltage.

トリガ電圧は、最大
ライン電圧より低く
設定する必要があり
ます。

最大ライン電圧レベ
ルより低いトリガ電
圧レベルを設定しま
す。
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1752 Calculated power loss
value is zero.One
complete switching ON
to ON cycle may not be
available or the
conduction portion of
the power signal may
be negative.Reacquire
with at least two
complete cycles.

電力損失の最小値
または最大値と平均
値は、次の条件下で
ゼロになることがあ
ります。1) 使用した

カップリングが AC の
場合。このとき、信
号は正にも負にもな
るため、電力損失の
計算値がゼロになる
可能性があります。
2) AC カップリングさ

れた電流信号と電圧
信号を乗算して電力
信号を求めた場合。
電力損失を計算する
ために電力信号の
積分が行われます
が、電力信号は正に
も負にもなるため、
ゼロ値が計算される
可能性があります。
3) プローブに DC オ
フセットがある場合。

使用したカップリング
が DC であることを

確認します。再び測
定を実行する前に、
使用したプローブの
DC オフセットを補正

する必要がありま
す。

1753 RDS ON or Vce(Sat) is
not Configured.The
calculated energy and
loss may not be
accurate.

この警告メッセージ
は、スイッチ電圧の
垂直軸スケールが
目盛あたり 10 V を超

えており、かつ、デ
バイス・パラメータ
RDS On または

Vce(SAT) が選択され

ていない場合に表示
されます。

デバイス・タイプ
MOSFET または

IGBT/BJT を選択し

て、それぞれのパラ
メータを入力します。

1754 合計損失および合
計エネルギーが計
算されていません。

合計損失および合
計エネルギーが計
算されていません。

エラー。
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1755 Multiple edges found in
a switching cycle, or
DC offset present in the
waveform.

このエラーは、次の
2 つの場合に表示さ

れます。1) 1 つのス

イッチング・サイクル
において複数のエッ
ジが検出された場
合。このことは、基準
レベルおよびヒステ
リシス・レベルが適
切でない場合に発生
します。2) 電圧およ

び電流プローブの
DC オフセットが適切

に補正されていない
ため、設定された
Ton および Toff レベ

ルが満たされない場
合。

電圧エッジ・ソース
のヒステリシス・レベ
ルを設定します。プ
ローブの DC オフセ

ットを削除して、再度
測定を実行します。

1756 The calculated edge at
(Ref Level ±/-
Hysteresis/2) is less
than the Ton and Toff
voltage level.

設定された Ton のレ

ベルおよび Toff のレ

ベルがエッジ（基準
レベル + ヒステリシ

ス /2）未満である場

合は、エラーが発生
します。

基準レベルの値とヒ
ステリシス・レベルを
2 で割った値の和

が、電圧波形の Ton
および Toff レベルよ

りも大きくなるように
設定して、再度測定
を実行します。

1757 The calculated edge at
(Ref Level ±
Hysteresis/2) is less
than Ton and Toff
current level.

設定された Ton のレ

ベルおよび Toff のレ

ベルがエッジ（基準
レベル + ヒステリシ

ス /2）未満である場

合は、エラーが発生
します。

基準レベルの値とヒ
ステリシス・レベルを
2 で割った値の和

が、電流波形の Ton
および Toff レベルよ

りも大きくなるように
設定して、再度測定
を実行します。

1758 The calculated edge at
(Ref Level ±
Hysteresis/2) is more
than 80 percent of the
gate voltage.

このエラーは、設定
されたエッジ（基準レ
ベル + ヒステリシス・

レベル /2）がゲート

電圧の 80% を超え

る場合に表示されま
す。

基準レベルの値とヒ
ステリシス・レベルを
2 で割った値の和

が、ゲート電圧の
80% 未満になるよう

に設定して、再度測
定を実行します。

1759 (Ref Level ±
Hysteresis/2) is more
than 100 percent.

このエラーは、エッジ
（基準レベル + ヒス

テリシス・レベル /2）
が 100% を超える場

合に表示されます。

基準レベルの値とヒ
ステリシス・レベルを
2 で割った値の和が

100% 未満になるよう

に設定して、再度測
定を実行します。
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1760 Failed to process the
waveform.

このエラーは、オシ
ロスコープで最大レ
ベルおよび最小レベ
ルを返すことができ
ない場合に表示され
ます。

測定を再実行してく
ださい。

1761 Switching loss and
energies in the result
can be zero.

このエラーは、ター
ン・オン時にスイッチ
電流にシャープなス
パイクが存在するこ
とによって発生する
場合があります。こ
のような場合に、ス
パイクの振幅が、ス
イッチ電流サイクル
の残りの部分よりも
大きくなることがあり
ます。これにより、I
レベルが影響を受
け、パーセントとして
設定された I レベル

が、最大スパイク電
流とパーセンテー
ジ・レベルの積として
絶対値に変換されま
す。

I レベルと V レベルを

確認し、測定を再度
実行します。

1762 The calculated
switching loss and
energy is zero.

ターン・オン時にスイ
ッチ電流にシャープ
なスパイクが存在す
るか、またはスパイ
クの振幅がスイッチ
電流サイクルの残り
の部分よりも大きく
なっている可能性が
あります。

I レベルと V レベルを

確認し、測定を再度
実行します。関連す
るコンポーネントの
寄生効果および大き
な電流ループが原
因でスパイクが発生
している可能性があ
ります。小さなルー
プを使用して電流を
測定し、小さなリード
を使用して電圧を測
定します。

1763 The number of samples
between the cursors is
less than two.

カーソルが不適切に
配置され、カーソル
間にサンプル・ポイ
ントがないことが原
因です。

カーソルを再配置し
て、再度測定を実行
します。
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1764 計算された合計損失
およびエネルギー
は、Ton 損失および

エネルギーと Toff 損
失およびエネルギー
の合計よりも低くな
っています。

計算された合計損失
およびエネルギー
は、Ton 損失および

エネルギーと Toff 損
失およびエネルギー
の合計よりも低くな
っています。

エラー。

1765 The number of samples
between the
consecutive edges is
less than ten. Increase
the sample rate and
use the HiRes
acquisition mode.

この警告は、1 つの

スイッチング・サイク
ルにおいて複数のエ
ッジが検出された場
合に表示されます。
スイッチ電圧にある
リンギングによって
複数のエッジが検出
されている可能性が
あります。

リンギング部分を回
避するようにエッジ・
レベルを設定して、
ヒステリシス帯を大
きくします。アクイジ
ション・モードとして
ハイレゾ・アクイジシ
ョン・モードを設定し
ます。

1766 Invalid data for
HiPower Finder results.

波形に十分なエッジ
がないか、または選
択した測定を正常に
実行するための波
形として適切ではあ
りません。

波形の水平軸スケ
ールを小さくするか、
またはレコード長の
値を大きくします。

1767 Switching Loss results
are Negative.これは、

使用される電圧プロ
ーブおよび電流プロ
ーブの DC オフセット

が原因である可能
性があります。これ
を回避するには、プ
ローブの DC オフセ

ットを補正して、アプ
リケーションを起動
する前にオシロスコ
ープで SPC（信号パ

ス補正）オプションを
実行します。

これは、使用される
電圧プローブおよび
電流プローブの DC
オフセットが原因で
ある可能性がありま
す。

これを回避するに
は、プローブの DC
オフセットを補正し
て、アプリケーション
を起動する前にオシ
ロスコープで SPC
（信号パス補正）オ
プションを実行しま
す。

1768 Inadequate acquisition
duration, increase the
record length and run
again.

このエラーは、選択
された周波数範囲よ
りも周波数解像度が
多い場合に表示され
ます。

より大きなレコード長
を指定して測定を再
実行してください。

1769 Select the appropriate
edge source (either
voltage or current
channel).

磁気特性で、エッジ・
ソースが電圧チャン
ネルまたは電流チャ
ンネルのどちらにも
設定されていませ
ん。

Source Configuration
パネルに進み、エッ
ジ・ソースを電圧チャ
ンネルまたは電流チ
ャンネルのいずれか
に設定します。
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1770 V(ce) cannot be
negative.Check the
coefficient values and
run the measurement
again.

Vce を計算するため

に係数を入力しまし
たが、Vce が負の値

になり、使用できなく
なりました。

係数の値を調べて、
Vce が正になるよう

に有効な値を入力し
てください。

1771 エッジ間に十分なサ
ンプルがありませ
ん。

エッジ間に十分なサ
ンプルがありませ
ん。

エッジ間に十分なサ
ンプルがありませ
ん。

1772 From and To Channels
are the same.

デスキューで選択さ
れている From およ

び To チャンネルが

同じです。

リアルタイム・デスキ
ューの出力元チャン
ネルと出力先チャン
ネルには異なるチャ
ンネルを選択してく
ださい。

1773 Too many edges in the
waveform.Only 1 edge
is required.

設定によると、デス
キューを実行するの
に必要なエッジは
1 つのみです。しか

し、取り込まれた波
形に存在するエッジ
が多すぎます。

1 つのエッジのみを

持つようにレコード
長を適切に設定し、
デスキューを再度実
行してください。

1774 The skew calculated is
more than the
oscilloscope
permissible value, so it
will be set to the
maximum.

計算されたスキュー
の数が、オシロスコ
ープでサポートされ
る数よりも多くなって
います。

有効な信号をチャネ
ルに接続してくださ
い。

1775 The skew calculated is
lower than the
oscilloscope
permissible value, so it
will be set to the
minimum.

計算されたスキュー
の数が、オシロスコ
ープでサポートされ
る数よりも少なくなっ
ています。

有効な信号をチャネ
ルに接続してくださ
い。

1776 Not enough samples
for current harmonics.

指定された数の高調
波および信号周波
数に十分なサンプル
がありません。

サンプルの数を増や
して、再度測定を実
行してください。

1777 Given current threshold
is not applicable for the
current waveform.

指定されたスレッシ
ョルドは、取り込まれ
た電流波形には適
用できません。

適切なスレッショルド
値を設定して、再度
測定を実行してくだ
さい。

1778 No peaks are found in
the selected region,
please change the
cursor position.

カーソルで選択され
た領域にはピークが
存在しません。

カーソル位置を調整
して、再度測定を実
行してください。

1779 No peaks are found in
the waveform, please
acquire again.

波形が適切でないた
め、ピークが存在し
ません。

波形を再度取り込
み、再度測定を実行
してください。
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1780 Low sampling rate,
please increase the
sampling rate and run
the measurement
again.

サンプリング・レー
ト・セットがスペクトラ
ム解析に十分では
ありません。

より高い値でサンプ
リング・レートを設定
して、再度測定を実
行してください。

1781 Waveform sampling
rate and/or record
length does not match.

電圧チャンネルおよ
び電流チャンネルの
サンプリング・レート
とレコード長が一致
しません。

両方のチャンネルで
レコード長とサンプリ
ング・レートが同じで
あることを確認し、再
度測定を実行してく
ださい。

1782 Insufficient number of
cycles.

電源品質測定に使
用できる完全なサイ
クルが存在しませ
ん。

少なくとも 1 つのサ

イクルを持つように
水平軸スケールを増
やし、測定を再実行
してください。

1783 Low record length,
please increase the
sampling rate and run
the measurement
again.

測定に十分な波形
のレコード長があり
ません。

レコード長を高めに
設定して、再度測定
を実行してください。

1784 Start frequency and
stop frequency can't be
the same.

Spectral analysis
Configuration パネル

で、開始と停止の周
波数が同じ値に設
定されています。こ
れは使用できませ
ん。

開始と停止の周波
数には異なる値を設
定してください。

1785 AutoSet
failed:Oscilloscope is
not responding, please
recall default setup and
run again.

オシロスコープが応
答していないため、
オートセットが失敗し
ました。

デフォルトのセットア
ップを呼び出して、
再度オートセットを
実行してください。

1786 基準レベルとヒステ
リシスを信号に適用
できません。

基準レベルとヒステ
リシスを信号に適用
できません。

レベルを変更し、再
度測定を実行してく
ださい。

1787 Autoset save
failed.Check system
drive accessibility.

オートセット・データ
を保存できません。

適切な権限でドライ
ブにアクセスできる
ことを確認してくださ
い。

1788 Autoset save failed. オートセット・データ
を保存できません。

再度オートセットして
ください。

1789 Recall Plot failed.The
plot does not match the
measurement.

呼び出し中のプロッ
トは、その特定の測
定には適用できませ
ん。

その測定に関連した
適切なプロットを呼
び出してください。
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1790 Autoset
failed:Incompatible
signal.

不適切な信号が原
因でオートセットが
失敗しました。これ
は、入力内のノイズ
が大きすぎるために
発生する場合があり
ます。

有効な信号をチャン
ネルに接続し、再度
オートセットを実行し
てください。

1791 Deskew performed
successfully.

デスキュー操作が完
了しました。

デスキュー操作が完
了しました。

1792 Autoset Error. それぞれのチャンネ
ルに接続されたプロ
ーブが、選択された
帯域幅またはカップ
リングをサポートして
いないため、選択さ
れたチャンネルのカ
ップリング/帯域幅を

オートセットで設定で
きませんでした。

グローバル設定パ
ネルから、適切なカ
ップリングまたは帯
域幅（またはその両
方）を選択してくださ
い。

1793 Autoset Completed オートセットが完了し
ました。

オートセットが完了し
ました。

1794 Selected resolution
bandwidth is not
applicable for input
waveform, display
results for available
resolution?

設定パネルから選
択した RBW は、波

形上の計算された
RBW と一致しませ

ん。

少なくとも水平オート
セットを一度実行し
てから、スペクトラム
測定を実行してくだ
さい。

1795 No edges found in the
waveform.Adjust the
waveform and rerun the
measurement.

取り込まれた波形に
エッジがありませ
ん。

少なくとも 1 つのエッ

ジを持つようにオシ
ロスコープの水平設
定を変更し、測定を
再実行してください。

1796 Negative capacitance
detected still showing
the result please
change ref levels and
run the measurement
again.

計算された平均キャ
パシタンス値が負で
す。

設定パネルから基
準レベルを変更し、
再度測定を実行して
ください。

1797 Do you want to
autoset?

このポップアップは、
デスキュー操作を実
行する前に表示され
ます。

これは Yes または

No のポップアップで

す。Yes をクリックし

た場合、オートセット
が実行され、デスキ
ューは続行します。
それ以外の場合は、
単にデスキューが実
行されます。
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1798 Unable to set the
calculated skew value
of ... value in scope
vertical De-skew, since
the Skew value is <
Sample
Interval.Increase the
sample Rate and adjust
the Record Length,
such that Sample
Interval is < " +
GetFormattedValue(sk
ewValue) + "\n The
skew value has been
set to " +
GetFormattedValue(set
Value) + " by scope".

計算されたスキュー
値がサンプリング間
隔よりも低くなってい
ます。

サンプリング間隔が
スキュー値よりも低く
なるようにサンプリン
グ・レートを増やして
ください。

1800 Turn on the device
now.

シーケンサはター
ン・オン・タイム測定
の信号を取り込むた
めに待機中です。

装置の電源をオンに
して OK をクリックし

てください。

1801 Unable to find edges
for the region
selected.Adjust the ref
levels or change the
cursor positions and re-
rerun the
measurement.

波形の選択領域に
エッジがありませ
ん。カーソルが互い
に近すぎるか、ある
いは波形にエッジが
含まれていない可能
性があります。

カーソルが互いに近
すぎる場合は、それ
らのギャップを広げ
るか、水平軸スケー
ルを変更して測定に
十分なエッジを取り
込んでください。

1802 電流プローブはどの
選択されたソースと
も接続されていませ
ん。

電流プローブはどの
チャンネルでも検出
されませんでした。

電流プローブを接続
し、再度消磁を実行
してください。

1803 No magnetic cycles
found on the
waveform.Adjust the
cursors and rerun the
measurement.

カーソル・ゲートはオ
ンになっています
が、カーソル間で使
用可能な完全なサイ
クルがないか、サイ
クル全体で使用可
能な完全なサイクル
がありません。

カーソル・ゲートがオ
ンになっている場合
は、カーソル間のギ
ャップを広げてくださ
い。あるいは、水平
パラメータを変更し
て再度信号を取り込
んでください。

1804 No magnetic cycles
found on the
waveform.Acquire
again with a longer
Record length and
rerun the
measurement.

波形全体で使用でき
る 1 つの完全なサイ

クルが存在しませ
ん。

水平軸スケールを変
更し、再度測定を実
行してください。
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1805 The configured
frequency range is not
supported by the
spectral analysis
measurement.

開始と停止の周波
数との差が、サポー
トされているレコード
長とサンプリング・レ
ートから見ると開き
すぎています。

差が縮まるように開
始と停止の周波数を
変更してください。

1806 No samples available in
the selected region of
the
waveform.Reposition
the cursors and run the
measurement.

選択した領域にサン
プルが入っていませ
ん。両方のカーソル
が同じ位置にあると
考えられます。

カーソルの 1 つを調

整し、測定を再実行
してください。

1807 AutoSet is only
applicable for live
channels.

ユーザは基準ソース
でオートセットを実行
しようとしました。

ライブ・チャンネルを
選択し、オートセット
を実行してください。

1808 Clipping detected
during autoset, Rerun
horizontal after
completing vertical
autoset.

水平オートセット時
にクリッピングが検
出されましたが、オ
ートセットは信号を
特定できませんでし
た。

垂直オートセットを
最初に実行してから
水平オートセットを
実行してください。

1809 No complete switching
cycle found in the
waveform.Reposition
the cursors, check the
waveform and re-run
the measurement.

波形の選択領域に
利用可能な完全な
スイッチング・サイク
ルが存在しません。

カーソル間のギャッ
プを広げるか、水平
軸スケールを変更し
て、再度測定を実行
してください。

1810 Update and select
appropriate RBW from
measurement
configuration panel and
rerun autoset.

スペクトラム測定で
は、"オート・セット"
は RBW（Hz）に基づ

いて水平分解能を
設定します。これ
は、測定を開始する
前に更新または設
定する必要がありま
す。

Configure > Spectral
Config > Update をクリ

ックして、Res BW(Hz)
を選択します。 > > 

1811 Consecutive mask
point can't be same,
change values and
click Add/Update
button.

SOA 測定には、

"Mask Designer" を使

用してマスクを作成
する機能がありま
す。ポイント同士を
接続するラインが交
差していない場合に
のみその機能が正し
く動作します。

ラインが交差するポ
イントを作成しないよ
うにしてください。
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1812 Mask is not valid
(Specify more number
of points(Minimum
3 points) and make
sure points do not lie
on a straight line).

1813 Mask points are not
valid.It could be
because.

マスクに十分な数の
ポイントがありませ
ん。マスク・ポイント
がすべて直線上に
配列されています。
マスクの設計をやり
直して、プレビューを
使用して、マスクの
有効性をチェックし
てください。または、
設定パネルでマスク
を無効にして、再度
測定を実行してくだ
さい。

1814 60 cycles of Line
Frequency is required
OR Make sure
Configure ->Line
Frequency is correct.

電流高調波測定で
"AM14" 規格を使用

する場合は、分析を
実行するために、
60 サイクル（4 × 15）
の電源周波数を作
成する必要がありま
す。

1. Configure >
Standard > Line
Frequency > Auto
をクリックしま
す。 > > > 

2. Configure > >
Standard > >
Harmonics Order
を選択します。

3. Source Configure
> Vert/Horiz を開

きます。 > 

1815 Unable to find edges
for the configured
trigger level.

トリガ・レベルを調整
して、再度測定を実
行してください。

1816 Unable to find edges
for the configured
output max voltage
level.

電圧レベルを調整し
て、再度測定を実行
してください。

1817 Not a valid mask, make
sure lines are not
intersecting.

マスクの描画に使用
される座標に、ポイ
ントが 1、または 2 つ
しかありません。

直線上に配列されて
いないポイントが少
なくとも 3 つあるマス

クを作成してくださ
い。

1818 Make sure input signals
are not DC in nature.

セットアップをチェッ
クしてから分析を続
けてください。
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1819 For most (>80%) of the
acquisition duration, the
input waveform is DC in
nature, since difference
of samples yields zero
values.A plot with the
same name is already
added.

RDS(on) 測定では、

事実上、AC 入力が

想定されています。
ユーザが純粋な DC
入力や、実際には
80% 相当が DC とい

った入力を使用する
場合には、測定が正
しく行われずに、エラ
ーがメッセージが表
示されます。

波形全体が分析さ
れるように、波形が
適切に遷移している
ことを確認します。

1820 Plot already added with
selected row
color.Select some other
row or clear the
selected row and try
Recall option.

SOA オーバレイ測定

には、複数の結果を
1 つのプロットで表現

する機能がありま
す。

新しい行を選択し
て、新しいオーバレ
イ・プロット・データを
参照してください。

1821 Recent plots does not
exist.Run measurement
to get the recent saved
plots.

Recent は保存された

プロット・データを開
きます。プロットは手
動で呼び出したり、
削除することもでき
ます。

最近使用したプロッ
トを開くには、プロッ
ト・データが保存され
ている必要がありま
す。

1822 Selected scale and
scale in the selected
mask file does not
match.Do you want to
change the scale?

NA
（Yes/No のポップアッ

プを選択することに
より、自動的に変更
されます）

NA

1823 Selected mask file may
be corrupted.Recall a
valid mask file.

保存されたマスクが
無効な場合は、呼び
出すことはできませ
ん。

グラフに表示可能な
有効なマスクを作成
します。Graph ボタン

は、Configuration >
Mask Editor にありま

す。 > 
1824 No coordinates

found.Recall a valid
mask file.

保存されたマスクが
無効な場合は、呼び
出すことはできませ
ん。

グラフに表示可能な
有効なマスクを作成
します。Graph ボタン

は、Configuration >
Mask Editor にありま

す。 > .
1825 Coordinate values are

not within the specified
range.

1826 File not found. ファイルを呼び出し
たときに、ファイルが
無効であったり、存
在しなかった場合に
は、エラー・メッセー
ジが表示されます。

呼び出そうとしてい
るファイルが指定さ
れたパスに存在する
ことを確認してくださ
い。
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1827 Changing the scale will
clear the unsaved
mask.Press Yes to
clear the mask.Press
No to return.

NA
（本当にスケールを
変更するかを確認す
るメッセージが表示
されません）

NA

1828 Could not log the data,
check if the file is in
use.

ファイルがすでに開
かれている場合は、
データを記録するこ
とはできません。

開かれているファイ
ルを閉じてから再び
実行します。

1829 Record Length is
chopped to 12.5M with
respected start point.

スペクトラム測定で
は、RF が 12.5 M より

大きい場合には、信
号はカーソル位置が
0 または 1 から

12.5 M までの長さに

チョッピングされま
す。

これは単に情報を表
示するためのメッセ
ージです。

1830 Zoom is not applied as
very few complete
cycles are available.

低周波入力の場合、
オートセットが実行さ
れていても、時間的
制限により、取り込
まれる信号の数サイ
クル分にしか設定さ
れません。その場
合、オートセットの後
にズームを使用して
も適用されません。

これは単に情報を表
示するためのメッセ
ージです。

1831 Make sure Sampling
minimum frequency is '
Line Frequency x
Harmonics No.x 2.2'
times.

全体の電源品質、電
流／電圧高調波の
測定では、エイリア
シングが発生してい
る状況で測定を行っ
ていると、このエラ
ー・メッセージが表示
されます。

1. Configure >
Standard > Line
Frequency > Auto
をクリックしま
す。 > > > 

2. Configure > >
Standard > >
Harmonics Order
を選択します。

3. Source Configure
> Vert/Horiz を開

きます。 > 

1832 File not found. 指定された場所にフ
ァイルが存在しませ
ん。

測定をやり直してく
ださい。

1833 No sufficient data
available for Time trend
Plot.Increase the
record length or
number of cycles being
captured.

未使用
NA

未使用
NA
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1834 Acquired waveform is
negative in
nature.Inverse the
probing points and re-
acquire.

Inverse the probing
points and re-acquire.

1835 Please wait while
plotting.

データを描画中で
す。

プロットが完成する
まで待機してくださ
い。

1836 Edges found are not
proper, may be due to
ringing in the wfm.

エッジ・ソースにゲー
ト電圧を設定してエ
ッジを計算します。

各スイッチング・サイ
クルのサンプル・ポ
イント数が少なくとも
100 あることを確認し

てください。ソース・
オートセットを使用す
ることをお勧めしま
す。

1837 For a REF source the
REF voltage cannot be
set more than the
maximum line voltage.

1838 For most (>80%) of the
acquisition duration, the
input waveform is DC in
nature, since difference
of samples yields zero
values.

RDS(on) 測定では、

事実上、AC 入力が

想定されています。
ユーザが純粋な DC
入力や、実際には
80% 相当が DC とい

った入力を使用する
場合には、測定が正
しく行われずに、エラ
ーがメッセージが表
示されます。

波形全体が分析さ
れるように、波形が
適切に遷移している
ことを確認します。

1839 SOA-X-Y(DPX) cannot
run with other
measurements of
Switching Analysis.

SOA X-Y (DPX)のみを

選択して実行しま
す。

Yes を押してリストを

クリアし、新しい測定
を追加します。No を
押すと、修正をせず
に戻ります。

1840 Use Gate Voltage (Vg),
If Signal is noisy

スイッチング・ロス分
析には、PFC 信号の

オプションがありま
す。一般に、PFC で
はゲート電圧を使用
してエッジを検出す
る必要があります。

これは PFC が選択さ

れていることを再確
認してもらうためのメ
ッセージです。
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1841 AutoZero performed
successfully

すべての測定で使
用可能な Source
Configuration には、

DC オフセットを設定

する "オートゼロ" の
オプションがありま
す。

これはオートゼロ操
作が完了したことを
示すメッセージで
す。

1842 AutoZero:Computed
DC Offset value

ターン・オン時間は、
出力分析の他の測
定項目と同時に実
行することができま
せん。

そうした測定項目に
ついてはグループ化
を解除して、個別に
実行してください。

1843 Turn On Time cannot
run with other
measurements of
Output Analysis.

ターン・オン時間の
みを選択して実行し
てください。

Yes を押してリストを

クリアし、新しい測定
を追加します。No を
押すと、修正をせず
に戻ります。

1844 In Rush Current cannot
run with other
measurements of Input
Analysis.

突入電流のみを選
択して実行してくださ
い。

Yes を押してリストを

クリアし、新しい測定
を追加します。No を
押すと、修正をせず
に戻ります。

1845 Input Capacitance
cannot run with other
measurements of Input
Analysis.

入力キャパシタンス
のみを選択して実行
してください。

Yes を押してリストを

クリアし、新しい測定
を追加します。No を
押すと、修正をせず
に戻ります。

1846 No edges were found in
the waveform, possible
due to ringing in the
switching transitions.

連続するエッジの間
のサンプル数は、少
なくとも 6 以上でな

ければなりません。

PFC の設定では、エ

ッジの REF レベルと

ヒステリシス値がデ
フォルトのレベルより
高くなるように調整
することによって、エ
ッジが検出されなか
ったり、あるいは間
違ったエッジが検出
されるのを防止しま
す。他のトポロジを
使用する場合には、
波形を再度取り込む
必要があります。

1847 Max X Scale should be
greater than Min X
Scale.

SOA マスク・デザイ

ナーで、X 軸の最大

値として X 軸の最小

値より少ない値が入
力されると、このエラ
ーが表示されます。

X 軸の最大値には X
軸の最小値よりも大
きな値を設定してく
ださい。
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1848 Min X Scale should be
lesser than Max X
Scale.

SOA マスク・デザイ

ナーで、X 軸の最小

値として X 軸の最大

値より大きな値が入
力されると、このエラ
ーが表示されます。

X 軸の最小値には X
軸の最大値よりも小
さな値を設定してく
ださい。

1849 Max Y Scale should be
greater than Min Y
Scale.

SOA マスク・デザイ

ナーで、Y 軸の最大

値として Y 軸の最小

値より少ない値が入
力されると、このエラ
ーが表示されます。

Y 軸の最大値には Y
軸の最小値よりも大
きな値を設定してく
ださい。

1850 Min Y Scale should be
lesser than Max Y
Scale.

SOA マスク・デザイ

ナーで、Y 軸の最小

値として Y 軸の最大

値より大きな値が入
力されると、このエラ
ーが表示されます。

Y 軸の最小値には Y
軸の最大値よりも小
さな値を設定してく
ださい。

1851 Probe is already
Degaussed.

プローブはすでに消
磁されています。

プローブを消磁する
必要はありません。

1852 Default vertical gain of
10e-3 V/div is set for
probe type am503s.

このメッセージは、
AM503 シリーズ・プロ

ーブを使用している
場合に表示されま
す。

AM503 シリーズで垂

直または水平／垂
直オートセットを実
行すると、垂直設定
に関する情報が表
示されます。
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測定機能と設定項目の相関表

次の表に、各測定の設定を示します。

表 10 : Switching Analysis

UI 名 Global オプショ
ン

Edges Type PWMTyp
e

OnOffLe
vel

Mask
Editor

Method

スイッチ
ング・ロ
ス

Hi-Power
Finder
SOA
RDS(on)
dv/dt
di/dt
SOA X-Y
（DPX）

表 11 : タイミング解析

UI 名 Global オプション Edges Edge
パルス幅

デューティ・サイ
クル

周期

周波数

スキュー

表 12 : Magnetics

UI 名 Global オプション Edges Source Physical
Chars1

Physical
Chars2

インダクタ
ンス

磁気特性

磁気損失
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表 13 : Input Analysis

UI 名 Global オプション Harmonics
Table

Line
Frequency

Standard I-Probe
Impedance

電源品質

電流高調
波

全体の電
源品質

突入電流

入力キャパ
シタンス

電圧高調
波

表 14 : Output Analysis

UI 名 Global Line Ripple
Freq

Ripple Freq Spectral
Config

入力 出力

ライン・リッ
プル

Switching
Ripple
Spectral
Analysis
ターン・オ
ン時間

表 15 : 振幅

UI 名 Global オプション Edge Signal Type
High
Low
（ハイ）-（ロー）

サイクル最小値

サイクル最大値

サイクル・ピーク
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測定機能とプロットの相関表

次の表に、各測定で表示されるプロットを示します。

表 16 : Switching Analysis

UI 名 タイム・トレ
ンド

ヒストグラ
ム

スイッチン
グ ON/OFF

SOA グラフ 立上りエッ
ジ - タイム・

トレンド

立下がりエ
ッジ - タイ

ム・トレンド

スイッチン
グ・ロス

Hi-Power
Finder
SOA
RDS(on)
dv/dt
di/dt
SOA X-Y
（DPX）

表 17 : Timing Analysis

UI 名 タイム・トレンド ヒストグラム

パルス幅

デューティ・サイクル

周期

周波数

スキュー

表 18 : Magnetics

UI 名 インダクタンス曲線 BH 曲線

インダクタンス

磁気特性

磁気損失
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表 19 : Input Analysis

UI 名 電力波形（V*I） 高調波のバー・グラ
フ

電源品質

電流高調波

全体の電源品質

突入電流

入力キャパシタンス

電圧高調波

表 20 : Output Analysis

UI 名 スペクトラム

ライン・リップル

Switching Ripple
Spectral Analysis
ターン・オン時間

表 21 : Amplitude

UI 名 タイム・トレンド ヒストグラム

High
Low
（ハイ）-（ロー）

サイクル最小値

サイクル最大値

サイクル・ピーク
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パラメータ

アプリケーションのパラメ

ータについて

このセクションでは、拡張電力解析アプリケーションのパラメータとデフォルトのメ
ニュー設定について説明します。フロント・パネルのボタンなど、その他のコント
ロールの動作の詳細については、使用しているオシロスコープのユーザ・マニュ
アルを参照してください。

メニューおよびオプションのパラメータには、各パラメータに使用可能な選択項
目の一覧とデフォルト値が表示されます。

シーケンサのパラメータ パラメータ 選択項目

Clear なし

Recalc なし

Single なし

Run なし

測定メニューのパラメー

タ

パラメータ 選択項目 デフォルト設定

Switching Analysis Switching Loss、Hi-Power
Finder、SOA、SOA X-Y
(DPX)、di/dt、dv/dt、RDS(on)

なし

タイミング解析 Pulse Width、Period、Duty
Cycle、Frequency

なし

Magnetics Inductance、Magnetic Loss、
Magnetic Property、I vs∫ V

なし

Input Analysis Power Quality、Current
Harmonics、Voltage
Harmonics、Total Power
Quality、In Rush Current、
Capacitance

なし

Output Analysis Line Ripple、Switching Ripple、
Turn on Time、Spectral
Analysis

なし

振幅 Cycle min、Cycle max、Cycle
peak-to-peak、High、Low、
High-Low

なし
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測定メニューのパラメー

タの設定

選択した測定には、次の各表に示すパラメータを設定できます。

Source Configuration のパラメータ

SOA のパラメータ

di/dt のパラメータ

dv/dt のパラメータ

Magnetics のパラメータ

Total Power Quality のパラメータ

Current Harmonics のパラメータ

Pulse Width Modulation のパラメータ

Period Modulation のパラメータ

Duty Cycle Modulation のパラメータ

Frequency Modulation のパラメータ

Source Configuration の
パラメータ

パラメータ 選択項目 デフォルト設定

Voltage Ch1、Ch2、Ch3、Ch4、Math1、
Math2、Math3、Math4、Ref1、
Ref2、Ref3、Ref4

Ch1

Current Ch1、Ch2、Ch3、Ch4、Math1、
Math2、Math3、Math4、Ref1、
Ref2、Ref3、Ref4

Ch2

Hi-Power Finder および

Switching Loss のパラメ

ータの設定

パラメータ 選択項目 デフォルト設定

Hi-Power Finder
Type タブ Fixed、Variable Fixed

On-Off Level タブ Vsw、Vg Vsw
Vg Source Ch1 ～ Ch4、Math1 ～ Math4 Ch3
Units Absolute、Percentage Percentage

Hysteresis（単位 % の場合） - 10%
Ref Level - 50%
Reference（単位 Absolute の
場合）

0 V

Hysteresis（単位 Absolute の
場合）

0 V

Device N-Channel、P-Channel N-Channel

V-level（単位 Percentage の場

合）

- 5%
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パラメータ 選択項目 デフォルト設定

I-level（単位 Percentage の場

合）

- 5%

V-level（単位 Absolute の場

合）

- 5 V

I-level（単位 Absolute の場

合）

- 1 A

Options タブ

Vg Level - 1.5 V
Filter Current - オン

Switch On - オフ

Details
スイッチング・ロス

Type タブ

PWM Type Fixed、Variable Fixed
Cursor Gating On、Off Off
Device Auto、User Auto
Type MOSFET、BJT/IGBT BJT/IGBT
RDS(on) - 20 mohm
On-Off Level タブ Vsw、Vg PFC が選択済みである場合

は Vg、それ以外の場合は
Vsw

Vg Source Ch1 ～ Ch4、Math1 ～ Math4 Ch3
Units Absolute、Percentage Percentage

Hysteresis（単位 % の場合） - 10%
Ref Level - 50%
Reference（単位 Absolute の
場合）

50 V

Hysteresis（単位 Absolute の
場合）

5 V

Device N-Channel、P-Channel N-Channel

V-level（単位 Percentage の場

合）

- 5%

I-level（単位 Percentage の場

合）

5%

V-level（単位 Absolute の場

合）

- 5 V

I-level（単位 Absolute の場

合）

1 A

Options タブ

Vg Level - 1.5 V
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パラメータ 選択項目 デフォルト設定

Signal Condition - オン

Filter Current - オン

Switch On - オフ

Details

Magnetics のパラメータの

設定

パラメータ 選択項目 デフォルト設定

Magnetic Loss タブ

Cursor Gating Details On、Off Off
Inductance-Edge Source Ch1 ～ Ch4、Math1 ～ Math4 Ch1
Ref Level Absolute、Percentage Percentage

Ref Level（単位 Absolute の場

合）

- 0 V

Hysteresis（単位 Absolute の
場合）

- 0 V

Ref Level（単位 Percentage の
場合）

- 50%

Hysteresis（単位 Percentage
の場合）

- 10%

# of Windings Single、Multiple Single

Magnetic Property タブ：Type
and Edge Source
Freq/Duty Fixed、Variable Fixed
Cursor Gating On、Off Off
# of Windings Single、Multiple Single
Edge Source Ch1 ～ Ch4、Math1 ～ Math4 Ch1
Units Absolute、Percentage Percentage

Ref Level（単位 Percentage の
場合）

10-90% 50%

Hysteresis（単位 Percentage
の場合）

5-40% 10%

Magnetic Property タブ：
Physical Chars
Units SI、CGS SI
Number of Turns 1 ～ 1 M 1 

Cross Section Area（SI の場

合）

1 m2

Cross Section Area（CGS の場

合）

1 cm2
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パラメータ 選択項目 デフォルト設定

Magnetic Length（単位 SI の
場合）

1 m

Magnetic Length（単位 CGS
の場合）

1 CM

# of Windings Two、More Two
Windings 2 Source Ch1 ～ Ch4 Ch3
Magnetizing Current Ref1 ～ Ref4 Ref1
Windings 3 Source Ch1-Ch4、Unused Unused

SOA のパラメータの設定 パラメータ 選択項目 デフォルト設定

Cursor Gating On、Off Off
Mask Editor 有効

Utility Overlay

SOA Mask パラメータ 選択項目 デフォルト設定

Mask Grid
Scale Log、Linear Linear
Linear マスク値 X-Min、X-Max

-40 KV ～ 40 KV
Y-Min、Y-Max
-40 KA ～ 5 KA

Log マスク値 X-Min、X-Max
-40 KV ～ 40 KV
Y-Min、Y-Max
-40 KA ～ 5 KA

di/dt のパラメータの設定 パラメータ 選択項目 デフォルト設定

Units Percentage、Absolute Percentage

Ref Level（単位 Percentage の
場合）

50%

Hysteresis（単位 Percentage
の場合）

10%

Ref Level（単位 Absolute の場

合）

0A

Hysteresis（単位 Absolute の
場合）

0A
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dv/dt のパラメータの設定 パラメータ 選択項目 デフォルト設定

Units Percentage、Absolute Percentage

Ref Level（単位 Percentage の
場合）

50%

Hysteresis（単位 Percentage
の場合）

10%

Ref Level（単位 Absolute の場

合）

0 V

Hysteresis（単位 Absolute の
場合）

0 mV

Current Harmonics のパラ

メータの設定

パラメータ 選択項目 デフォルト設定

Standards 61000-3-2、AM 14、MIL 1399 61000-3-2 
61000-3-2 
Line Frequency 50 Hz、60 Hz 50 Hz
Harmonic Table Table 1 ～ 10 Table 1 
Class Class A ～ Class D Class A
AM 14 
Line Frequency 50 Hz、60 Hz 50 Hz
Harmonic Table Table 1 ～ 10 1 
Class Class A ～ Class D Class A

Filter オン

Controls > Input Power 100 W
Controls > Power Factor 1 
Controls > Fundamental
Current

15A

MIL 1399 
高調波 50,100 50 
Line Frequency 60 Hz、400 Hz 60 Hz
i-Probe Impedance
Transfer Impedance Table Table 1 ～ 10 Table 1 

Use Impedance Table チェッ

ク・ボックス

オフ、オン オフ
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Voltage Harmonics のパラ

メータの設定

パラメータ 選択項目 デフォルト設定

Line Frequency
Line Frequency 50 Hz、60 Hz、Custom（1 Hz

～ 4 KHz）
50 Hz

Harmonics Order 40 - 100 40 
Global
Coupling AC、DC DC
Bandwidth Limit 20 MHz、250 MHz、Full  1 20 MHz
Switching Freq 50 Hz ～ 1 MHz 100 Hz
Acquisition Mode Hi Res、Sample、Pk Detect Hi Res

Total Power Quality のパ

ラメータの設定

パラメータ 選択項目 デフォルト設定

Standards 61000-3-2、AM 14、MIL 1399 61000-3-2 
61000-3-2 
Line Frequency 50 Hz、60 Hz 50 Hz
Harmonic Table Table 1 ～ 10 Table 1 
Class Class A ～ Class D Class A
AM 14 
Line Frequency 50 Hz
Harmonic Table 1 
Class Class A

Filter オン

Controls > Input Power 100 W
Controls > Power Factor 1 
Controls > Fundamental
Current

15A

MIL 1399 
高調波 50,100 50 
Line Frequency 60 Hz、400 Hz 60 Hz
i-Probe Impedance
Transfer Impedance Table Table 1 ～ 10 Table 1 

Use Impedance Table チェッ

ク・ボックス

オフ、オン オフ

1 * 対応オシロスコープでも、一部ではこれらのオプションを使用できない場合もあります。使用しているオシロスコープ

の帯域幅オプションを参照してください。
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Line Ripple のパラメータ

の設定

パラメータ 選択項目 デフォルト設定

Coupling AC、DC DC
Bandwidth Limit 20 MHz、250 MHz、Full  2 20 MHz
Acquisition Mode Hi Res、Pk Detect、Sample Hi Res
Ripple Freq 50 Hz、60 Hz、400 Hz 50 Hz

Switching Ripple のパラメ

ータの設定

パラメータ 選択項目 デフォルト設定

Ripple Freq
スイッチング・リップル周波
数

50 Hz ～ 1 MHz 100 KHz

Global
Coupling AC、DC DC
Bandwidth Limit 20 MHz、250 MHz、Full  3 20 MHz
Switching Freq 50 Hz ～ 1 MHz 100 Hz
Acquisition Mode Hi Res、Sample、Pk Detect Hi Res

Turn-On Time のパラメー

タの設定

パラメータ 選択項目 デフォルト設定

入力

Source Ch1、Ch2、Ch3、Ch4 Ch1
Converter AC-DC、DC-DC AC-DC
Max Voltage 1 V ～ 500 V 230 V
Trigger Level 1 V ～ 500 V 230 V
Max Turn-On Time 1 us ～ 5 s 200 ms

出力

Source 1 On、Off On
Source 2 On、Off Off
Source 3 On、Off Off
Source 1 Ch1 ～ Ch4 Ch2
Max Voltage -5.9 KV ～ 5.9 KV 5.0 V

2 * 対応オシロスコープでも、一部ではこれらのオプションを使用できない場合もあります。使用しているオシロスコープ

の帯域幅オプションを参照してください。
3 * 対応オシロスコープでも、一部ではこれらのオプションを使用できない場合もあります。使用しているオシロスコープ

の帯域幅オプションを参照してください。
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Pulse Timing Analysis の
パラメータの設定

パラメータ 選択項目 デフォルト設定

Source Ch1、Ch2、Ch3、Ch4 Ch1
Ref Destination Ref1、Ref2、Ref3、Ref4 Ref1
Units Level、Percentage Percentage
Percentage Ref Level、Hysteresis Ref Level：50% ヒステリシス：

5%
Absolute Ref Level、Hysteresis Ref Level：0 V、Hysteresis：6 V
Edge Positive、Negative Positive
Cursor Gating Off
Polarity Positive、Negative Positive

Period Timing Analysis の
パラメータの設定

パラメータ 選択項目 デフォルト設定

Source Ch1、Ch2、Ch3、Ch4 Ch1
Ref Dest Ref1、Ref2、Ref3、Ref4 Ref1
Ref Level Mode Level、Percentage Percentage
Percentage Ref Level、Hysteresis Ref Level：50% ヒステリシス：

5%
Absolute Ref Level、Hysteresis Ref Level：0 V、Hysteresis：6 V
Edge Type Rise、Fall Rise
Cursor Gating On、Off Off

Duty Cycle Timing
Analysis のパラメータの

設定

パラメータ 選択項目 デフォルト設定

Source Ch1、Ch2、Ch3、Ch4 Ch1
Ref Dest Ref1、Ref2、Ref3、Ref4 Ref1

Edge Level：Units Level、Percentage Percentage
Percentage Ref Level、Hysteresis Ref Level：50% ヒステリシス：

5%
Absolute Ref Level、Hysteresis Ref Level：0 V、Hysteresis：6 V
Edge Rise、Fall Rise
Cursor Gating On、Off Off
Polarity Positive、Negative Positive
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Frequency のパラメータ

の設定

パラメータ 選択項目 デフォルト設定

Source Ch1、Ch2、Ch3、Ch4 Ch1
Edge Type Rise、Fall Rise

Edge Level：Units Percentage、Absolute Percentage

Ref Level：Percentage 1% ～ 99% 50%

Ref Level：Absolute 0 V ～ 6 V 0 V

ヒステリシス 0 V ～ 3 KV 6 V

Utilities メニュー Utilities メニューで使用できるパラメータは次のとおりです。

■ デスキュー

■ SOA Overlay

■ Degauss

■ オートセット

次の項目も参照してください。.
デスキュー

SOA Overlay

消磁

オートセット
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静的なデスキュー パラメータ 選択項目 デフォルト設定

From Source Ch1、Ch2、Ch3、Ch4 Ch1
Probe TAM503B w/ A6302、AM503B

w/ A6303、AM503B w/ A6312、
AM503B w/ A6302XL、AM503B
w/ A6303XL、AM503B w/
A6304XL、P5050、P5050B、
P5100、P5100A、P5200、
P5200A、P5202A、P5205、
P5205A、P5210、P5210A、
P6015A (10 ft)、P6015A
(25 ft)、P6021A、P6131
(1.3 m)、P6131 (2 m)、
P6138A、P6139A、P6139B、
P6158、P6243、P6245、
P6246、P6247、P6248、
P6250、P6251、TAP1500、
TAP2500、TCP0020、
TCP0030、TCP0030A、
TCP0150、TCP202、
TCP202A、TCP2020、
TCP202A;TPA-BNC、TCPA300
w/ TCP303、TCPA300 w/
TCP303 + TPA-BNC、
TCPA300 w/ TCP305、
TCPA300 w/ TCP305 + TPA-
BNC、TCPA300 w/ TCP305A、
TCPA300 w/ TCP305A + TPA-
BNC、TCPA300 w/ TCP312、
TCPA300 w/ TCP312 + TPA-
BNC、TCPA300 w/ TCP312A、
TCPA300 w/ TCP312A + TPA-
BNC、TCPA400 w/
TCP404XL、TCPA400 w/
TCP404XL + TPA-BNC、
TDP0500、TDP1000、
TDP1500、TDP3500、,TekVPI
TCP0030、TekVPI TAP1500、
TekVPI TAP2500、TekVPI
TPA-BNC、THDP0100、
THDP0200、TMDP0200、
TPP0500、TPP0500B、
TPP0502、TPP0850、
TPP1000、Custom

Custom

To Source Ch1、Ch2、Ch3、Ch4 Ch2
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パラメータ 選択項目 デフォルト設定

Probe AM503B w/ A6302、AM503B w/
A6303、AM503B w/ A6312、
AM503B w/ A6302XL、AM503B
w/ A6303XL、AM503B w/
A6304XL、P5050、P5050B、
P5100、P5100A、P5200、
P5200A、P5202A、P5205、
P5205A、P5210、P5210A、
P6015A (10 ft)、P6015A
(25 ft)、P6021A、P6131
(1.3 m)、P6131 (2 m)、
P6138A、P6139A、P6139B、
P6158、P6243、P6245、
P6246、P6247、P6248、
P6250、P6251、TAP1500、
TAP2500、TCP0020、
TCP0030、TCP0030A、
TCP0150、TCP202、
TCP202A、TCP2020、
TCP202A;TPA-BNC、TCPA300
w/ TCP303、TCPA300 w/
TCP303 + TPA-BNC、
TCPA300 w/ TCP305、
TCPA300 w/ TCP305 + TPA-
BNC、TCPA300 w/ TCP305A、
TCPA300 w/ TCP305A + TPA-
BNC、TCPA300 w/ TCP312、
TCPA300 w/ TCP312 + TPA-
BNC、TCPA300 w/ TCP312A、
TCPA300 w/ TCP312A + TPA-
BNC、TCPA400 w/
TCP404XL、TCPA400 w/
TCP404XL + TPA-BNC、
TDP0500、TDP1000、
TDP1500、TDP3500、,TekVPI
TCP0030、TekVPI TAP1500、
TekVPI TAP2500、TekVPI
TPA-BNC、THDP0100、
THDP0200、TMDP0200、
TPP0500、TPP0500B、
TPP0502、TPP0850、
TPP1000、Custom

Custom
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リアルタイム・デスキュー.

パラメータ 選択項目 デフォルト設定

From Source Ch1、Ch2、Ch3、Ch4 Ch1
To Source Ch1、Ch2、Ch3、Ch4 Ch2
Slope Rise、Fall Rise
Edges  1

Ref Level 最小：0、最大：100% 50%

ヒステリシス 最小：0、最大：25% 5%
Source Internal、External External
Edges - 1 

一般的なスイッチ・モード電源（SMPS）

図 13 : SMPS のブロック図

1 推奨されるのは 1 つです。最大 5 つのエッジを使用できます。
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電力変換の効率を高めるために、最も一般的に利用されているアーキテクチャ
が、スイッチ・モード電源です。このアーキテクチャでは、損失の多い部品の使
用を最小に抑えています。代わりに、スイッチ・モード半導体素子、磁気素子や
受動素子など、理想的には無損失であることが期待される部品を使用していま
す。SMPS 装置には、パルス幅変調レギュレータ、パルス繰り返し数変調レギュ

レータ、およびフィードバック・ループなどの素子を含む制御部があります。ま
た、この制御部に固有の電源を備えた装置もあります。スイッチ・モード電源の
技術的根幹は、MOSFET（Metal Oxide Semiconductor Field Effect Transistor）
や IGBT（Insulated Gate Bipolar Transistor）などの電源用半導体スイッチング素

子にあります。これらの素子はスイッチング速度が高速であり、不安定な電圧ノ
イズに対する耐性にも優れています。同じように重要な特性として、ON または

OFF のいずれの状態でも電力の消散がきわめて少ないため、放熱を抑えなが

ら優れた効率を達成できることがあります。スイッチ・モード電源では、ほとんど
の場合スイッチング素子によって全体的な性能が決定されます。スイッチ・モー
ド電源の主なセクションに関連する一般的な測定項目としては、次のようなもの
が挙げられます。スイッチング素子に関しては、スイッチング・ロス、平均電力損
失、および安全動作領域などが主な測定項目になります。変圧部に関しては、
磁気特性や磁気による電力損失などが電源の性能に影響を及ぼすことになりま
す。また、動作環境がどのように電源に影響を与えるのかについても解析する
必要があります。これに関しては、電源品質、高調波、総合高調波歪みなどの
測定項目が重要になります。

図 14 : SMPS の回路図

 リファレンス
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スイッチング・ロス（PFC）

ターン・オン時のスイッチ

電流スパイク

電源オンの間、スイッチ電流が増加すると、突発的なスパイクまたは近接したリ
ンギングが発生する場合があります。これらのリンギングは、Ton の開始地点が

誤検出される原因になります。電流波形において開始指標の検出が行われる
間、リンギングを減少させるために、電流波形は 4 点移動平均フィルタ（MAV）

のソフトウェアに渡されます。開始指標の検出には、此のフィルタリングされた電
流波形が使用されます。フィルタリングされた電流波形の指標は、実際の電流
にマップされて、Ton 損失の計算が行われます。

図 15 : ターン・オン時の電流スパイク

カーソルの配置 2 つのスイッチング損失測定を選択します。1 つは 2 つのソースの VDS と ID、

もう 1 つは 3 つのソースの VDS、ID、および VG を測定します。下図のように、

カーソル 1 と 2 を、120 Hz のヘンプを含む領域に置きます。
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図 16 : カーソルの配置

下図に示されているように、VG にはリンギングがありますが、VDS は非常にクリ

ーンです。

図 17 : TOFF 時における VG のリンギング

 リファレンス
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図 18 : クリーンな VDS

測定を続けて、結果およびプロットを表示します。

電流レンジと X 軸の電圧レンジ（400 V）を確認すれば、VDS のプロットが正確

であることがわかります。

リファレンス  

282  拡張電源解析



図 19 : 測定結果と SWL プロット

ノイズが多い VG ソース

での REF レベルの計算

PCF では、エッジ・ソースとしてゲート電圧を使用することをお勧めします。ゲー

ト電圧をズームして、各スイッチング・サイクルのターン・オン時にリンギングが発
生していないか観測します。このリンギングは、間違ったエッジ検出の原因にな
り、測定時のエラーにもつながります。このケースでは、デフォルト値では正しく
測定できません。

図に示されているように、エッジの計算が可能なクリーンな領域のゲート電圧を
測定します。アプリケーションでは、エッジの設定に 12.25 V という値が設定され

ています。
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プロットと結果を比較す

る方法

特定のスイッチング・サイクルを選択して、Details をクリックします。次の図に示

すように、プロットの Prev/Next ボタンを使用して、ターン・オンの領域を選択しま

す。

カーソル・ゲートをオンにしてプロット画面の領域の測定値を観察すると、
75.32nWs を示しています。これは TON 統計値のエネルギーと符合していま

す。
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また、損失（ワット）を計算するには、プロット画面に表示された値にスイッチング
周波数（164 KHz）を乗算します。その結果は、12.35 mW であり、やはり TON
損失の統計値の中に見出すことができます。

要約すれば、プロットの結果とスカラー値による結果を直接比較することはでき
ません。プロットのサイクルと結果の値を比較するには、TON および TOFF のす

べての値を個別に追加する必要があります。次の図のように、ドット接続を有効
にして、ON 領域に対応するすべての黄色のドットを追加し、サンプル間隔を乗

算して、個別のエネルギーを求めます。

 リファレンス
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アルゴリズム

アルゴリズムについて

アルゴリズムとは、特定の機能を実装するための一連の有限かつ明確な手続き
によって表現された計算方式です。このセクションでは、DPOPWR の測定アル

ゴリズムについて説明します。

スコープの設定に関する
ガイドライン

拡張電源解析では、測定を実行する前に、測定ごとにオシロスコープのパラメ
ータを適切に設定します。電圧波形または電流波形は Ch1 ～ Ch4 または Ref1
～ Ref4 のいずれかになります。2 チャンネルのオシロスコープの場合は、Ch1
～ Ch2 または Ref1 ～ Ref2 になります。

1. 最適な結果を得るには、波形がオシロスコープの垂直レンジを超えないよう
に波形の垂直軸スケールを設定する必要があります。垂直軸スケールは、
波形が画面全体に広がるように設定します。

2. エイリアシングを防止するために、サンプル・レートは、十分な波形の詳細が
取り込まれるように設定する必要があります。

オプションの設定

この設定タブを使用して、アプリケーションが各測定を行うときに使用する必要
がある波形エッジを選択できます。

ヒステリシス

 

 

ヒステリシス入力は、指定した基準レベルでの波形のクロス・オーバー時間を識
別するのに役立ちます（前の図を参照）。リファレンス・レベルにノイズが存在す
る場合は、ヒステリシス帯（H Band 1）を使用すると、シングル・クロス・オーバーを

識別できます。

リファレンス・レベルでヒステリシス帯（H Band 2）が信号ノイズより小さい場合は、

1 つの遷移ではなく、3 つのエッジまたは 3 つの遷移として表示されます。ヒステ

リシス帯を使用すると、正しい遷移を識別できます。
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Ref Level

REF レベルは、指定されたレベルに設定されたソースのエッジを計算するため

に使用されます。

スイッチング解析

スイッチング・ロス  

 

T1 = 最初のスイッチング・サイクル

T2 = 2 番目のスイッチング・サイクル

Tn = n 番目のスイッチング・サイクル

前の図を参考に、次の式を使用して全損失を計算します。
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MOSFET の RDS(on) 値を使用してアプリケーションで全損失を計算する場合

は、次の式を使用して計算を行います。

RDS(on) は、スイッチング・デバイスへの入力に使用します。伝導損失は、入力

として RDS(on) を使用して計算されます。

全損失 = TOn 損失 (平均) + TOff 損失 (平均) + 伝導損失。

全エネルギー = TOn エネルギー (平均) + TOff エネルギー (平均) + 伝導エネ

ルギー。

MOSFET の伝導損失を測定するには、次の式を使用します。

 

 

ここで、

Irms = スイッチング電流の実効値。

BJT/IGBT の伝導損失を測定するには、次の式を使用します。

 

 

ここで、

Imean = スイッチ電流の平均値

伝導エネルギーを測定するには、次の式を使用します。

伝導エネルギー = 伝導損失 * アクイジション時間。

 

 アルゴリズム

拡張電源解析 289



 

アプリケーションでは、前の図に基づき、次の式を使用して、TOn エネルギーお

よび TOff エネルギーを計算します。

 

 

全スイッチング・ロス=Ton 損失+Toff 損失+伝導損失。

基本アルゴリズム：TOn、TOff、および平均全損失の計算の場合。

 

 

エッジ解析にゲート電圧を使用して TOn および TOff を識別する場合の考え

方：
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エッジ・レベルをデフォルトの 50% およびヒステリシスを 10% とし、エッジ解析に

ゲート電圧を使用します。

■ TOn の開始の特定：TOn の開始は、ゲート電圧の立上りスロープで 5% ま
たは 1.5 V のうちのどちらか小さい方です。

■ TOn の停止の特定：スイッチ電圧では、ゲート電圧の立上りスロープの 5%
または 1.5 V が開始指標となります。開始指標から 5% または設定したレベ

ルになるまで、スイッチ電圧を先に進めます。

■ TOff の開始の特定：ゲート電圧の 80% が開始指標となります。停止指標か

ら、スイッチ電圧の（立上りスロープの）5% の位置を検索します。

■ TOff の停止の特定：ゲート電圧の 80% が開始指標です。スイッチ電流（立

下りスロープ）のこの開始指標から 最大（スイッチ電流）の 5% になるまで先

に進めます。

アプリケーションで Filter チェック・ボックスをオンにした場合は、次の式を使用し

て移動平均フィルタが計算されます。

 

 

y(n)= 出力

x(n)= 入力

M = 4 つのサンプル・ポイントの平均

スイッチング・ロス - PFC 力率改善回路（PFC エッジ）は SMPS で使用される特別な回路で、AC 入力電

圧に対して入力電流の波形を正弦波に近づけることによって、力率を改善する
働きがあります。PFC にはパッシブ・タイプとアクティブ・タイプの 2 種類がありま

す。

次の波形は、電子安定器から取り込まれたスイッチング電圧、電流、およびゲー
ト電圧の典型的な例を示しています。

動作周波数の開始地点ではほとんどゼロに近い SWL 電流がエンベロープ形

状で高い電流レベルに増加した後に、ゼロ・レベルまで減少しているのがわかり
ます。したがって、電流波形でエッジを検出するのは不可能であり、ゲート電圧
を使用しなければなりませんでした。

図に示されているように、スイッチ電圧はデューティ・サイクルや動作周波数が
変化する場合があるため、ON と OFF のエッジの遷移を適切に検出するために

は、3 番目のソースであるゲート電圧の使用することをお勧めします。スイッチ電

圧は、連続伝導モードと不連続伝導モードのどちらにも見られます。
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次の図は、50 Hz で取り込まれたスイッチング電圧波形のバーストを示していま

す。ズームされた部分では遷移を確認できます。1 つの領域で 100 Hz レンジを

カバーできる位置にカーソル 1 と 2 を置きます。

図 20 : ズームインされた VDS（ドレイン - ソース間電圧）のスイッチング・サイクル

次の図に示すように、ターン・オン中に電流波形にスパイクが発生しています。
より正確な解析を行なうには、ゲート電圧の使用をお勧めします。
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図 21 : ズームインされた IDS（ドレイン - ソース間電流）のスイッチング・サイクル

電流波形はゲート電圧と同相を示しています。また、ゲート電圧はリンギングの
ない理想的なパルス波を示しています。ゲート電圧にノイズが見られる場合に
は、Measurement > Configuration > Options タブで、エッジの REF レベルを適

切に設定してください。 > > レベルは水平カーソルを使用して手動で確認でき

ます。

図 22 : ズームインされた VG（ゲート電圧）
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図 23 : オーバラップされた VDS、IDS、および VG

図 24 : PRC の結果
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図 25 : 数多くのサイクルをとらえた典型的な PFC のプロット

ハイパワー・ファインダ TON、TOFF、およびハイパワー・ファインダの全損失の計算方法は、スイッチン

グ・ロス測定の場合と同じです。

安全動作領域 この測定には次の 3 つのオプションがあります。

■ SOA：電圧波形と電流波形のグラフをプロットします。

■ SOA X-Y (DPX)：オシロスコープの内蔵 XY モードを起動します。このこと

は、ライブ・チャンネルにのみ当てはまります。

 アルゴリズム

拡張電源解析 295



結果：. 電圧と電流のグラフ（SOA プロット）には、グラフ上で選択した部分の電
圧、電流、および電力の値が表示されます。

Occurrence フィールドには、次の内容が表示されます。

■ 取り込まれた波形において、選択された電圧位置と電流位置が出現する回
数

■ 平均電力

■ 選択したデータ・ポイントの標準偏差

アプリケーションでは、電力値の計算に次の式を使用します。

 

 

ここで、

P n = 瞬間電力値

V n = 電圧値

I n = 電流値

n = 特定ポイントにおけるサンプル

アプリケーションでは、平均電力の計算に次の式を使用します。

 

 

ここで、

N = プロットで同じ値を持つサンプルの数。

アプリケーションでは、標準偏差の計算に次の式を使用します。

 

 

ここで、

X I = 電力値

X = 平均電力
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RDS(on) 動的抵抗（RDS(on)）は、スイッチング・デバイスがオン状態の場合に、このデバ

イスによって発生する抵抗です。DPOPWR では、オシロスコープ内蔵の演算機

能によって、V/I 曲線で動的抵抗を監視することができます。

抵抗値を得るには、抵抗曲線上の対象領域にカーソルを配置してください。

di/dt di/dt 測定は、スイッチング中に電流が変化するレートを表します。アプリケーシ

ョンでは、オシロスコープの内蔵演算機能を使用して、電流入力の微分波形が
求められます。

測定を実行すると、デフォルト・レベルに 10% と 90% を使用して最初のエッジ

の di/dt が計算され、結果が表示されます。

ハイ・レベルとロー・レベルの入力を電圧と電流のパーセンテージおよび絶対値
として指定すると、ライブ信号で波形の特定のセクションを選択します。対象の
エッジを選択するには、オシロスコープで、そのエッジが見えるように表示しま
す。結果パネルでエッジ番号を入力することもできます。選択したエッジおよび
レベルの結果は、アプリケーションの結果パネルに表示されます。

アプリケーションでは、di/dt の計算に次の式を使用します。

 

 

ここで、

X= タイミング値

Y= 波形データの垂直値

dv/dt dv/dt は、スイッチング中に電圧が変化するレートを表します。アプリケーション

では、演算機能を使用して電圧入力の微分波形が求められます。

測定を実行すると、デフォルト・レベルに 10% と 90% を使用して最初のエッジ

の dv/dt が計算され、結果が表示されます。

ハイ・レベルとロー・レベルの入力を電圧と電流のパーセンテージおよび絶対値
として指定すると、ライブ信号で波形の特定のセクションを選択します。対象の
エッジを選択するには、オシロスコープで、そのエッジが見えるように表示しま
す。結果パネルでエッジ番号を入力することもできます。選択したエッジおよび
レベルの結果は、アプリケーションの結果パネルに表示されます。

アプリケーションでは、dv/dt の計算に次の式を使用します。
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ここで、

X = タイミング値

Y = カーソル間の波形データの垂直（電圧）値。

タイミング解析

このセクションでは、変調解析に含まれる、次の測定のアルゴリズムについて詳
細に説明します。

■ パルス幅
■ 周期
■ デューティ・サイクル
■ 周波数

アプリケーションでは、電圧波形のサイクル全体で信号が測定されます。これら
の測定はすべて、アクイジションでのエッジの時間位置に関連しています。結果
は、測定の設定において選択したリファレンス・メモリのいずれかに、グラフィカ
ルに表示されます。

周期変調および周波数  

 

上の図は、周期変調と周波数変調を説明する周期変調信号の例です。上図の
点 A ～ I は、取り込まれた波形の V ref mid 交点を表しています。

アプリケーションでは、周期および周波数の計算に次の式を使用します。
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ここで、

A、B、C、D、E、F、G、H、I = データ・ポイント

パルス幅およびデューテ
ィ・サイクル

 

 

上の図は、パルス幅変調およびデューティ・サイクル変調を計算するパルス幅
変調信号の例です。上図の点 A ～ G は、取り込まれた波形の V ref Mid 交点
を表しています。

正または負のパルス幅やデューティ・サイクルを設定することもできます。

アプリケーションでは、パルス幅およびデューティ・サイクルの計算に次の式を
使用します。
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ここで、

A、B、C、D、E、F、G = データ・ポイント

スキュー

このセクションでは、タイミング解析に含まれる、次の測定のアルゴリズムについ
て詳細に説明します。

スキュー測定は、基準とする波形の指定されたエッジと、比較対象とする波形の
指定されたエッジの時間差を計算します。

クロック・エッジに最も近いデータ・エッジのタイミングのレンジ限界は、次の式で
計算されます。

Tn
Skew = Tn

Main = Tn
2nd

ここで、

Tn
Skew は、タイミング・スキューです。

Tn
Main は、メイン入力 VRefMidMain の指定された方向での交差時間です。

Tn
2nd は、2 番目のメイン入力 VRefMid2nd の指定された方向での交差時間で

す。

n の指定範囲は 1 ～（エッジ数）です。
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Magnetics
磁気の測定では電流と積分電圧が表示されます。また、インダクタンス、磁気特
性、および磁気損失が測定されます。電圧の積分を使用する場合は、電圧 "V"
に DC 成分が一切含まれていないことを確認するよう注意してください。電圧波

形の積分で DC シフトを避けるには、オシロスコープの AC カップリングを使用

します。アプリケーションでは、電流と積分電圧の複数のサイクルを平均して
1 つのサイクルが作成されます。

 

 

前の図における各記号の意味は次のとおりです。

Bs = 飽和磁束密度

Br = 残留磁気磁束密度

Hc = 保磁力（Hc）

Ui = 初期透磁率

Ua = 最大振幅透磁率

注： データ波形は H の最大値から始まり、減少してから再び増加します（M-N-
O-P の順）。

磁界強度（H）：前の図は、標準的な磁性材料のヒステリシスを示しています。磁

界によって、磁束が DUT に誘導されます。測定の単位は、SI 単位では A/m、

CGS 単位では Oe です。
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飽和磁束密度（Bs）：外部的にかかる磁界 H の大きさに関係しない、材料内で

誘導される最大磁束密度。

この値は、取り込まれた波形上の最大磁束密度サイクルで計算されます。この
サイクルを、取り込まれた波形の K 番目のサイクルとします。

Bs = Max (Bk)

磁界強度 H も最大磁束密度サイクル Bk 上で計算されます。

Bs = Max (B)

H が最大となるインデックス I は次のとおりです。

I = (Max(H)) のインデックス

Bs = B(I) (2)

残留磁気（Br）：外部的にかかる磁界（H）がゼロに戻った後、ヒステリシス・ルー

プが生成されている間に材料に残る、誘導された磁束密度です。

また、取り込まれた波形全体で最大磁束密度が出現する k 番目のサイクル

（Bk）で、残留磁気も計算されます。

H 波形で H がゼロ値となるインデックスを特定し、これらのインデックスから B の
最大値を計算します。

H 波形で H がゼロ値となるインデックスを "q" とします。q1 および q2 を波形の

インデックスとします。K 番目のサイクルで、インデックス q1 および q2 での B の
値を計算します。B の最大振幅値が残留磁気磁束密度となります。

保磁力（Hc）：H 軸とヒステリシス・ループの交点で求められる H の値が保磁力

です。これは、ヒステリシス・ループの測定周期中に誘導される磁束密度（B）を
ゼロにするのに必要な外部磁界を表します。Hc は、正と負の軸で対称になりま

す。

また、取り込まれた波形全体の最大磁束密度が出現する k 番目のサイクルで、

保磁力 Hc も計算されます。

B 波形でゼロ B 値にあるインデックスの特定：B 波形で B がゼロ値となるインデ

ックスを "q" とします。q1 および q2 を、B がゼロとなる B 波形のインデックスとし

ます。

インデックス q1 および q2 で H データの最大振幅が保磁力となります。

透磁率：Bk サイクルで計算された B と H の比率です。

カーソルを使用して BH プロット上のポイントを選択し、カーソル間で選択したデ

ータから BH 曲線のスロープを計算します。カーソルを使用してプロットの一部

を選択すると、結果を取得できます。

スロープの計算

カーソル間には N 個のデータ・ポイントが存在します。

Hav = (H1+HX2+…Hn)/N

Bav = (B1+B2+…Bn)/N
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Hnormi = Hi-Hav（i=1..N）

Bnormi = Bi-Bav（i=1..N）

B/H = SUM(Hnorm1*Bnorm1+Hnorm2*Bnorm2+…+HnormN*BnormN)

/SUM(Hnorm1*Hnorm1+Hnorm2*Hnorm2+…HnormN*HnormN)

入力解析

電源品質 電源品質測定では、電圧の実効値、電流の実効値、有効電力、皮相電力、力
率、電圧の波高率、および電流の波高率を計算します。

アプリケーションでは、RMS 電圧の計算に次の式を使用します。

 

 

ここで、

RMS(v) = 電圧

N = サンプル数

n = データ・ポイント

v(n) = 特定データ・ポイントにおける電圧の絶対値

アプリケーションでは、RMS 電流の計算に次の式を使用します。

 

 

ここで、

i = 電流

N = サンプル数

n = データ・ポイント

i(n) = 特定データ・ポイントにおける電流の絶対値

アプリケーションでは、有効電力の計算に次の式を使用します。
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ここで、

N = サンプル数

n = データ・ポイント

アプリケーションでは、皮相電力の計算に次の式を使用します。

 

 

ここで、

RMS(v) = 電圧の実効値

RMS(i) = 電流の実効値

アプリケーションでは、力率の計算に次の式を使用します。

 

 

ここで、

P real = 有効電力

P appar = 皮相電力

波高率は、信号の PK 値と信号の RMS 値の比率です。電圧と電流の波高率を

計算するには、次の式を使用します。

 

 

ここで、
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Vpk = 電圧のピーク値

Vrms = 電圧の RMS 値
 

 

ここで、

Ipk = 電流のピーク値

Irms = 電流の RMS 値

位相角の測定

位相角とは、その余弦をとることにより真の実効力率が求められる角度（+90 ～
-90）です。位相角を表す単位は「度」です。Ch1 の波形（通常は電圧）が Ch2 の
波形（通常は電流）よりも進んでいる（LEAD）場合は、角度が正になります。Ch1
の波形 が Ch2 の波形よりも遅れているいる（LAG）場合は、角度が負になりま

す。
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電源品質の測定では、電力変換回路の AC 入力セクションの次のような測定値

と統計値が 1 つのテーブルで示されます。

■ RMS 電圧と電流

■ 有効電力（P）または負荷の抵抗部に実際に供給される電力（測定単位はワ

ット）。または、VRMS * IRMS * cos(φ)

■ 皮相電力（S）。RMS 電圧と電流の積（数学的には、有効電力と無効電力の

ベクトルの和の絶対値）、測定単位はボルトアンペアまたは VA。

■ 無効電力（Q）または負荷のリアクタンス素子（インダクタまたはキャパシタ）に

供給または一時的に蓄積される虚電力。測定単位はバールまたは VAR。
または、VRMS * IRMS * sin(φ)

■ 電圧および電流の波高率（信号の最大値と実効値の比率）

■ 力率（実効電力と皮相電力の比率。信号が純正弦波の場合は、力率は電
流波形と電圧波形の間の位相角のコサイン）

注： 位相角は他の測定結果から簡単に求められます。

■ 位相角（φ）は実効電力と皮相電力のベクトルの角度で、インピーダンスの位
相角に等しくなります。

■ 数学的には、cos(φ) = P/S および sin(φ) = Q/S という式で表されます。

電流／電圧高調波 高調波は、電源システムを動作させる周波数（基本周波数）の整数倍の周波数
を持つ正弦波電圧／電流です。歪んだ波形は、基本周波数の部分と高調波の
部分に分解できます。

電流／電圧測定では、以下の手順に従って高調波が計算されます。
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1. 実数部（Re(k)）と虚数部（Im(k)）を計算するために、離散フーリエ変換

（DFT）を使用します。
 

 

ここで、

ki = 取り込まれたレコード長（N）に対応する高調波のインデックス

i = 1, 2, ....高調波次数（OH）

ki = 入力電源高調波のインデックス × i

x(n) = 取り込み時間のサンプルの離散集合

Rek = th 番目の高調波の実数部

Imk = th 番目の高調波の虚数部

2. 周波数領域成分の振幅
 

 
fk - kth 高調波

fk の単位は電圧信号の場合はボルト、電流信号の場合はアンペアです。

3. 高調波は、次の式を使用して dB に変換されます。
 

 

注： 'AM 14' 規格の場合には、取り込まれた信号は 15 のチャンクに分割さ
れ、それぞれのチャンクごとにすべての高調波が計算されます。それぞれ
の高調波に対して、15 個の値の中から最大値が取られます。

高調波の実効値は、次の式を使用してボルトまたはアンペアの単位で計算され
ます。
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f1 = 基本調波または電源高調波

総合高調波歪み（THDF）は、ソース波形の基本成分の実効値に対する割合と
して計算されます。結果はパーセントで表され、次の式で計算されます。
 

 

総合高調波歪み（THDR）は、ソース波形の実効値に対する割合として計算され
ます。結果はパーセントで表され、次の式で計算されます。
 

 
位相の計算

周波数領域は、極形式で表現することもできます。この記法では、周波数領域
の実数（Rex[]）と複素数（lmX[]）の成分が 2 つの別の配列、X[]の振幅（Mag
X[]）と X[] の位相（Phase X[]）で表現されます。振幅と位相は、それぞれ実数部
分と虚数部分を組にした状態で置き換えたものです。たとえば、Mag X[0] と
Phase X[0] は、ReX[0] と Im X[0] のみを使用して計算されます。同様に、Mag
X[14] と Phase X[14] は、ReX[14] と Im X[14] のみを使用して使用されます。
変換を理解するためには、同じ周波数の余弦波と正弦波を追加したときにどう
なるか考えてみます。結果は、A cos(x) + B sin (x) = M cos( x + Φ) の余弦波に
なります。
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ここで、

i = 高調波のインデックス

RelX[i] = 高調波の実数部（余弦波周波数）

ImgX[i] = 高調波の虚数部（正弦波周波数）

 

 

If, RelX[i] < 0 & ImgX[i] < 0 Phase[i] = Phase[i] - π

If, RelX[i] < 0 & ImgX[i] > 0 Phase[i] = Phase[i] + π

注： "AM 14" 規格では、位相値は高調波の最大振幅値の結果に表示されま
す。

部分奇数次高調波電流（POHC）

第 21 次以上の奇数次の高調波については、観測期間全体から取得したそれ
ぞれの奇数次高調波の平均値が、取り込まれた波形から計算されます。測定さ
れた部分奇数次高調波電流は、該当する限界値から算出された部分奇数次高
調波電流を超過してはなりません。
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全体の電源品質 この測定のアルゴリズムは、電流高調波と電源品質のアルゴリズムを組み合わ

せたものです。

突入電流 ピーク突入電流を測定したい場面としては、スイッチング電源が最初に起動され
るときがあります。入力キャパシタンスの充電電流により、電源変換装置には定
常状態よりかなり高い突入電流が流れます。そのため、あらゆる状況に対応でき
るように、一般的な測定方法が考案されています。

アルゴリズム：

突入電流は、波形全体ではなく、対象領域について測定されます。開始領域は
波形が "突入電流のしきい値" を交差する地点、終了領域は電流波形が再びこ

のレベルを交差する地点と定義されます。測定は自動的に行われ、突入領域
がアルゴリズム的に特定されます。ただし、ユーザはスコープのカーソルを置くこ
とによって、突入領域を指定できます。突入領域の開始および終了は、領域の
検出に使用されるしきい値（Ref レベルの設定）によって異なります。通常は、開

始領域は波形が "突入電流のしきい値" を交差する地点、終了領域は電流波

形が再びこのレベルを交差する地点として特定されます。
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入力キャパシタンス 電流波形はキャパシタンス値を計算するのに使用されます。アプリケーションで
は、ピーク電圧値を入力する設定が提供されているため、波形を取り込む必要
はありません。開始から終了までの領域から取られた電流値サンプルの台形積
分を使用して、累積電荷が計算されます。

アルゴリズム：

電荷は、 

ここで、

K は開始指標から停止指標までの間の電流値サンプルを表します。

キャパシタンスは次の式を使用して計算されます。 

したがって、キャパシタンス（単位：ヘンリー）は  で求められま

す。

出力解析

ライン・リップルおよびス

イッチング・リップル

リップルの測定では信号のリップル成分が表示されます。ライン・リップルでは、
入力波形に 50 Hz または 60 Hz の 3 つのサイクルが含まれるように時間軸が設

定されます。スイッチング・リップルでは、スイッチング周波数入力に応じて 4 つ
のサイクルを表示するように時間軸が設定されます。

選択したカップリング・タイプに応じて必要なオフセットが設定され、垂直軸スケ
ールが適切な感度に調整されます。ピーク・ピーク値が測定され、結果が表示さ
れます。

スペクトラム解析 スペクトラム解析では、高速フーリエ変換を計算して、指定した周波数レンジの
信号の振幅が測定されます。

アプリケーションでは、両側振幅スペクトラムの計算に次の式を使用します。

数量ピークの振幅スペクトラム = Magnitude [FFT (A)]/N

ここで、

N = サンプリング・ポイント数

A = 信号

アプリケーションでは、両側振幅スペクトラムの計算に次の式を使用します。

V rms の片側振幅スペクトラム = 1.141*Magnitude [FFT (A)]/N（i = 1 ～ N/
2 -1）
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= Magnitude [FFT (A)]/N（i = 0 つまり DC の場合）

ここで、

i = A の FFT の周波数ライン番号

DC 以外の各周波数には 2 が乗算され、配列の後半は破棄されます。

振幅スペクトラムはパワー・スペクトラムと密接に関連しています。片側パワー・ス
ペクトラムは、片側 RMS 振幅スペクトラムを二乗して計算されます。

アプリケーションでは、片側振幅スペクトラムの計算に次の式を使用します。

DB = 10Log10P/Pr

ここで、

P = 測定された電力

Pr = 基準電力

Db = 20log10A/Ar

ここで、

A = 振幅の測定値（デシベル単位で測定）

Ar = 基準振幅（デシベル単位で測定）

アプリケーションでは、FFT の計算に次の式を使用します。

 

 

ここで、

X (K) = 高速フーリエ変換アルゴリズムを使用して計算された x の離散フーリエ

変換

x(n) = タイム・サンプルの離散集合

k = 離散周波数成分の集合の計算値のインデックス

N = 対象サンプル数
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RBW 値の選択. ここでは、計算されたリストから RBW 値を選択する例を示しま
す。50 Hz、1 V（p-p）の入力方形波の場合は、スタート周波数を 50 Hz、ストップ
周波数を 10 KHz に設定します。Update ボタンを押すと、RBW 値のリストが表
示されます。ウィンドウ・タイプが Rectangular の場合、表示の最大値は 17.6 Hz
です。

17.6 Hz という値は、20 Hz（サンプル・レート（100KS/s）/レコード長（5K））RBW
と Rectangular ウィンドウ定数の積として計算されます。基本周波数 50 Hz は
20 Hz RBW の 2.5 倍です。

このアルゴリズムでは、RBW の整数倍と基本周波数が使用されます。したがっ
て、2.5 は 2.0 に丸められます（Floor 処理）。このため、20 Hz RBW からは基本
周波数を計算できず、50 Hz は表示されません。このような場合は、17.6 以外で
サイクル数が整数値となる RBW 値を使用してください。この状況は、一部のス
タート周波数とストップ周波数、および RBW が基本周波数の積分ではない
RBW の一部の組み合わせの場合に発生します。

ターン・オン時間 ターン・オン時間とは、入力電圧が印加された後、電源の出力電圧が得られる
までにかかる時間です。DPOPWR には、4 チャンネルのオシロスコープの場合

に 3 つの出力信号を同時に測定するオプションがあります。

ターン・オン時間の測定には、次の入力が使用されます。

ターン・オン時間を測定するには、次の入力が必要となります。

■ すべてのチャンネルの電圧レベル

■ 最大ターン・オン時間

波形の垂直軸は、波形が少なくとも軸の 2 目盛分の大きさになるようにアプリケ

ーションで設定されます。水平軸設定は、上記の設定入力に従って行われま
す。
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振幅

High 振幅（ハイ）は各単位間隔の選択された部分の平均またはモードを計算します。

アプリケーションでは、この測定の計算に次の式を使用します。

VHIGH(n) = Func(Vpercent(n))

ここで、

VHIGH(n) = 振幅（ハイ）の測定結果

Func [ ] = 選択された演算（Mean または Mode）

Vpercent(n) = 各サイクルの中心線より上の部分の領域の割合（1% ～ 100%）

n = 高ビットのインデックス

Low 振幅（ロー）は各単位間隔の選択された部分の平均またはモードを計算します。

アプリケーションでは、この測定の計算に次の式を使用します。

VLow(n) = Func(Vpercent(n))

ここで、

VLow(n) = 振幅（ロー）の測定結果

Func [ ] = 選択された演算（Mean または Mode）Mean は、アクイジション全体の

各サイクルのヒストグラムから算出される算術平均です。Mode は、アクイジション

全体の各サイクルのヒストグラムから算出される最頻値です。

Vpercent(n) = 各サイクルの中心線より下の部分の領域の割合（1% ～ 100%）

n = 高ビットのインデックス

High-Low （ハイ）-（ロー）測定は波形が遷移する間の電圧レベルの変化を計算します。

アプリケーションでは、この測定の計算に次の式を使用します。

VHigh-Low(n) = Func(Vlevel(i) - Vlevel(i+1))

ここで、

VHigh-Low(n) = 振幅（ハイ）-（ロー）の測定結果

i = 取り込まれた波形の最初のエッジ位置のインデックス
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サイクル最小値 サイクル最小値はすべてのサイクルの下部の領域を測定します。各サイクルの
立下りスロープの中間レベルから立上りスロープまでの間の最小電圧です。

VCycleMin = Min(f(FallIndex(i) to RiseIndex(i+1))

ここで、

i = 1 ～ 最後のサイクルの有効なエッジ

f = 定義された領域の最小サンプル・ポイントを求める関数

サイクル最大値 サイクル最大値はすべてのサイクルの上部の領域を測定します。各サイクルの
立上りスロープの中間レベルから立下りスロープまでの間の最大電圧です。

アプリケーションでは、この測定の計算に次の式を使用します。

VCycleMax = Max(f(RiseIndex(i) to FallIndex(i+1))

ここで、

i = 1 ～ 最後のサイクルの有効なエッジ

f = 定義された領域の最大サンプル・ポイントを求める関数

サイクル・ピーク（Pk-Pk） サイクル・ピークは、波形の各サイクルの最大振幅と最小振幅の絶対差を測定
します。有効なスロープが立下りスロープで、次のピークが立上りスロープからそ
の次の立下りスロープまでに存在する場合には、ピーク値は立下りスロープから
次の立上りスロープまでの間で測定されます。ピーク・ピーク値は、利用可能な
すべての最小値と最大値のペアについて計算されます。

アプリケーションでは、Cycle Pk-Pk の計算に次の式を使用します。

Vpk-pk(n) = ABS (VCycleMax - VCycleMin)

ここで、

VCycleMax (n) = 最大ピーク振幅

VCycleMin (n) = 最小ピーク振幅

n = サイクルの数（1 ～ 最後の有効なエッジ）

 アルゴリズム
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付録

付録 A
スイッチング電源の電圧信号と電流信号をプローブするには、差動電圧プロー
ブおよび電流プローブを使用します。これらのプローブにはアクティブな回路が
あるため、DC オフセット・エラーが修正されます。DC 電圧のエラーが発生する

と、テスト信号に対して誤った結果が表示されます。差動電圧プローブと電流プ
ローブの伝搬が異なると、時間相関のある測定でエラーが発生し、誤った電力
波形を持つ測定値が表示されます。

これらのエラーを排除するには、次の手順を実行します。

P5205 型プローブの場合 1. オシロスコープのチャンネル 1 に P5205 を接続します。

2. 50X の位置でプローブを設定します。

3. 同じテスト・ポイントに + と - のプローブ入力を接続します。

4. カップリングを DC に設定します。

5. 垂直感度を最大に設定します。

6. 画面上に DC 電圧オフセットがないことを確認します。

7. オシロスコープの画面に DC オフセットがある場合は、小型のドライバを使
用して P5205 の BNC 端で "adjust offset" 可変抵抗器を設定し、DC 電圧
をゼロにします。

TCP202 型プローブの場
合

1. オシロスコープのチャンネル 2 に TCP202 を接続します。

2. TCP202 クランプを閉じます。

3. TCP202 の BNC コネクタで DEGAUSS ボタンを押してから離します。

4. 画面上に DC オフセットがある場合は、TCP202 の BNC コネクタの
"Balance" を使用して DC 電流レベルをゼロに調整します。

NOTE. P5205 型プローブと TCP202 型プローブは適合しています。これらの
プローブは伝搬遅延が同じであるため、デスキューする必要はありません。

5. テスト・セットアップが完了したら、電力測定を行います。
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付録 B
1. アプリケーションでは、非等価時間モード（ET）以外のデータ波形を使用し

て解析を行います。等価時間モードが AUTO になっている場合、アプリケ

ーションでは等価時間モードをオフに切り替えてから信号を測定します。こ
のとき、警告メッセージは表示されません。また、水平軸設定によってはレコ
ード長が変化する場合があります。

2. アプリケーションでは、選択された測定に基づいて、リファレンス・メモリか演
算、またはその両方を使用します。また、警告メッセージは表示されません。

3. プロットを使用して測定が選択されている場合、アプリケーションが動作する
ときには、2 M 以下のレコード長が使用されます。

4. 電力損失、SOA、および磁気の測定中は、結果のポスト解析時にオシロス

コープの設定を変更しないでください。設定を変更すると、結果の解釈に誤
りが発生します。

5. 電流プローブは正しい向きで接続してください。プローブの向きが間違って
いると、インダクタンス値に負の結果が表示されます。

6. 電流プローブおよび電圧プローブの DC オフセットを補正してください。補

正を行わなかった場合、鉄損の結果が負になるか、またはピーク検出測定
に不適切なカーソルの関連付けが表示されます。

7. チャンネルに接続された電圧プローブと電流プローブに従って、適切な電
圧チャンネルと電流チャンネルを選択してください。選択が不適切な場合は
B-H 曲線が逆になり、その他の測定でも誤った結果が得られる場合がありま

す。

付録  
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用語集

AC 信号

時間とともに変化する信号。その極性は周期 T で変化し、平均値はゼロです。

波高率：cf 安定状態で測定された AC 波形の RMS 値に対するピーク値の比率。この値に

単位はなく、純粋な正弦波の比率は  に等しくなります。

ここで、V in = ユーザ入力端末の電圧

dB デシベルの略称。

電流プローブ 電流プローブは、DC、AC、またはコンポジット電流の測定に使用されます。DC
電流プローブでは、プローブ校正器ありの場合は ± 1%、校正器なしの場合は
± 3% の範囲内で DC 電流およびコンポジット電流を測定する必要があります。
AC 電流プローブでは AC 電流を ± 5% の範囲内で測定する必要があります。
最悪の場合が想定されるピーク電流の場合にも、この確度を維持する必要があ
ります。同様に、適切な帯域幅も保証する必要があります。

DC 信号 時間が経過しても極性および振幅が変化しない信号。
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電力損失

UUT への入力電力と出力電力間の差。単位はワット。

 

 

次の式で表すこともできます。

 

 

高調波

基本周波数の整数倍の周波数において発生する、周期波形の電圧または電
流の正弦成分（歪み）。

入力電力の波を完全に整流する場合など、ほとんどの非線形負荷では奇数の
高調波が生成されます。入力リアクタを使用してユーザが作成したこれらの "特
性高調波" の周波数は、次の式で求めることができます。

 

 

ここで、

fH = 特性高調波（たとえば、H = 3 の場合は "第 3 次高調波"）

H = 高調波の数

k = 1 から始まる整数

q = 1 サイクルあたりのリアクタによる整流回数を表す整数

f 1 = 基本周波数

半波整流では、AC 電源システムに望ましくない結果（DC 成分など）を引き起こ

す偶数次の高調波が発生します。単相電源負荷を入力した全波整流では、基
本周波数の奇数倍となる 3 倍の位置で "第 3 次" 高調波が生成されます。ま

た、単相負荷の量と、これらの高調波が配信システムのゼロ・シーケンス・インピ
ーダンス（通常は大きい）と相互作用する事実を考慮すると、これらの高調波が
発生することは適切ではありません。このため、歪み電流に関するユーザ要件
は、偶数次および 3 倍の高調波に意図的に制限されています。

用語集  

320  拡張電源解析



力率（変位） ユーザ機器の場合、変位力率は基本周波数における入力電流と入力電圧間の
角度 j の余弦に相当します。

 

 

この力率の定義に、入力電流（または入力電圧、あるいはその両方）波形の歪
みの影響は含まれていません。

合計電力または皮相電
力

合計電力または皮相電力（S）は RMS 電圧と電流の積（VA）です。

力率（変位） ユーザ機器の場合、変位力率は基本周波数における入力電流と入力電圧間の
角度 j の余弦に相当します。

 

 

この力率の定義に、入力電流（または入力電圧、あるいはその両方）波形の歪
みの影響は含まれていません。

力率（歪み） 歪み力率は次のように定義されています。

 

 

ここで、THD（総合高調波歪み）= 1.22。

この力率の定義に、変位の影響は含まれていません。

 用語集
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力率（有効） ユーザ機器の場合、有効力率は、消費された有効電力または実電力（P）（ワット
単位）と、ボルトアンペアで示される皮相電力（S）の比率で、次の式で表されま
す。

 

 

ここで、

PF = 力率

P = 有効電力（ワット単位）

Q = 無効電力（バール単位）

S = 合計電力（ボルトアンペア単位）

この力率の定義には、入力電流（または入力電圧、あるいはその両方の）波形
の変位と歪みの影響の両方が含まれています。

次数間高調波が存在しない場合は、式 7 を次のように簡略化することもできま
す。

.

突入

突入電流の最大値またはピークのホット・プラグ測定。測定の結果には、ピーク
電力、突入時のエネルギー、および突入電流の時間が含まれます。

用語集  
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入力キャパシタンス

式 c=q/v を使用して、電圧および電流を使用したキャパシタンスを測定します。

ここで、

c - キャパシタンス（ファラッド）

q - 累積電荷（電流波形の積分）

v - ピーク・ツー・ピーク電圧。

RMS 値（電圧）（電圧）

期間全体から得られる関数値を二乗して平均を求め、その平方根を計算した
値。たとえば、正弦波の RMS 電圧値は次のように計算できます。

 

 

ここで、

T = 波形の周期

v(t) = 時刻 t における瞬間電圧

V rms = RMS 電圧値

総合高調波歪み 基本成分を除去して次数間高調波成分を無視した後の AC 信号の RMS 値と
基本成分の RMS 値の比率。パーセント表記。総合高調波歪み（THD）を定義
する公式を式（7）に示します。変数 "X 1" および x n は、電圧または電流を表す
場合と RMS 値またはピーク値を表す場合がありますが、1 つの式にある変数は
すべて同じ物理量を表します。

 

 

ここで、

X 1 = 電流または電圧の基本値

x n = 電流または電圧の n 次高調波値

 用語集
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伝達インピーダンス

定格電流を送信中の出力側において、出力電圧を入力電流で除算した値。

ヒステリシス UVLO のスレッショルド電圧とターン・オンのスレッショルド電圧の間の差。

V max 入力 UUT が仕様に従って動作可能な最大許容入力電圧定格。

V min 入力 UUT が仕様に従って動作可能な最小許容入力電圧定格。

V nom 入力 入力電圧の見かけまたは実際の値。測定する実効値ではない場合があります。
この値は、最小入力値と最大入力値の間に収まります。

電圧プローブ 通常は 2 本の導体で遮蔽されたケーブルと周波数補正ネットワークで構成され
る接続デバイス。ハンドヘルド・チップを搭載し、オシロスコープと組み合わせて
DC、AC、またはコンポジット信号の振幅と波形の測定に使用されます。測定に
はグランド基準が必要です。測定帯域幅は対象周波数の 10 倍以上である必要
があります。インピーダンスには、測定対象のノード・インピーダンスの 50 倍以
上の大きさが必要です。インピーダンスの低いプローブは、測定専用に使用す
る必要があります。

用語集  
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追加のトピック

電流高調波の結果の棒グラフ

 

 

デフォルトの場所 C:\Program Data\Tektronix\TekApplications\Advanced Power
Analysis\Images または選択したほかの任意の場所に棒グラフを保存するには、

Save ボタンを押します。

拡張電源解析 325



File メニュー

File メニュー項目にパラメータはありません。

設定パラメータの仕様

測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

共通設定 I-Probe
Settings >
Transfer
Impedance

0.001 10 0.5 0.001 Ω

共通設定 I-Probe
Settings >
Custom
Scale Factor

100 p 10 G 1 1 NA

共通設定 I-Probe
Settings >
Custom
Propagation
Delay

0 150 n 0 1 n s

電力損失 RDS(on) 0 100 20m 0.0001 Ω
VCE Sat 100m 50 2 0.1 V
Edge Levels
Hysteresis
（単位
Percentage
の場合）

5 40 10 1 %

Ref Level
（単位
Percentage
の場合）

10 90 50 1 %

Hysteresis
（単位
Absolute の
場合）

0 3000 5 0.001 V

Ref Level
（単位
Absolute の
場合）

-5999 5999 50 0.001 V

V Level（単
位
Percentage
の場合）

1 90 5 1 %

追加のトピック  
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測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

I level（単位
Percentage
の場合）

1 90 5 0 %

V level（単
位 Absolute
の場合）

-5999 5999 5 0.001 V

I Level（単
位 Absolute
の場合）

-100 100 1 0.001 A

Vg Level -100 100 1.5 0.1 V
Magnetics Hysteresis

（単位
Percentage
の場合）

5 40 10 1 %

Ref Level
（単位
Percentage
の場合）

10 90 50 1 %

Hysteresis
（単位
Absolute の
場合）

0 3000 150 m 0.001 V

Ref Level
（単位
Absolute の
場合）

-5999 5999 5 0.001 V

Num of
Turns

1 1 M 1 1 NA

Cross
section area
（SI の場

合）

1 u 1 M 1 1 u m2

Length（SI
の場合）

1 u 1 M 1 1 n m

Cross
section area
（CGS の場

合）

1 un 1 M 1 1 n cm2

Length（CGS
の場合）

1 un 1 M 1 1 n cm

電流高調
波

アンペア値
（高調波テ
ーブル・エ
ディタ）

0 10 0 0.00001 A

 追加のトピック
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測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

比率
（Impedance
Table
Editor）

0.001 2 0 0.001 NA

A14 入力電

源（Class C
および
Class D の
み）

0 600 100 10m W

A14 力率

（Class C の
み）

0 1 1 10m NA

A14 基本電

流（Class C
のみ）

0 16 16 10m A

Switching
Ripple

Switching
Frequency

50 1 M 10K 1 Hz

Turn on
Time

Maximum
Line Voltage

1 500 230 1 V

Voltage
1 Maximum
Value

- 5999 5999 5 0.01 V

Voltage
2 Maximum
Value

- 5999 5999 5 0.01 V

Voltage
3 Maximum
Value

- 5999 5999 5 0.01 V

Maximum
Turn-on

1 u 5 200m 1 u s

AC-DC のカ

スタム周波
数

50 1 M 50 1 Hz

トリガ電圧 1 500 230 1 V
Utilities >
Deskew

From Ref
Level

0 100 50 1 %

From
Hysteresis

0 25 5 1 %

To Ref Level 0 100 50 1 %
To
Hysteresis

0 25 5 1 %

Edges 1 100 1 1 NA

追加のトピック  
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測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

Pulse Width、Duty Cycle、Period、Frequency
Absolute Ref
Level

Ref Level -5999 5999 0 0.001 V

Absolute
Hysteresis

Ref Level 0 3000 6 0.001 V

Percentage
Ref Level

NA 1 99 50 1 %

Percentage
Hysteresis

NA 0 50 3 1 %

SOA
SOA Mask
Editor

Y Max （-40K） 5K 10 A

Y Min （-40K） 5K 0 A
X Max （-40K） 40K 500 1m V
X Min （-40K） 40K 0 1m V

SOA Overlay Y Max -40 5 10 A
Y Min -40 5 0 A
X Max -40 5 500 V
X Min -40 40 Kv 0 V

Spectral
Analysis
スタート周
波数

NA 0 499 M
299 M
（TDS5032
型、
TDS5034
型）

50 5 Hz

ストップ周
波数

NA 50 500 M
499 M
（TDS5032
型、
TDS5034
型）

1000 5 Hz

測定／サブ・タイプ メニュー 最大、最小

SOA プロット カーソル位置 結果に動的に依存

Power Energy Power Finder の
結果

Peak Count 結果に動的に依存

Occurrence 結果に動的に依存

コア飽和プロット カーソル位置 結果に動的に依存

 追加のトピック
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測定／サブ・
タイプ

最小値 最大値 デフォルト 分解能 Units

di/dt 設定

Ref Level
（Amps 単位）

-999 999 5 0.001 A

Hysteresis
（Amps 単位）

0 3000 150 m 0.001 A

Ref Level
（Percentage
単位）

1 99 50 1 %

Hysteresis
（Percentage
単位）

5 50 10 1 %

dv/dt 設定

Ref Level（ボ
ルト単位）

-5999 5999 5 0.001 V

Hysteresis（ボ
ルト単位）

0 3000 150 m 0.001 V

Ref Level
（Percentage
単位）

-5999 5999 50 1 %

Hysteresis
（Percentage
単位）

5 50 10 1 %

測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

di/dt 結果

Ref Level
（Amps 単
位）

High -999 999 10 0.001 A

Low -999 999 1 0.001 A
Ref Level
（Percentage
単位）

High 1 99 90 1 %

Low 1 99 10 1 %
dv/dt 結果

Ref Level
（ボルト単
位）

High -5999 5999 10 0.001 V

Ref Level
（ボルト単
位）

Low -5999 5999 1 0.001 V

追加のトピック  
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測定／サ
ブ・タイプ

メニュー 最小値 最大値 デフォルト 分解能 Units

Ref Level
（Percentage
単位）

High 1 99 90 1 %

Ref Level
（Percentage
単位）

Low 1 99 10 1 %

Edge
Number

結果に動的に依存 NA

SOA プロットの機能

緑のゼロ基準ラインは X と Y の値を表し、X が電流、Y が電圧です。このライン

は SOA 測定でゼロ値が現れると表示されます。水平ゼロ基準ラインは水平値

がゼロの場合に表示され、垂直基準ラインは垂直値がゼロの場合に表示されま
す。X 軸と Y 軸上にゼロ値がある場合、その値は (0,0) で表されます。入力は

X と Y の波形で、出力はプロットです。

ドット接続機能：プロット内の連続したデータ・ポイントを接続できます。プロット領
域で 1 つのデータがわずかに分散している場合に、そのデータを特定できま

す。Zoom In モードまたは Zoom Out モードでは、この機能を使用できません。

Link：データ・ポイントをリンクするには Link ボタンを押します。データ・ポイント

をリンクすると、アプリケーションによって、プロットが 1/2 スクリーン・サイズに変

更されます。

Reset：ズームされたプロットを元の状態に戻すには Reset ボタンを使用します。

プロットの保存：XY プロットを保存するには Save ボタンを使用します。このボタ

ンを押すと、プロット領域が .jpeg フォーマットでデフォルト・ディレクトリ C: \ User
\Public\TekApplications\DPOPWR\Images に保存されます。

Zoom In、Zoom Out：Zoom ボタンを有効にするには、Zoom コントロール・ボタ

ンを押します。XY プロットのデータ・ポイントは、プロット領域をマウスで 1 回クリ

ックすることによって、拡大または縮小できます。ズームする部分を選択するに
は、プロット上に矩形を描きます。この操作を実行すると、選択した領域がズー
ムされます。
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アプリケーションの設定と測定の実行

オシロスコープを設定するには、次の手順を実行します。

1. 測定を開始する前に、オシロスコープを 20 分間ウォーム・アップします。

2. オシロスコープで信号パス補正を実行します。

3. オシロスコープのアプリケーションを使用する前に、必ず工場出荷時のデフ
ォルト設定を呼び出します。オシロスコープのフロント・パネルでデフォルト
設定の呼び出しボタンを押すと、工場出荷時のデフォルト設定が呼び出さ
れます。

4. 常に、校正済みのプローブを使用し、電流プローブも消磁してください。

I-Probe Settings：AM503S 設定の内容

AM503S シリーズのプローブを使用する場合は、AM503S Settings ボタンを押

し、Probe Type フィールドのドロップダウン・リストを使用してプローブ・タイプを

選択します。ドロップダウン・リストから Range 値を選択し、選択したプローブの

範囲を Probe Type フィールドに表示します。OK をクリックして戻り、変更を反映

します。

オシロスコープからの Recall Waveform の表示
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